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Chapter 1 Introduction

1.1 Introduction

Congratulations on your purchase of this outstanding product: M2M Cellular Gateway. For M2M (Machine-to-
Machine) applications, AMIT M2M Cellular Gateway is absolutely the right choice. With built-in world-class
3G/4G module, you just need to insert SIM card from local mobile carrier to get to Internet. The redundant
SIM design provides a more reliable WAN connection for critical applications.

Main Features:
o Provide 3G/4G WAN connection.
e  Support dual SIMs for the redundant wireless WAN connection.
. Provide one Ethernet port for comprehensive LAN connection.
. Provide one R$232/RS485 serial port for accessing legacy serial device.
. Designed by solid and easy-to-mount metal body for business and M2M environment to work with a
variety M2M (Machine-to-Machine) applications.

Before you install and use this product, please read this manual in detail for fully exploiting the functions of
this product.
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1.2 Contents List

1.2.1 Package Contents
#Standard Package

IDG500-0T002

4G WAN Extender 1pcs

2 Cellular Antenna 2pcs

Power Adapter -
3 (DC5V/2A) 1pcs
(*%)

Male DC Jack to Screw Terminal

1
Block Adaptor pes

5 DIN-Rail Bracket 1set(2pcs)

6 RJ45 Cable 1pcs
7 Serial Convert Cable ‘—H- 1pcs

8 Rubber Feet o 4pcs

1 The maximum power consumption of IDG500 series product is 5.5W.
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1.3 Hardware Configuration

> Left View
LAN Serial PWR

> Right View

Reset Button

3G/4G 3G/4G
Antenna SIM-A SIM-B Antenna
GPS Antenna
(optional)

s Reset Button

The RESET button provides user with a quick and easy way to resort the default setting. Press the RESET button
continuously for 6 seconds, and then release it. The device will restore to factory default settings.

¢ GPS Antenna

The GNSS function is not available for some specific model / SKU. Even for the model with GNSS enabled,
the GPS Antenna is an optional accessory, and not included in the standard package. If you intend to use the
provided GNSS function, please purchase additional passive-type GPS antenna and install it to the

corresponding SMA connector in advance.
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1.4 LED Indication

Signal SIMA/B Serial
=] @ [ -

Signal
LTE/3G

SIM 1/2
Internet

Serial

Status

Blue
Purple
Red

Blue
Purple
Red

Blue

Blue

Status

// amic

When the LED color is shown in:
e Blue: Cellular module is in LTE Mode.
e Purple: Cellular module is in HSPA/3G Mode.
e Red: Cellular module is in GSM/2G Mode.
When the behavior of LED is:
e Flash (Fast): Signal Strength is 0~30%
e Flash (Slow, per 1.5~2 second): Signal Strength is 31~60%
e Steady On: Signal Strength is 61~100%

LED Off: Connection is not established.

Flash in Blue: Connection is establishing/re-establishing by SIM 1 (SIM-A).

Blue steady On: Uplink connection was established by SIM 1 (SIM-A).

Flash alternately in Blue and Purple: Data transfers via cellular connection by SIM 1 (SIM-A).
Flash in Red: Connection is establishing/re-establishing by SIM 2 (SIM-B).

Red steady On: Uplink connection was established by SIM 2 (SIM-B).

Flash alternately in Red and Purple: Data transfers via cellular connection by SIM 2 (SIM-B).

Flash: Data packet transferred via Serial port.

Flash (per second): The gateway works normally.
Flash (Fast): The gateway is in Recovery Mode or abnormal situation.

Note: If you encountered the abnormal situation, even power OFF / ON the device, there might be
something wrong during the device boot up session and it was damaged. You need to call for RMA
service to recover it.
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1.5 Installation & Maintenance Notice

1.5.1 SYSTEM REQUIREMENTS

e  Afast Ethernet RJ45 cable

Network Requirements e 3G/4G cellular service subscription
e 10/100 Ethernet adapter on PC
Computer with the following:
o Windows®, Macintosh, or Linux-based operating

system
e Aninstalled Ethernet adapter
Browser Requirements:
. Internet Explorer 6.0 or higher
e  Chrome 2.0 or higher
Firefox 3.0 or higher
Safari 3.0 or higher

Web-based Configuration Utility
Requirements

1.5.2 WARNING

/ ® Only use the power adapter that comes with the \

package. Using a different voltage rating power

adaptor is dangerous and may damage the product.
® Do not open or repair the case yourself. If the
Attention product is too hot, turn off the power immediately
and have it repaired at a qualified service center.

® Place the product on a stable surface and avoid

\ using this product and all accessories outdoors. /

10
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Federal Communication Commission Interference Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the

user's authority to operate this equipment.
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

FOR PORTABLE DEVICE USAGE (<20m from body/SAR needed)

Radiation Exposure Statement:

The product comply with the FCC portable RF exposure limit set forth for an uncontrolled environment and are safe for
intended operation as described in this manual. The further RF exposure reduction can be achieved if the product can be
kept as far as possible from the user body or set the device to lower output power if such function is available.

FOR MOBILE DEVICE USAGE (>20cm/low power)

Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

FOR COUNTRY CODE SELECTION USAGE (WLAN DEVICES)

Note: The country code selection is for non-US model only and is not available to all US model. Per FCC regulation, all
WiFi product marketed in US must fixed to US operation channels only.

1



4G WAN Extender

1.5.3 HOT SURFACE CAUTION

Burn hazard.

Hot surface inside.

Allow to cool before
servicing.

CAUTION: The surface temperature for the metallic enclosure can be very high!
Especially after operating for a long time, installed at a closed cabinet
without air conditioning support, or in a high ambient temperature
space.

DO NOT touch the hot surface with your fingers while servicing!!

12
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1.5.4 Product Information for CE RED Requirements

The following product information is required to be presented in product User Manual for latest CE RED

requirements. 2

(1) Frequency Band & Maximum Power
1.a Frequency Band for Cellular Connection (for ME3630 E1C version) >

Band number

Operating

Frequency

Max output power

LTE FDD BAND 1

Uplink:

1920-1980 MHz

Downlink: 2110-2170 MHz
LTE FDD BAND 3 Uplink:  1710-1785 MHz
Downlink: 1805-1880 MHz
LTE FDD BAND 7 Uplink:  2500-2570 MHz
+
Downlink: 2620-2690 MHz 23 £2.7 dBm
LTE FDD BAND 8 Uplink:  880-915 MHz
Downlink: 925-960 MHz
LTE FDD BAND 20 Uplink:  832-862 MHz
Downlink: 791-821 MHz
WCDMA BAND 1 Uplink:  1920-1980 MHz
Downlink: 2110-2170 MHz
24 +1/-3 dB
WCDMA BAND 8 Uplink:  880-915 MHz 4+1/-3 dBm
Downlink: 925-960 MHz
E-GSM Uplink:  880-915 MHz
+
Downlink: 925-960 MHz 33 £2dBm
DCS Uplink:  1710-1785 MHz
+
Downlink: 1805-1880 MHz 30£2 dBm

requency Band for Cellular Connection (for EC25-E version)

Band number

Operating Frequency

Max output power

LTE FDD BAND 1 Uplink:  1920-1980 MHz 731 dBm

Downlink: 2110-2170 MHz :
LTE FDD BAND 3 Uplink:  1710-1785 MHz

Downlink: 1805-1880 MHz 23.0 dBm
LTE FDD BAND 7 Uplink:  2500-2570 MHz

Downlink: 2620-2690 MHz 22.8 dBm
LTE FDD BAND 8 Uplink:  880-915 MHz

Downlink: 925-960 MHz 23.2.dBm
LTE FDD BAND 20 Uplink:  832-862 MHz 23.5 dBm

2 The information presented in this section is ONLY valid for the EU/EFTA regional version. For those non-CE/EFTA versions, please
refer to the corresponding product specification.

3 There can be different cellular module intrgrated in the device for EU/EFTA regional version. Refer to the cellular module identifier
printed on the device label for the purchased device.

13
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Downlink: 791-821 MHz
LTE FDD BAND 38 Uplink: 2570-2620 MHz

Downlink: 2570-2620 MHz 21.7 dBm
LTE FDD BAND 40 Upllnk.: 2300-2400 MHz 1.5 dBm

Downlink: 2300-2400 MHz
WCDMA BAND 1 Uplink: 1920-1980 MHz

Dov_vnllnk: 2110-2170 MHz »3.3 dBm
WCDMA BAND 8 Uplink:  880-915 MHz

Downlink: 925-960 MHz
E-GSM Uplink:  880-915 MHz

Downlink: 925-960 MHz 32.9 dBm
DCS Uplink:  1710-1785 MHz

Downlink: 1805-1880 MHz 29.9 dBm

1.c Frequency Band for Cellular Connection (for UC20-G version)

Band number Operating Frequency Max output power
WCDMA BAND 1 Uplink: 1922.4-1977.6 MHz

Downlink: 2112.4-2167.6 MHz 22.47 dBm
WCDMA BAND 8 Uplink:  882.4-912.6 MHz

Downlink: 927.4-957.6 MHz 22.48 dBm
E-GSM Uplink:  880.2-914.8 MHz

Downlink: 925.2-959.8 MHz 32.1dBm
DCS Uplink: 1710.2-1784.8 MHz

Downlink: 1805.2-1879.8 MHz 28.9 dBm

(2) DoC Information
You can get the DoC information of this product from the following URL:
http://www.amit.com.tw/products-doc/

(3) RF Exposure Statements
The antenna of the product, under normal use condition, is at least 20 cm away from the body of user.

(4) Unit Mounting Notice
The product is suitable for mounting at heights <=2m (approx. 6 ft), or in a cabinet.
Ensure the unit is fixed tightly to reduce the likelyhood of injury due to exposure to mechanical hazards if
dropped.

(5) Manufacture Information

Manufacture Name: AMIT Wireless Inc.
Manufacture Address: No. 28, Lane 31, Sec. 1, Huandong Rd., Xinshi Dist., Tainan 74146, Taiwan (R.0.C.)

14


http://www.amit.com.tw/products-doc/

4G WAN Extender

1.6 Hardware Installation

This chapter describes how to install and configure the hardware

1.6.1 Mount the Unit

The IDG500 series can be placed on a desktop, or mounted on the wall.

1.6.2 Insert the SIM Card

WARNING: BEFORE INSERTING OR CHANGING THE SIM CARD, PLEASE MAKE SURE
THAT POWER OF THE DEVICE IS SWITCHED OFF.

The SIM card slots are located at the right side of IDG500 series housing in order to protect the SIM card. You
need to unscrew and remove the outer SIM card cover before installing or removing the SIM card. Please
follow the instructions to insert or eject a SIM card. After SIM card is well placed, screw back the outer SIM
card cover.

Step 1: Step 2: Step 3:

Loosen the screws as Push the SIM card Push the inserted SIM card
below and remove the into the SIM-A or slot again to eject it from the
SIM cover. SIM-B SIM slot.

15
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1.6.3 Install the External Antenna

As illustrated in Section 1.3, there are several SMA antenna Jacks for you to install the required antennas for
the RF signal transmission and receiving. You have to purchase required RF cables and antennas separately for
a specific project or installation site to get excellent RF performance.

Since there is limited spacing for allocating all SMA antenna Jacks around the enclosure, the separation among
SMA Jacks (or direct-attached antennas) could be not the optimized arrangement. It is very likely to get
degraded RF performance at specific circumstances. It depends heavily on the environment.

However, there are well-known rules of thumb for solving the antenna separation issue.

1: The horizontal distance between antennas should be greater than 1/4 of its wavelength, and there will be
best separation at 1/2 of its wavelength.

2. If multiple frequency antennas are near each other, then use spacing distance of the lower frequency
antenna, or even better try to satisfy the rule for both frequencies.

Wavelength Table for Major RF Category

RF Category Frequency Wavelength 1/2 Wave Ler!gth 1/4 Wave Lenfgth

(Best Separation) (Good Separation)
WiFi 802.11 5.8GHz 5.2cm 2.6cm 1.3cm
WiFi 802.11 2.4GHz 12.5cm 6.2cm 3.1cm
Celllular LTE 2600MHz 11.5cm 5.8cm 2.9cm
Cellular LTE 2100MHz 14.3cm 7.1cm 3.7cm
Cellular LTE 900MHz 33.3cm 16.6cm 8.3cm
Cellular LTE 700MHz 42.8cm 21.4cm 10.7cm
GPS 1.57GHz 19.0cm 9.5cm 4.7cm

For example, if you have a 900MHz LTE antenna and a WiFi 2.4GHz antenna, you would want them to be
separated by at least 8.3cm to get good antenna separation.

So, it is recommended to use some external RF cables to extend and separate the adjacent antennas and get
better antenna separation and RF performance, if required.

16
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1.6.4 Connecting Serial Devices

The IDG500 series product provides one RJ45 type serial port. Connect the serial device to the serial port with

the right pin assignments of RS-232/485 are shown as below.

RJ45 Serial Receptacle Pinout

RJ45 Receptacle

Pinout Definition

Pinl Pin2 Pin3 Pin4 Pin5 Pin6 Pin7 Pin8
RS-232 DCD RXD TXD DTR GND DSR RTS CTS
RS-485 DATA+ DATA- GND

Note: Make sure the pinout is compatiable to your serial device, or you have to prepare a

special conversion cable with proper pinout arrangements.

17
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1.6.5 Connecting Power

There are a DC5V/2A power adapter® and a 2-pin Terminal Block adapter in the package for you to easily
connect DC power to this gateway.

If you powered the gateway with other DC Power Source, Please make sure the DC Power voltage is comply to
5V ~ 18V, and the electrodes have been plugged into the right pins according to their assignments (‘+’ for the
DC Power and ‘- for the GND wire).

WARNNING: This commercial-grade power adapter is mainly for ease of powering up
the purchased device while initial configuration. It’s not for operating at wide
temperature range environment. PLEASE PREPARE OR PURCHASE OTHER INDUSTRIAL-
GRADE POWER SUPPLY FOR POWERING UP THE DEVICE.

1.6.6 Connecting to the Network or a Host

The IDG500 series product provides one RJ45 port to connect 10/100Mbps Ethernet. It can auto detect the
transmission speed on the network and configure itself automatically. Connect one Ethernet cable to the RJ45
port (LAN) of the device and plug another end of the Ethernet cable into your computer’s network port. In this
way, you can use the RJ45 Ethernet cable to connect the device to the host PC’s Ethernet port for configuring
the device.

4 The maximum power consumption of IDG500 series product is 5.5W.
18
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1.6.7 Setup by Configuring WEB Ul

You can browse web Ul to configure the device.

Type in the IP Address (http://192.168.123.254)°

& Windows Internet Explorer
() [ 10216812305 -] x]

When you see the login page, enter the user name and password and then click ‘Login’ button.
The default setting for both username and password is ‘admin’ °,

Welcome to the router configuration interface.
Enter the password and click ‘Login’

Username

Password

5 The default LAN IP address of this gateway is 192.168.123.254. If you change it, you need to login by using
the new IP address.

6 For security consideration, you are strongly recommended to change the login username and password from
default values. Refer to Section 6.1.2 for how to change the setting.
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Chapter 2 Basic Network
2.1 WAN & Uplink

Basic Network | @) stats | “Phy jace’|  Connection Setup
| @) Basic Network | B,

[ WAN& Uplink ]

WAN-1 3G/4G

Physical Interface

Item

Internet Setup l@ el LR I | ¢ Physical Interface

+ Qperation Mode

The gateway provides one WAN interface to let all client hosts in Intranet of the gateway access the Internet
via ISP. But ISPs in the world apply various connection protocols to let gateways or user's devices dial in ISPs

and then link to the Internet via different kinds of transmit media.

So, the WAN Connection lets you specify the WAN Physical Interface and Internet Setup for Intranet to access
Internet. For each WAN interface, you must specify its physical interface first and then its Internet setup to

connect to ISP.

= WAN & Uplink Interface Name Physical Interface

| @) Fietd communication | | ERIREVINTR A Enablel0

Widget

Edit

Action
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2.1.1 Physical Interface

] -

Physical Interface

Interface Name Physical Interface Operation Mode Action
WWAN-1 1G/AG Always an Edit
Physical - N
Interface List )
Item Setting
» Physical Interface 3GAG ¥

Interface » Operation Mode Always on ¥
Configuration » VLAN Tagging Enable [0 (1-4085)
J, Select

< Physical > The first step to configure one WAN interface is to specify which kind of connection

Interface media to be used for the WAN connection, as shown in "Physical Interface" page.
»LSelect In "Physical Interface" page, there are two configuration windows, "Physical
Operation Mode Interface List" and "Interface Configuration". "Physical Interface List" window
:Al‘!""“"s on shows all the available physical interfaces. After clicking on the "Edit" button for the
: interface in "Physical Interface List" window the "Interface Configuration" window
% will appear to let you configure a WAN interface.

Physical Interface:

« 3G/4G WAN: The gateway has one built-in 3G/4G cellular as WAN connection. For each cellular WAN,
there are 1 or 2 SIM cards to be inserted for special failover function.

4 )

® Please MUST POWER OFF the gateway before you

insert or remove SIM card.

® The SIM card can be damaged if you insert or

. remove SIM card while the gateway is in operation.
Attention
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Operation Mode:

There are three option items “Always on”, “Failover”, and “Disable” for the operation mode setting. However,
for the single WAN device, only “Always on” is available.

Always on: Set this WAN interface to be active all the time. When two or more WAN are established at
"Always on" mode, outgoing data will through these WAN connections base on load balance policies.

VLAN Tagging

Sometimes, your ISP required a VLAN tag to be inserted into the WAN packets from Gateway for specific
services. Please enable VLAN tagging and specify tag in the WAN physical interface. Please be noted that only
Ethernet and ADSL physical interfaces support the feature. VLAN tagging is not available for the gateway.

Physical Interface Setting

Go to Basic Network > WAN > Physical Interface tab.

The Physical Interface allows user to setup the physical WAN interface and to adjust WAN’s behavior.

Note: Numbers of available WAN Interfaces can be different for the purchased gateway.

Interface Name Physical Interface Operation Mode Action

WAMN-1 3GM4G Always on Edit

When Edit button is applied, an Interface Configuration screen will appear. WAN-1 interface is used in this
example.
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Interface Configuration:

= Interface Configuration { WAN -1} u

Item

Setting

¥ Physical Interface

¥ Operation Mode

Always on ¥

» VLAN Tagging

Enable D (1-4005)

Interface Configuration

Item

Physical Interface

Value setting

1. A Must fill setting

2. WAN-1 is the primary
interface and is factory
set to Always on.

Description
Select one expected interface from the available interface dropdown list.

Operation Mode

A Must fill setting

Define the operation mode of the interface.
Select Always on to make this WAN always active.

(Note: for WAN-1, only Always on option is available.)

VLAN Tagging

Optional setting

Check Enable box to enter tag value provided by your ISP. Otherwise
uncheck the box.
Value Range: 1 ~ 4095.

Note: This feature is NOT available for this gateway.
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2.1.2 Internet Setup

* Internet Connection List

Internet Setup

Interface Name Physical Interface Operation Mode WAN Type Action

Internet WAN-1 IGMG Always on 3GMG Edit
Connection List

= Internet Connection Configuration { WAN-1)

Item Setting
» WAN Type 3GMAG ¥

= 3GI4G WAN Type Configuration

Internet Connect
Configure (WAN-x

ltem Setting
» Prefered SIM Card Failback : [ Enable
» Auto Flight Mode [J Enable
» SIM Switch Policy

After specifying the physical interface for each WAN connection, administrator must configure their
connection profile to meet the dial in process of ISP, so that all client hosts in the Intranet of the gateway can
access the Internet.

In "Internet Setup" page, there are some configuration windows: "Internet Connection List", "Internet
Connection Configuration", "WAN Type Configuration" and related configuration windows for each WAN type.
For the Internet setup of each WAN interface, you must specify its WAN type of physical interface first and
then its related parameter configuration for that WAN type.

After clicking on the "Edit" button of a physical interface in "Internet Setup List" window, the "Internet
Connection Configuration" window will appear to let you specify which kind of WAN type that you will use for
that physical interface to make an Internet connection. Based on your chosen WAN type, you can configure
necessary parameters in each corresponding configuration window.
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Internet Connection — 3G/4G WAN

Internet Connect List

Item

= Intemet Connection Configuration { WAN -1)

Setting

» WAN Type

GG

Internet Connect
Configure

= 3G/4G WAN Type Configuration

Item Setting
WAN Type= > v Preferred SIM Card SIM-A First v | Failback : [) Enable
3G6/4G6 » Auto Flight Mode [ Enable
» SIM Switch Policy Policy Setting

3G/4G WAN Type
Configuration

L4 Setup

Configure
SIM-A/ SIM-B

SIM-A/ SIM-B

APN Profile List
lﬁepeat.ﬁddfﬁlﬁt
APN Profile-x v Connection Control
» Time Schedule (0) Always ¥
» MTU Setup [] Enable
SIM-A/B APN + IP Passthrough (Cellular [] Enable Fixed MAC - |
Profile Configuration Bridge)
» NAT ¥ Enable
r IGMP -_Disahle v
3G/4G Connection
Common Configure r WANIP Alias @ Enable |1D'D'D'1

Preferred SIM Card — Dual SIM Fail Over

For 3G/4G embedded device, one embedded cellular module can create only one WAN interface. This device
has featured by using dual SIM cards for one module with special fail-over mechanism. It is called Dual SIM
Failover. This feature is useful for ISP switch over when location is changed. Within “Dual SIM Failover”, there
are various usage scenarios, including "SIM-A First", "SIM-B First“ with “Failback” enabled or not, and “SIM-A
Only and “SIM-B Only”.




4G WAN Extender

SIM-A/SIM-B only: When “SIM-A Only” or “SIM-B Only” is used, the specified SIM slot card is the only one to
be used for negotiation parameters between gateway device and cellular ISP.

SIM-A / SIM-B first without enable Failback

By default, “SIM-A First” scenario is used to connect to cellular ISP for

Disconnected 5|M'A data transfer. In the case of “SIM-A First” or “SIM-B First” scenario, the

((( )) {( ))  gateway will try to connect to the Internet by using SIM-A or SIM-B card
E\ first. And when the connection is broken, the gateway will switch to use
the other SIM card for an alternate automatically and will not switch back

ISP] Fail ver to use original SIM card except current SIM connection is also broken.
(( )) M That is, SIM-A and SIM-B are used iteratively, but either one will keep

SIM B being used for data transfer when current connection is still alive.

Cunnected
'5" Not back to SIM-A

SIM-A / SIM-B first with Failback enable

With Failback option enabled, “SIM-A First” scenario is
used to connect when the connection is broken, gateway
system will switch to use SIM-B. And when SIM-A
connection is recovered, it will switch back to use original
SIM-A card

Disconnected g ;.4

)

I5P1 Fail}ver

() -, g
&Connected w ",

IsP2
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Internet Setup Setting

Go to Basic Network > WAN > Internet Setup tab.

Internet Setup allows user to setup WAN connection of the gateway. Numbers of available WAN Interfaces
can be different for the purchased gateway.

Internet Connection List shows the basic information of each WAN. Click Edit button to configure. Then follow
the following pages for detail settings.

= Internet Connection List

Interface Name Physical Interface Operation Mode WAN Type Action

WAN-1 3G/4G Always on 3G/4G
Internet Connection List

Item Value setting Description
Interface Name N/A Shows the name of WAN interface.
Physical Interface N/A Physical Interface (i.e. 3G/4G) shows the type of interface configured to

map with Interface Name.
Operation Mode shows the current setting of Connection Control mode of
WAN interface to keep WAN connection.
Operation Mode N/A ® Auto-reconnect (Always on)
® Connect-on-demand
® Connect Manually
WAN Type shows the type of connection method to your ISP.
Depending on the device model, the following WAN connection types are
supported.
e 3G/4G:3G/4G
Note: If Edit button is disabled for the Interface, you will need to enable the Interface first by going to Basic

Network > WAN & Uplink > Physical Interface page. Then Click Edit button then select Always on or Failover.

WAN Type N/A
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Internet Setup — 3G/4G WAN

Configure 3G/4G WAN Setting

When Edit button is applied, Internet Connection Configuration, and 3G/4G WAN Configuration screens will
appear.

Item Setting
» WAN Type 3GM4G ¥

Item Setting
v Preferred SIM Card SIM-A First v | Failback Enable
¢ Auto Flight Mode Enable
» SIM Switch Policy Paolicy Setting

1.A Must filled setting From the dropdown box, select Internet connection method for 3G/4G
WAN Type 2.3G/4G is set by WAN Connection. Only 3G/4G is available.
default.

Choose which SIM card you want to use for the connection.
When SIM-A First or SIM-B First is selected, it means the connection is built
first by using SIM A/SIM B. And if the connection is failed, it will change to
the other SIM card and try to dial again, until the connection is up.
1. A Must filled setting When SIM-A only or SIM-B only is selected, it will try to dial up only using
2. By default SIM-A First  the SIM card you selected.

Preferred SIM Card is selected When Failback is checked, it means if the connection is dialed-up not using
3. Failback is unchecked the main SIM you selected, it will failback to the main SIM and try to
by default establish the connection periodically.
Note_1: For the product with single SIM design, only SIM-A Only option is
available.
Note_2: Failback is available only when SIM-A First or SIM-B First is
selected.

Check the Enable box to activate the function.
By default, if you disabled the Auto Flight Mode, the cellular module will
always occupy a physical channel with cellular tower. It can get data
connection instantly, and receive managing SMS all the time on required.
If you enabled the Auto Flight Mode, the gateway will pop up a message
The box is unchecked by  “Flight mode will cause cellular function to be malfunctioned when the
default data session is offline.”, and it will make the cellular module into flight
mode and disconnected with cellular tower phycially. In, addition,
whenever the cellular module is going to be used for data connection to
backup the failed primary connection, the cellular module will be active to
connect with cellular tower and get the data connection for use, It takes
few more seconds.

Auto Flight Mode
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Note: Keep it unchecked unless your cellular ISP asked the connected
gateway to enable the Auto Flight Mode.

Click the Policy Setting button to define the SIM Switch policy or browse

SIM Switch Policy NA . >
the current policy settings.

# Policy Seiting

ltem Setting
» Failed connection D (1-10) times
» RSSI Monitor [J Enable Threshold: -[0 | (-90~-113 dBm)
» Network Service [ Enable Loss LTE signal: [0 | (1~30 minutes)
» Roaming Service [] Enable Timeout: D (1~30 minutes)

Configure SIM-A / SIM-B Card

Here you can set configurations for the cellular connection according to your situation or requirement.

« Connection with SIM-A Card ’

ltem Setting
b Network Type
» Dial-Up Profile | Manual-configuration v |
» APN | |
» PIN Code | | (Optional)
» Dial Number | | (Optional)
» Account | | (Optional)
» Password | | (Optional)

» Authentication
b IP Mode Dynamic IP +

» Primary DNS | | (Optional)
b Secondary DNS | | {Optional)
* Roaming [J Enable

Note_1: Configurations of SIM-B Card follows the same rule of Configurations of SIM-A Card, here we list SIM-
A as the example.

Note_2: Both Connection with SIM-A Card and Connection with SIM-B Card will pop up only when the SIM-A
First or SIM-B First is selected, otherwise it only pops out one of them.
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Network Type

Dial-Up Profile

APN

IP Type

PIN code

Dial Number,
Account,
Password

Authentication

IP Mode

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. By default Manual-

configuration is selected

1. A Must filled setting
2. String format : any
text

1. A Must filled setting
2. By default IPv4 is
selected

1. An Optional setting
2. String format :
interger

1. An Optional setting
2. String format : any
text

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting

2. By default Dynamic IP

is selected

Select Auto to register a network automatically, regardless of the network
type.

Select 2G Only to register the 2G network only.

Select 2G Prefer to register the 2G network first if it is available.

Select 3G only to register the 3G network only.

Select 3G Prefer to register the 3G network first if it is available.

Select LTE only to register the LTE network only.

Note: Options may be different due to the specification of the module.
Specify the type of dial-up profile for your 3G/4G network. It can be
Manual-configuration, APN Profile List, or Auto-detection.

Select Manual-configuration to set APN (Access Point Name), Dial Number,
Account, and Password to what your carrier provides.

Select APN Profile List to set more than one profile to dial up in turn, until
the connection is established. It will pop up a new filed, please go to Basic
Network > WAN & Uplink > Internet Setup > SIM-A APN Profile List for
details.

Select Auto-detection to automatically bring out all configurations needed
while dialing-up, by comparing the IMSI of the SIM card to the record listed
in the manufacturer’s database.

Note_1: You are highly recommended to select the Manual or APN Profile
List to specify the network for your subscription. Your ISP always provides
such network settings for the subscribers.

Note_2: If you select Auto-detection, it is likely to connect to improper
network, or failed to find a valid APN for your ISP.

Enter the APN you want to use to establish the connection.

This is a must-filled setting if you selected Manual-configuration as dial-up
profile scheme.

Specify the IP type of the network serveice provided by your 3G/4G
network. It can be IPv4, IPv6, or IPv4/6.

Enter the PIN (Personal Identification Number) code if it needs to unlock
your SIM card.

Enter the optional Dial Number, Account, and Password settings if your ISP

provided such settings to you.

Note: These settings are only displayed when Manual-configuration is

selected.

Select PAP (Password Authentication Protocol) and use such protocol to be

authenticated with the carrier’s server.

Select CHAP (Challenge Handshake Authentication Protocol) and use such

protocol to be authenticated with the carrier’s server.

When Auto is selected, it means it will authenticate with the server either

PAP or CHAP.

When Dynamic IP is selected, it means it will get all IP configurations from

the carrier’s server and set to the device directly.

If you have specific application provided by the carrier, and want to set IP

configurations on your own, you can switch to Static IP mode and fill in all
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parameters that required, such as IP address, subnet mask and gateway.

Note: IP Subnet Mask is a must filled setting, and make sure you have the
right configuration. Otherwise, the connection may get issues.

1. An Optional setting Enter the IP address to change the primary DNS (Domain Name Server)
Primary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

1. An Optional setting Enter the IP address to change the secondary DNS (Domain Name Server)
Secondary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

Check the box to establish the connection even the registration status is
. The box is unchecked by  roaming, not in home network.
Roaming default

Note: It may cost additional charges if the connection is under roaming.

Create/Edit SIM-A / SIM-B APN Profile List

You can add a new APN profile for the connection, or modify the content of the APN profile you added. It is
available only when you select Dial-Up Profile as APN Profile List.

W SIM-A APN Profile List X5} IPEES

Profile
Name

Account | Password | Authentication| Priority | Enable Actions

List all the APN profile you created, easily for you to check and modify. It is available only when you select
Dial-Up Profile as APN Profile List.

When Add button is applied, an APN Profile Configuration screen will appear.

= SIM-A APN Profile Configuration

ltem Setting

» Profile Name Profile-1 |

» APN | |

¥ IP Type IPvd v

¥ Account | | {Cptional)

» Password | | {Cptional)

b Authentication

* Priority I:I

¥ Profile (J Enable
Item Value setting Description

1. By default Profile-x is Enter the profile name you want to describe for this profile.

Profile Name listed

2. String format : any text
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APN String format : any text Enter the APN you want to use to establish the connection.

1. A Must filled setting Specify the IP type of the network serveice provided by your 3G/4G
IP Type 2. By default IPv4 is network. It can be IPv4, IPv6, or IPv4/6.

selected

Enter the Account you want to use for the authentication.

Account String format : any text Value Ranae: 0 ~ 53 characters.
Password String format : any text Enter the Password you want to use for the authentication.
1. A Must filled setting Select the Authentication method for the 3G/4G connection.
Authentication 2. By default Auto is It can be Auto, PAP, CHAP, or None.
selected

1. A Must filled setting Enter the value for the dialing-up order. The valid value is from 1 to 16. It

Priority . . will start to dial up with the profile that assigned with the smallest number.
2. String format : integer
Value Range: 1 ~ 16.
Profile The box is checked by Check the box to enable this profile.
default Uncheck the box to disable this profile in dialing-up action.
Save N/A Click the Save button to save the configuration.
Undo N/A Click the X button to restore what you just configured back to the previous

setting.

Setup 3G/4G Connection Common Configuration

Here you can change common configurations for 3G/4G WAN.

ltem Setting
» Connection Contro Auto-reconnect v
¥ Time Schedule (0) Always ¥
» MTU Setup Enable
¥ IP Passthrough (Cellular Enable Fixed MAC
Bridge)
b NAT # Enable
» IGMP Disable
» WAN IP Alias Enable {10.0.0.1

When Auto-reconnect is selected, it means it will try to keep the Internet
connection on all the time whenever the physical link is connected.
When Connect-on-demand is selected, it means the Internet connection
By default Auto- will be established only when detecting data traffic.
reconnect is selected When Connect Manually is selected, it means you need to click the
Connect button to dial up the connection manually. Please go to Status >
Basic Network > WAN & Uplink tab for details.

Connection Control
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Maximum Idle Time

Time Schedule

MTU Setup

IP Pass-through
(Cellular Bridge)

NAT
IGMP

WAN IP Alias

[tem

¢+ Network Monitoring
Configuration

¢+ Checking Method
» Loading Check
b Query Interval

» Latency Threshold

¢ Fail Threshold
» Targetl
» Target?

1. An Optional setting
2. By default 600
seconds is filled-in

1. A Must filled setting
2. By default (0) Always
is selected

1. An Optional setting
2. Uncheck by default

1. The box is unchecked
by default

2. String format for Fixed
MAC:

MAC address, e.g.
00:50:18:aa:bb:cc

Check by default

By default Disable is
selected

1. Unchecked by default
2. String format: IP
address (IPv4 type)

Note: If the WAN interface serves as the primary one for another WAN
interface in Failover role( and vice versa), the Connection Control
parameter will not be available on both WANs as the system must set it to
“Auto-reconnect”

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

When (0) Always is selected, it means this WAN is under operation all the
time. Once you have set other schedule rules, there will be other options to
select. Please go to Object Definition > Scheduling for details.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the 3G/4G connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

When Enable box is checked, it means the device will directly assign the
WAN [P to the first connected local LAN client.

However, when an optional Fixed MAC is filled-in a non-zero value, it
means only the client with this MAC address can get the WAN IP address.

Note: When the IP Pass-through is on, NAT and WAN IP Alias will be
unavailable until the function is disabled again.

Uncheck the box to disable NAT (Network Address Translation) function.
Select Auto to enable IGMP function.

Check the Enable box to enable IGMP Proxy.

Check the box to enable WAN IP Alias, and fill in the IP address you want to
assign.

Setting
#| Enable
DNS Query v
#| Enable
5 (seconds)
3000 (ms)
5 (Times)
DMNS1 ¥
MNone v
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Network Monitoring
Configuration

Checking Method

Loading Check

Query Interval

Check Interval

Latency Threshold

Fail Threshold

Target 1

Target 2

Save
Undo

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2. DNS Query is set by
default

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.3000 ms is set by
default

1. An Optional setting
2.5 times is set by
default

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Check the Enable box to activate the network monitoring function.

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is to
prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.
None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Click Save to save the settings.

Click Undo to cancel the settings.
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2.2 LAN & VLAN

This section provides the configuration of LAN and VLAN. VLAN is an optional feature, and it depends on the
product specification of the purchased gateway.

2.2.1 Ethernet LAN

The Local Area Network (LAN) can be
used to share data or files among

Tét:aﬂd{m computers attached to a network.
Ehutar Ethernet LAN . . .

“ Following diagram illustrates the
network that wired and interconnects
computers.

Wired Network
Please follow the following instructions to do IPv4 Ethernet LAN Setup.
Item Setting

» P Mode Static IP

v LAM P Address 192168 123 254

v Subnet Mask 255.255.255.0 (124) v

It shows the LAN IP mode for the gateway according the related configuration.
Static IP: If there is at least one WAN interface activated, the LAN IP mode is
IP Mode N/A fixed in Static IP mode.

1. A Must filled setting
2.192.168.123.254 is set by
default

LAN IP
Address

1. A Must filled setting
Subnet Mask 2.255.255.255.0 (/24) is set
by default

Dynamic IP: If all the available WAN inferfaces are disabled, the LAN IP mode
can be Dynamic IP mode.

Enter the local IP address of this device.

The network device(s) on your network must use the LAN IP address of this
device as their Default Gateway. You can change it if necessary.

Note: /t’s also the IP address of web Ul. If you change it, you need
to type new IP address in the browser to see web Ul.

Select the subnet mask for this gateway from the dropdown list.

Subnet mask defines how many clients are allowed in one network or subnet.
The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 IP
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addresses are allowed in this subnet. However, one of them is occupied by LAN
IP address of this gateway, so there are maximum 253 clients allowed in LAN

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.252 (/30).

Save N/A

Click the Save button to save the configuration

Undo N/A

Click the Undo button to restore what you just configured back to the previous
setting.

Create / Edit Additional IP

This gateway provides the LAN IP alias function for some special management consideration. You can add
additional LAN IP for this gateway, and access to this gateway with the additional IP.

= Additional IP " "

Interface

IP Address Subnet Mask Enable Action

When Add button is applied, Additional IP Configuration screen will appear.

= Additional IP Configuration

Item

Setting

¥ Mame |

¥ Interface

» IP Address |

¥ Subnet Maszsk

|255.255.255.0 {24y r |

» Enahle (]

Configuration

Item Value setting Description

Name .1 An Optional Setting Enter the name for the alias IP address.
1. A Must filled setting .

Interface . Specify the Interface type. It can be lo or br0.
2. lois set by default
1. An Optional setting

IP Address 2.192.168.123.254 issetby  Enter the addition IP address for this device.

default

1. A Must filled setting
2.255.255.255.0 (/24) is set
by default

Subnet Mask

Select the subnet mask for this gateway from the dropdown list.

Subnet mask defines how many clients are allowed in one network or subnet.
The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 |P
addresses are allowed in this subnet. However, one of them is occupied by LAN
IP address of this gateway, so there are maximum 253 clients allowed in LAN

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.255 (/32).
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Save NA

Click the Save button to save the configuration
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2.2.2 VLAN (not supported)

Not supported feature for the purchased product, leave it as blank.
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2.2.3 DHCP Server

> DHCP Server

The gateway supports up to 4 DHCP servers to fulfill the DHCP requests from different VLAN groups (please
refer to VLAN section for getting more usage details). And there is one default setting for whose LAN IP
Address is the same one of gateway LAN interface, with its default Subnet Mask setting as “255.255.255.0”,
and its default IP Pool ranges is from “.100” to “.200” as shown at the DHCP Server List page on gateway’s

WEB UlI.
‘)

Gateway

x> e

&

12uIay13

@ Meeting Room

553

@ Office Network

User can add more DHCP server configurations by clicking on the “Add” button behind “DHCP Server List”, or
clicking on the “Edit” button at the end of each DHCP Server on list to edit its current settings. Besides, user
can select a DHCP Server and delete it by clicking on the “Select” check-box and the “Delete” button.
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» Fixed Mapping

User can assign fixed IP address to map the specific client MAC address by select them then copy, when targets
were already existed in the DHCP Client List, or to add some other Mapping Rules by manually in advance,
once the target's MAC address was not ready to connect.

-------------------------------------------------

{ PC-A: 00-12-34-AB-CD-0A

EFixedMappingE 192.168.123.150

! PC-B: >
PC-C: 00-12-34-AB-CD-0C | { 10.10.133.181

----------------------------------------------------------------------------------

"
"
"
"
"
*
-
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DHCP Server Setting

Go to Basic Network > LAN & VLAN > DHCP Server Tab.

The DHCP Server setting allows user to create and customize DHCP Server policies to assign IP Addresses to
the devices on the local area network (LAN).

Create / Edit DHCP Server Policy

The gateway allows you to custom your DHCP Server Policy. If multiple LAN ports are available, you can define
one policy for each LAN (or VLAN group), and it supports up to a maximum of 4 policy sets.

T Add || Delete | DHCP Client List |

DHCP

LANIP Lease Domain Primary | Secondary Primary  Secondary .
?qt;r;l:r Address Subnet Mask IP Pool Time Name DNS DNS WINS WINS Gateway Enable Actions
Edit
DHCP 192.168.66.1 255.255.254 0 192165 66.100- 900 0.0.00 0.00.0 0000 0.0.00 0000 v -
1 192.168.66.200 Fixed Mapping

When Add button is applied, DHCP Server Configuration screen will appear.

% DHCP Server Configuration

ltem Setting
» DHCP Server Name IDHCP 2 |
» LAN IP Address 1192.168.2.1 |
¥ Subnet Mask |255255255.0(/24) |
Starting Address: | |
P oot Ending Address: | |
r Lease Time seconds
» Domain Name | | {Optional)
¥ Primary DNS | | (Optional)
¥ Secondary DNS | | (Optional)
b Primary WINS | | (Optional)
b Secondary WINS | | (Optional)
b Gateway | | {Optional)
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DHCP Server
Name

LAN IP
Address

Subnet Mask

IP Pool

Lease Time

Domain Name

Primary DNS

Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Server
Save

Undo

Back

1. String format can be any
text

2. A Must filled setting

1. IPv4 format.

2. A Must filled setting
255.0.0.0 (/8) is set by
default

1. IPv4 format.

2. A Must filled setting

1. Numberic string format.
2. A Must filled setting
String format can be any
text

IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format

The box is unchecked by
default.

N/A

N/A

N/A

Enter a DHCP Server name. Enter a name that is easy for you to understand.

The LAN IP Address of this DHCP Server.

The Subnet Mask of this DHCP Server.

The IP Pool of this DHCP Server. It composed of Starting Address entered in this
field and Ending Address entered in this field.

The Lease Time of this DHCP Server.

Value Range: 300 ~ 604800 seconds.

The Domain Name of this DHCP Server.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.

The Gateway of this DHCP Server.
Click Enable box to activate this DHCP Server.

Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous
setting.

When the Back button is clicked the screen will return to the DHCP Server
Configuration page.

Create / Edit Mapping Rule List on DHCP Server

The gateway allows you to custom your Mapping Rule List on DHCP Server. It supports up to a maximum of 64
rule sets. When Fix Mapping button is applied, the Mapping Rule List screen will appear.

Add || Delete

MAC Address

IP Address Enable Actions

When Add button is applied, Mapping Rule Configuration screen will appear.

42



4G WAN Extender

» MAC Address

ltem

Setting

b IP Address
» Rule Enable
1. MAC Address string
MAC Address  format The MAC Address of this mapping rule.
2. A Must filled setting
1. IPv4 format.
IP Address ) ) The IP Address of this mapping rule.
2. A Must filled setting
The box is unchecked by . . .
Rule Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo N/A
setting.
When the Back button is clicked the screen will return to the DHCP Server
Back N/A

View / Copy DHCP Client List

When DHCP Client List button is applied, DHCP Client List screen will appear.

Configuration page.

Copy to Fixed Mapping

LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions
Ethermnet Dynamic /192.168.123.100 James-P45Y 74:D0:2B:62:80:42 00:49:07 Select
Copy to Fixed Mapping
LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions

When the DHCP Client is selected and Copy to Fixed Mapping button is applied. The IP and MAC address of
DHCP Client will apply to the Mapping Rule List on specific DHCP Server automatically.

Enable / Disable DHCP Server Options

The DHCP Server Options setting allows user to set DHCP OPTIONS 66, 72, or 114. Click the Enable button to
activate the DHCP option function, and the DHCP Server will add the expected options in its sending out
DHCPOFFER DHCPACK packages.
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Optlon Meaning (e

TFTP server name [RFC 2132
72 Default World Wide Web Server [RFC 2132
114 URL [RFC 3679
Setting
» DHCP Server Options [J Enable

Create / Edit DHCP Server Options

The gateway supports up to a maximum of 99 option settings.

= DHCP Server Option List [FXEN

1D Option Name DHCP Sever Select Option Select Type Value Enable Actions

When Add/Edit button is applied, DHCP Server Option Configuration screen will appear.

= DHCP Server Option Configuration

Setting
» Option Name |Option 1 |
» DHCP Sever Select
» Option Select | DHCP OPTION 6B v |
» Type | Single IP Address v |
» Value |
+ Enable O Enable

DHCP Server Option Configuration

Item Value setting Description

1. String format can be any
Option Name text

2. A Must filled setting.
DHCP Server Dropdown list of all available

Enter a DHCP Server Option name. Enter a name that is easy for you to
understand.

Choose the DHCP server this option should apply to.

Select DHCP servers.

1. A Must filled setting. Choose the specific option from the dropdown list. It can be Option 66, Option
Option Select 2. Option 66 is selected by 72, Option 144, Option 42, Option 150, or Option 160.

default. Option 42 for ntp server;
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Option 66 for tftp;

Option 72 for www;

Option 144 for url;

Each different options has different value types.
Single IP Address

66 -
Single FQDN
_ 72 IP Addresses List, separated by “,”
Type Dropdown. list of DHCP 114 Single URL
server option value’s type -
42 IP Addresses List, separated by “,”
150 IP Addresses List, separated by “,”
Single IP Address
160 -
Single FQDN
Should conform to Type :
1. IPv4 format Type Value
2. FQDN format Single IP Address IPv4 format
Value 3. 1P list 66 -
4. URL format Single FQDN FQDN format
5. A Must filled setting 72 IP Addresses List, separated by “,”  IPv4 format, separated by “,”
114 Single URL URL format
Enable The box s unchecked by Click Enable box to activate this setting.
default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed

Create / Edit DHCP Relay

The gateway supports up to a maximum of 6 DHCP Relay configurations.

Add | Delete

DHCP Relay

D Agent Name LAN interface WAN interface Server IP Option 82 Enable Actions

When Add/Edit button is applied, DHCP Relay Configuration screen will appear.
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ltem Setting
» Agent Name | |
» LAN interface
» WAN interface WAN -1 ¥
» Server IP |
» DHCP OPTION 82 =
+ Enable O

1. String format can be any
Agent Name text
2. A Must filled setting.

Enter a DHCP Relay name. Enter a name that is easy for you to understand.
Value Range: 1~64 characters.

1. A Must filled setting. Choose a LAN Interface for the dropdown list to apply with the DHCP Relay
2. LAN is selected by default.  function.

1. A Must filled setting.
WAN Interface 2. WAN-1 is selected by

LAN Interface

Choose a WAN Interface for the dropdown list to apply with the DHCP Relay
function. It can be the available WAN interface(s), and L2TP connection.

default.
Server IP 1. A Must filled setting. Assign a DHCP Server IP Address that the gateway will relay the DHCP requests
2. null by default. to the assigned DHCP server via specified WAN interface.

Click Enable box to activate DHCP OPTION 82 function.
DHCP OPTION The box is unchecked by Option 82 is organized as a single DHCP option that contains circuit-ID
82 default. information known by the relay agent. If the relayed DHCP server required the
such information, you have to enable it, otherwise, just leave it as unchecked.

The box is unchecked by

Enable Click Enable box to activate this setting.
default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed
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2.3 WiFi (not supported)

Not supported feature for the purchased product, leave it as blank.
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2.4 IPv6 (not supported)

Not supported feature for the purchased product, leave it as blank.
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2.5 Port Forwarding

Network address translation (NAT) is a methodology of remapping one IP address space into another by
modifying network address information in Internet Protocol (IP) datagram packet headers while they are in
transit across a traffic routing device. The technique was originally used for ease of rerouting traffic in IP
networks without renumbering every host. It has become a popular and essential tool in conserving global
address space allocations in face of IPv4 address exhaustion. The product you purchased embeds and activates
the NAT function. You also can disable the NAT function in [Basic Network]-[WAN & Uplink]-[Internet Setup]-
[WAN Type Configuration] page.

Widget

' Status W Virtual Server & Virtual Computer Special AP & ALG DMZ & Pass Through

—

Basic Network
. a

- WAN & Uplink Item Setting

- LAN & VLAN » NAT Loopback ¥ Enable

- WiFi Save | Lndo

* IPv6

© Port Forwarding

- Routing

- DNS & DDNS

-

Usually all local hosts or servers behind corporate gateway are protected by NAT firewall. NAT firewall will filter
out unrecognized packets to protect your Intranet. So, all local hosts are invisible to the outside world. Port
forwarding or port mapping is function that redirects a communication request from one address and port
number combination to assigned one. This technique is most commonly used to make services on a host
residing on a protected or masqueraded (internal) network available to hosts on the opposite side of the
gateway (external network), by remapping the destination IP address and port number
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2.5.1 Configuration

NAT Loopback

This feature allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Configuration Setting

Go to Basic Network > Port Forwarding > Configuration tab.

The NAT Loopback allows user to access the WAN IP address from inside your local network.

Enable NAT Loopback

) NAT Loopback °

Item Setting

» MAT Loophack Enahle

Configuration

Item { Value setting Description

NAT Loopback The box is checked by default ~ Check the Enable box to activate this NAT function
Save N/A Click the Save button to save the settings.

Undo N/A Click the Undo button to cancel the settings
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2.5.2 Virtual Server & Virtual Computer

= Configuration . v
Item Setting

» Virtual Server [ Enable

¥ Virtual Computer # Enable

= Virtual Server List XTI ]

1D WAN Interface Public Port Time Schedule | Enable Actions
* Virtual Computer List [~ | x
1D Global IP Local IP Enable Actions

There are some important Pot Forwarding functions implemented within the gateway, including "Virtual
Server", "NAT loopback" and "Virtual Computer".

It is necessary for cooperate staffs who travel outside and want to access various servers behind office
gateway. You can set up those servers by using "Virtual Server" feature. After trip, if want to access those
servers from LAN side by global IP, without change original setting, NAT Loopback can achieve it.

"Virtual computer" is a host behind NAT gateway whose IP address is a global one and is visible to the outside
world. Since it is behind NAT, it is protected by gateway firewall. To configure Virtual Computer, you just have
to map the local IP of the virtual computer to a global IP.
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Virtual Server & NAT Loopback

"Virtual Server" allows you to access servers with the

Network-A global IP address or FQDN of the gateway as if they are

s Slobal P 118.18.81.33 servers existed in the Internet. But in fact, these servers

8@“*2—\@ —g are located in the Intranet and are physically behind the

Remote User ~Fa gateway. The gateway serves the service requests by port

1 ,” [\ 3 forwarding the requests to the LAN servers and transfers

1.Configure E-mail Server (10.0.75.101) _ L the replies from LAN servers to the requester on the

z.aliseanfgtneuljlsz;:i;ssE-maiIServer : < SO WAN side. As shown in example, an E-mail virtual server

3_\:\;:;6;;\:2:;::! ;:;:.ﬁ’fi:{gg)' R et W5 is defined to be located at a server with IP address

User can access local E-mail Server S 10.0.75.101 in the Intranet of Network-A, including SMTP
with Global IP (118.18.81.33) as well. Global IP:118.18.81.44

Local IP:10.0.75.102 service port 25 and POP3 service port 110. So, the

remote user can access the E-mail server with the

gateway’s global IP 118.18.81.33 from its WAN side. But the real E-mail server is located at LAN side and the
gateway is the port forwarder for E-mail service.

NAT Loopback allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Virtual Computer

"Virtual Computer" allows you to assign LAN hosts to
global IP addresses, so that they can be visible to outside
P world. While so, they are also protected by the gateway
firewall as being client hosts in the Intranet. For example,
if you set a FTP file server at LAN side with local IP
address 10.0.75.102 and global IP address 118.18.82.44,

Network-A

Gateway

Remote User

1. Configure File Server as a Virtual ’ >
Computer by Global IP (118.18.81.44). | [ A — a remote user can access the file server while it is hidden

2. Remote User access File Server as by D 1 \
global IP (118.18.81.44) directly E < o~ behind the NAT gateway. That is because the gateway

E-mail Server

B G i takes care of all accessing to the IP address 118.18.82.44,
Fleerver  a including to forward the access requests to the file
Loeal IP:10.0.75.102 server and to send the replies from the server to outside

world.
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Virtual Server & Virtual Computer Setting

Go to Basic Network > Port Forwarding > Virtual Server & Virtual Computer tab.

Enable Virtual Server and Virtual Computer

e BC

Item Setting

» Virtual Server () Enable
¥ Virtual Computer |« Enable

Configuration :
Item Value setting Description

. The box is unchecked by . . . .
Virtual Server default Check the Enable box to activate this port forwarding function
. The box is checked b
Virtual Computer default y Check the Enable box to activate this port forwarding function
efau
Save N/A Click the Save button to save the settings.
Undo N/A Click the Undo button to cancel the settings.

Create / Edit Virtual Server

The gateway allows you to custom your Virtual Server rules. It supports up to a maximum of 20 rule-based
Virtual Server sets.

= Virtual Server List [T ]

Private
1D WAN Interface Server IP Source IP Protocol | Public Port Time Schedule  Enable Actions
Port

When Add button is applied, Virtual Server Rule Configuration screen will appear.
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+ WAN Interface
b Server IP

+ Source IP

¢ Protoco

» Public Port

» Private Port

r Time Schedule

F Rule

Item

Setting
¥ Al WAN-1 WWAN-2 WAN-3
Any v
TCP{6) & UDP(17) ¥
Single Port v
Single Port v

(0) Always *

Enable

WAN Interface

Server IP

Source IP

Protocol

1. A Must filled setting
2. Default is ALL.

A Must filled setting

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. TCP & UDP is selected
by default.

Define the selected interface to be the packet-entering interface of the
gateway.

If the packets to be filtered are coming from WAN-x then select WAN-x for this
field.

Select ALL for packets coming into the gateway from any interface.

It can be selected WAN-x box when WAN-x enabled.

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number of
WAN interfaces for the product.

This field is to specify the IP address of the interface selected in the WAN
Interface setting above.

This field is to specify the Source IP address.

Select Any to allow the access coming from any IP addresses.

Select Specific IP Address to allow the access coming from an IP address.
Select IP Range to allow the access coming from a specified range of IP address.
When “ICMPv4” is selected

It means the option “Protocol” of packet filter rule is ICMPv4.

Apply Time Schedule to this rule, otherwise leave it as Always. (refer to
Scheduling setting under Object Definition)

Then check Enable box to enable this rule.

When “TCP” is selected

It means the option “Protocol” of packet filter rule is TCP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.
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Time Schedule

Rule

Save
Undo

1. An optional filled setting
2. (0) Always Is selected
by default.

1. An optional filled setting
2.The box is unchecked by
default.

N/A

N/A

When “UDP” is selected

It means the option “Protocol” of packet filter rule is UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “TCP & UDP” is selected

It means the option “Protocol” of packet filter rule is TCP and UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “GRE” is selected
It means the option “Protocol” of packet filter rule is GRE.

When “ESP” is selected
It means the option “Protocol” of packet filter rule is ESP.

When “SCTP” is selected
It means the option “Protocol” of packet filter rule is SCTP.

When “User-defined” is selected
It means the option “Protocol” of packet filter rule is User-defined.
For Protocol Number, enter a port number.

Apply Time Schedule to this rule; otherwise leave it as (0) Always. (refer to
Scheduling setting under Object Definition)

Check the Enable box to activate the rule.

Click the Save button to save the settings.

Click the X button to cancel the settings and return to previous page.
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Create / Edit Virtual Computer

The gateway allows you to custom your Virtual Computer rules. It supports up to a maximum of 20 rule-based
Virtual Computer sets.

« Virtual Computer List

1D Global IP Local IP Enable Actions

When Add button is applied, Virtual Computer Rule Configuration screen will appear.

& Virtual Computer Rule Configuration

Global IP Local IP Enable
| | | | g

Virtual Computer Rule Configuration

Item Value setting Description

Global IP A Must filled setting This field is to specify the IP address of the WAN IP.
Local IP A Must filled setting This field is to specify the IP address of the LAN IP.
Enable N/A Then check Enable box to enable this rule.

Save N/A Click the Save button to save the settings.
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2.5.3 DMZ & Pass Through

DMZ (De Militarized Zone) Host is a host that is exposed to the Internet cyberspace but still within the
protection of firewall by gateway device. So, the function allows a computer to execute 2-way communication
for Internet games, Video conferencing, Internet telephony and other special applications. In some cases
when a specific application is blocked by NAT mechanism, you can indicate that LAN computer as a DMZ host

to solve this problem.

The DMZ function allows you to ask the gateway pass through all normal packets to the DMZ host behind the
NAT gateway only when these packets are not expected to receive by applications in the gateway or by other
client hosts in the Intranet. Certainly, the DMZ host is also protected by the gateway firewall. Activate the
feature and specify the DMZ host with a host in the Intranet when needed.

Item
# Enable ¥ All
r DMz DMZ Host = [10.0.75.100
» Pass Through Enahle ¥ IPSec «# FPTF [« LITP
DMZ Scenario

Global IP:118.18.81.33

Q Local IP: 10.0.75.2
Gateway
g" ;—‘-,—@ ----------- -b

Remote User

1.Set X Server as DMZ Host

2.Request X server service by Gateway Global IP
3.Gateway redirect service request to DMZ host:
10.0.75.100

X Server

Setting

AN WAN-3 AN

When the network administrator wants to set up
some service daemons in a host behind NAT
gateway to allow remote users request for services
from server actively, you just have to configure this
host as DMZ Host. As shown in the diagram, there
is an X server installed as DMZ host, whose IP
address is 10.0.75.100. Then, remote user can
request services from X server just as it is provided
by the gateway whose global IP address is
118.18.81.33. The gateway will forward those
packets, not belonging to any configured virtual
server or applications, directly to the DMZ host.
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VPN Pass through Scenario

NetworlcA @ HQ et Conter Since VPN traffic is different from that of TCP or
— - UDP connection, it will be blocked by NAT gateway.
E}E/ \@J acs To support the pass through function for the VPN

Apbg'.ﬁn s connections initiating from VPN clients behind NAT
Server ol P EL L Ll A U gateway, the gateway must implement some kind

Gateway without
VPN Pass Through

bf] server,
e m@ of VPN pass through function for such application.
4 \ N The gateway support the pass through function for
PRI ( ATl IPSec, PPTP, and L2TP connections, you just have
Security Gatewayl &= — — = = = = = = = = = — — — — ] ) )
with a “Staticlp” |  Establish VPN tunnel to check the corresponding checkbox to activate it.

successfully VPN Pass Through behind NAT Gateway
Global IP: 203.95.80.22
Local IP: 10.0.76.2

DMZ & Pass Through Setting

Go to Basic Network > Port Forwarding > DMZ & Pass Through tab.

The DMZ host is a host that is exposed to the Internet cyberspace but still within the protection of firewall by
gateway device.

Enable DMZ and Pass Through

ltem Setting
Enahle Al WAARN-1 WA VAN WAN-4
» DMz DMZ Hast
» Pass Through Enable # IFSec & FFTP [« LZTF
bMz 1. A Must filled setting Check the Enable box to activate the DMZ function
2. Default is ALL. Define the selected interface to be the packet-entering interface of the

gateway, and fill in the IP address of Host LAN IP in DMZ Host field

If the packets to be filtered are coming from WAN-x then select WAN-x for
this field.

Select ALL for packets coming into the router from any interfaces.

It can be selected WAN-x box when WAN-x enabled.
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Pass Through Enable  The boxes are checked by

default
Save N/A
Undo N/A

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number
of WAN interfaces for the product.

Check the box to enable the pass through function for the IPSec, PPTP, and
L2TP.

With the pass through function enabled, the VPN hosts behind the gateway
still can connect to remote VPN servers.

Click the Save button to save the settings.

Click the Undo button to cancel the settings

59



4G WAN Extender

2.6 Routing
' Status W * Dynamic Routing  Routing Information Widget

P

Basic Netwo
- - x
R Item Setting
EE——— » Static Routing [} Enable
- WiFi
- Add § Delste - I x
D Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions
= Port Forwarding
Sy

- DNS & DDNS

If you have more than one router and subnet, you will need to enable routing function to allow packets to find
proper routing path and allow different subnets to communicate with each other. Routing is the process of
selecting best paths in a network. It is performed for many kinds of networks, like electronic data networks
(such as the Internet), by using packet switching technology. The routing process usually directs forwarding on
the basis of routing tables which maintain a record of the routes to various network destinations. Thus,
constructing routing tables, which are held in the router's memory, is very important for efficient routing. Most
routing algorithms use only one network path at a time.

The routing tables record your pre-defined routing paths for some specific destination subnets. It is static
routing. However, if the contents of routing tables record the obtained routing paths from neighbor routers by
using some protocols, such as RIP, OSPF and BGP. It is dynamic routing. These both routing approaches will be
illustrated one after one. In addition, the gateway also built in one advanced configurable routing software
Quagga for more complex routing applications, you can configure it if required via Telnet CLI.
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2.6.1 Static Routing

Configuration

\l( Enable

Static No
Routing?

Yes

Setup

4 Static Routing
Rule List

¢ Check

Finish?
¢ Neo

Static Routing
Rule Configuration

B —

ftem Sutting
F Stak 0 # Enable
Add || Delele
I Dastination IP Subnet Mask Gateway IF interface Matriz  Enable Actiens
Itam Setting
v Dheztination (P
v Sybnat Mash 2555 1B50(124) -
v Gatevay B
v intertace ¥
b bletr

Enable

"Static Routing" function lets you define the routing paths for some dedicated hosts/servers or subnets to
store in the routing table of the gateway. The gateway routes incoming packets to different peer gateways
based on the routing table. You need to define the static routing information in gateway routing rule list.

@) Google(173.194.72.94): -> WAN-1
Yahoo(188.125.73.108): -> WAN-2

ISP-DSLAM

| Static Routing: Enable |

[Static Routing]-[Static Routing Rule List]

152.168.121.253

Cellular (‘&

((9)) Gateway

ID1:
Destination IP: 173.194.72.94
Subnet Mask: 255.255.255.255
Gateway:192.168.121.253
Metric: 255
Rule: Enable

ID2:
Destination IP: 188.125.73.108
Subnet Mask: 255.255.255.255
Gateway: 192.168.22.1
Metric: 255
Rule: Enable

When the administrator of the gateway wants to
specify what kinds of packets to be transferred via
which gateway interface and which peer gateway to
their destination. It can be carried out by the "Static
Routing" feature. Dedicated packet flows from the
Intranet will be routed to their destination via the pre-
defined peer gateway and corresponding gateway
interface that are defined in the system routing table
by manual.

As shown in the diagram, when the destination is
Google access, rule 1 set interface as ADSL, routing
gateway as IP-DSLAM gateway 192.168.121.253. All the
packets to Google will go through WAN-1. And the
same way applied to rule 2 of access Yahoo. Rule 2 sets
3G/4G as interface.

61



4G WAN Extender

Static Routing Setting

Go to Basic Network > Routing > Static Routing Tab.

There are three configuration windows for static routing feature, including "Configuration"”, "Static Routing
Rule List" and "Static Routing Rule Configuration" windows. "Configuration" window lets you activate the
global static routing feature. Even there are already routing rules, if you want to disable routing temporarily,
just uncheck the Enable box to disable it. "Static Routing Rule List" window lists all your defined static routing
rule entries. Using "Add" or "Edit" button to add and create one new static routing rule or to modify an
existed one.

When "Add" or "Edit" button is applied, the "Static Routing Rule Configuration" window will appear to let you
define a static routing rule.

Enable Static Routing

Just check the Enable box to activate the "Static Routing" feature.

Item Setting

» Static Routing + Enable

The box is unchecked by

Static Routing
default

Check the Enable box to activate this function

Create / Edit Static Routing Rules

The Static Routing Rule List shows the setup parameters of all static routing rule entries. To configure a static
routing rule, you must specify related parameters including the destination IP address and subnet mask of
dedicated host/server or subnet, the IP address of peer gateway, the metric and the rule activation.

Add || Delete

1D Destination IP Subnet Mask Gateway [P Interface Metric Enable Actions

The gateway allows you to custom your static routing rules. It supports up to a maximum of 64 rule sets. When
Add button is applied, Static Routing Rule Configuration screen will appear, while the Edit button at the end
of each static routing rule can let you modify the rule.
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% |Pv4 Static Routing Rule Configuration

ltem Setting

+ Destination [P | |
» Subnet Mask 12552552550 (/24) v |

v Gateway IF | |

¥ Interface
¥ Metric I:I

+ Rule [ Enable

IPv4 Static Routing

Item [ Value setting [ Description
N 1. IPv4 Format
Destination IP . . Specify the Destination IP of this static routing rule.
2. A Must filled setting
255.255.255.0 (/24) isset b
Subnet Mask (/24) v Specify the Subnet Mask of this static routing rule.
default
1. IPv4 Format . . . .
Gateway IP . . Specify the Gateway IP of this static routing rule.
2. A Must filled setting
. Select the Interface of this static routing rule. It can be Auto, or the available
Interface Auto is set by default .
WAN / LAN interfaces.
Metric 1. Numberic String Format The Metric of this static routing rule.
2. A Must filled setting Value Range: 0 ~ 255.
The box is unchecked b
Rule Y Click Enable box to activate this rule.
default.
Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous
setting.
Back NA When the Back button is clicked the screen will return to the Static Routing
Configuration page.
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2.6.2 Dynamic Routing

=] RIP Configuration

Item Setting
=1 » RIP Enable Disable ~
Configuration =] OSPF Configuration ’ n
Item Setting
» OSPF [~ Enable
» Router ID |
» Authentication None -
» Backbone Subnet |
OSPF Area List?
= osre avea Lt [L11 -]
ID Area Subnet Area ID Enable Actions
OFPF Are_a = OSPF Area Configuration ’ a
Configuration
Item Setting
» Area Subnet I
» Area ID [
» Area [~ Enable

|\_
a
—
x

BGP Network = BGP Configuration
Configuration Item Setting
» BGP [~ Enable
BGP *ASN |
Metwork List? » Router ID |
Ep—— -
BGP Neighbor )
. ID Network Subnet Enable Actions
Configuration
8 = BGP Neighbor List ’
ID Neighbor IP Remote ASN Enable Actions

Dynamic Routing, also called adaptive routing, describes the capability of a system, through which routes are
characterized by their destination, to alter the path that the route takes through the system in response to a

change in network conditions.

This gateway supports dynamic routing protocols, including RIPv1/RIPv2 (Routing Information Protocol), OSPF
(Open Shortest Path First), and BGP (Border Gateway Protocol), for you to establish routing table
automatically. The feature of dynamic routing will be very useful when there are lots of subnets in your
network. Generally speaking, RIP is suitable for small network. OSPF is more suitable for medium network.

BGP is more used for big network infrastructure.
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The supported dynamic routing protocols are described as follows.

RIP Scenario
Network-A
@Routing Table#1
SPDSIAM (@ @
RIPEnabled
' ; WAN-1: ADSL
\@ C 118.18.81.33 Gateway
11818811 Y S
e @Routing Tablei#1 + #2
OBasicNetwork-Routiné o Lan
o et LAN
[Dynamic Routing]-[RIP §onfiguration] ((( )))
RIP:RIPVLOTRIP2 |

‘,»f 203.95.30,1

Cellular Network
1

@Routing Table#2 |

OSPF Scenario

Gateway Settings:

[Dynamic Routing]-{OSPF Configuratia

OSPF:Enable
Backbone Subnet: 192.168.0.0/16

[Dynamic Routing]-[OSPF Area List]
DL
Area Subnet: 192.168.101.0/24
ArealD: 192.168.101.254
Area: Enable

D2 SPF Gateway

Area Subnet: 192.168.102.0/24
Areal
Area Subnét; 192,168.101.0/, \
ArealD:192.168.101.254
6

AreaD: 192.168.102.254 i

Area: Enable

The Routing Information Protocol (RIP) is one of the
oldest distance-vector routing protocols, which
employs the hop count as a routing metric. RIP
prevents routing loops by implementing a limit on the
number of hops allowed in a path from the source to a
destination. The maximum number of hops allowed
for RIP is 15. This hop limit, however, also limits the
size of networks that RIP can support. A hop count of
16 is considered an infinite distance, in other words
the route is considered unreachable. RIP implements
the split horizon, route poisoning and hold-down
mechanisms to prevent incorrect routing information
from being propagated.

Open Shortest Path First (OSPF) is a routing protocol
that uses link state routing algorithm. It is the most
widely used interior gateway protocol (IGP) in large
enterprise networks. It gathers link state information
from available routers and constructs a topology map
of the network. The topology is presented as a routing
table which routes datagrams based solely on the
destination IP address.

Network administrator can deploy OSPF gateway in
large enterprise network to get its routing table from
the enterprise backbone, and forward routing
information to other routers, which are no linked to
the enterprise backbone. Usually, an OSPF network is
subdivided into routing areas to simplify
administration and optimize traffic and resource
utilization.

As shown in the diagram, OSPF gateway gathers routing information from the backbone gateways in area 0O,
and will forward its routing information to the routers in area 1 and area 2 which are not in the backbone.
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BGP Scenario

Border Gateway Protocol (BGP) is a standard exterior
gateway protocol designed to exchange routing and
reachability information between autonomous systems
(AS) on the Internet. It usually makes routing decisions
based on paths, network policies, or rule-sets.

Most ISPs use BGP to establish routing between one
another (especially for multi-homed). Very large private
IP networks also use BGP internally. The major BGP
gateway within one AS will links with some other
border gateways for exchanging routing information. It
will distribute the collected data in AS to all routers in
other AS.

As shown in the diagram, BGP 0 is gateway to dominate

ASO (self IP is 10.100.0.1 and self ID is 100). It links with other BGP gateways in the Internet. The scenario is
like Subnet in one ISP to be linked with the ones in other ISPs. By operating with BGP protocol, BGP 0 can
gather routing information from other BGP gateways in the Internet. And then it forwards the routing data to
the routers in its dominated AS. Finally, the routers resided in AS 0 know how to route packets to other AS.
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Dynamic Routing Setting

Go to Basic Network > Routing > Dynamic Routing Tab.

The dynamic routing setting allows user to customize RIP, OSPF, and BGP protocol through the router based
on their office setting.

In the "Dynamic Routing" page, there are several configuration windows for dynamic routing feature. They are
the "RIP Configuration" window, "OSPF Configuration" window, "OSPF Area List", "OSPF Area Configuration",
"BGP Configuration"”, "BGP Neighbor List" and "BGP Neighbor Configuration" window. RIP, OSPF and BGP
protocols can be configured individually.

The "RIP Configuration" window lets you choose which version of RIP protocol to be activated or disable it.
The "OSPF Configuration" window can let you activate the OSPF dynamic routing protocol and specify its
backbone subnet. Moreover, the "OSPF Area List" window lists all defined areas in the OSPF network.
However, the "BGP Configuration" window can let you activate the BGP dynamic routing protocol and specify
its self ID. The "BGP Neighbor List" window lists all defined neighbors in the BGP network.

RIP Configuration

The RIP configuration setting allows user to customize RIP protocol through the router based on their office
setting.

Item Setting

» RIP Enable IDTsable vl

Select Disable will disable RIP protocol.
RIP Enable Disable is set by default Select RIP v1 will enable RIPv1 protocol.
Select RIP v2 will enable RIPv2 protocol.

OSPF Configuration

The OSPF configuration setting allows user to customize OSPF protocol through the router based on their
office setting.
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* OSPF Configuration ’ ®
ltem Setting

» OSPF [~ Enable

» Router ID |

» Authentication None ~

» Backbone Subnet |

OSPF Configuration

Item Value setting Description

OSPF Disable is set by default Click Enable box to activate the OSPF protocol.
1. IPv4 Format

Router ID The Router ID of this router on OSPF protocol

2. A Must filled setting

The Authentication method of this router on OSPF protocol.

Select None will disable Authentication on OSPF protocol.

Select Text will enable Text Authentication with entered the Key in this field on
OSPF protocol.

Select MD5 will enable MD5 Authentication with entered the ID and Key in
these fields on OSPF protocol.

Authentication None is set by default

1. Classless Inter Domain

Routing (CIDR) Subnet

Mask Notation. (Ex: The Backbone Subnet of this router on OSPF protocol.
192.168.1.0/24)

2. A Must filled setting

Backbone
Subnet

Create / Edit OSPF Area Rules

The gateway allows you to custom your OSPF Area List rules. It supports up to a maximum of 32 rule sets.

% OSPF Area List

Area Subnet

When Add button is applied, OSPF Area Rule Configuration screen will appear.
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* OSPF Area Configuration

Item Setting
» Area Subnet |
» Area ID I
» Area [ Enable
_Save |

OSPF Area Configuration
Item Value setting
1. Classless Inter Domain
Routing (CIDR) Subnet
Area Subnet Mask Notation. (Ex:
192.168.1.0/24)
2. A Must filled setting

Description

The Area Subnet of this router on OSPF Area List.

1. IPv4 Format

Area ID : . The Area ID of this router on OSPF Area List.
2. A Must filled setting
The box is unchecked b
Area Y Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
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BGP Configuration

The BGP configuration setting allows user to customize BGP protocol through the router setting.

R - |-

Item Setting

» BGP [ Enable

» ASN |

» Router ID |

BGP Network Configuration

Item Value setting Description

BGP The box is unchecked by Check the Enable box to activate the BGP protocol.
default

ASN 1. Numberic String Format  The ASN Number of this router on BGP protocol.
2. A Must filled setting Value Range: 1 ~ 4294967295.

Router ID 1. IPv4 Format The Router ID of this router on BGP protocol.
2. A Must filled setting

Create / Edit BGP Network Rules

The gateway allows you to custom your BGP Network rules. It supports up to a maximum of 32 rule sets.

% BGP Network List

Network Subnet

When Add button is applied, BGP Network Configuration screen will appear.

= BGP Network Configuration . %

Item Setting

» Network Subnet P |255.255.255.0 (/24) -]

» Network [ Enable

_Save |

Item Value setting Description

1. IPv4 Format The Network Subnet of this router on BGP Network List. It composes of entered
2. A Must filled setting the IP address in this field and the selected subnet mask.

Network Subnet
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The box is unchecked by . . .
Network Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration

Create / Edit BGP Neighbor Rules

The gateway allows you to custom your BGP Neighbor rules. It supports up to a maximum of 32 rule sets.

=1 BGP Neighbor List

Neighbor IP Remote ASN Actions

When Add button is applied, BGP Neighbor Configuration screen will appear.

« BGP Neighbor Configuration a x

Item Setting

» Neighbor IP |

» Remote ASN |

+ Neighbor [ Enable

BGP Neighbor Configuration

Item Value setting

. 1.IPv4 F t
Neighbor IP v orr.na . The Neighbor IP of this router on BGP Neighbor List.
2. A Must filled setting
1. Numberic String Format The Remote ASN of this router on BGP Neighbor List.
Remote ASN
2. A Must filled setting Value Range: 1 ~ 4294967295.
. The box is unchecked by . . .
Neighbor Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
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2.6.3 Routing Information

The routing information allows user to view the routing table and policy routing information. Policy Routing
Information is only available when the Load Balance function is enabled and the Load Balance Strategy is By

User Policy.

Go to Basic Network > Routing > Routing Information Tab.

% Routing Table ' *

Destination IP Subnet Mask Gateway IP Metric Interface
100.105.167.72 255255255252 0000 0 WAN-2
192.168.66.0 255.255.255.0 0.0.00 0 LAN
1921681270 2552552550 0000 0 WAN-1
16925400 25525500 0000 0 LAN
127.0.0.0 255.0.00 0.0.00 0 lo

\ Routing Table \
Item Value setting Description
Destination IP N/A Routing record of Destination IP. IPv4 Format.
Subnet Mask N/A Routing record of Subnet Mask. IPv4 Format.
Gateway IP N/A Routing record of Gateway IP. IPv4 Format.
Metric N/A Routing record of Metric. Numeric String Format.
Interface N/A Routing record of Interface Type. String Format.

= Policy Routing Information

Policy Routing Source

Source IP

Destination IP

Destination Port

WAN Interface

Load Balance

Policy Routing Information

Item Value setting Description

Policy Routing Source  N/A Policy Routing of Source. String Format.

Source IP N/A Policy Routing of Source IP. IPv4 Format.
Destination IP N/A Policy Routing of Destination IP. IPv4 Format.
Destination Port N/A Policy Routing of Destination Port. String Format.
WAN Interface N/A Policy Routing of WAN Interface. String Format.
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2.7 DNS & DDNS

How does user access your server if your WAN IP address changes all the time? One way is to register a new
domain name, and maintain your own DNS server. Another simpler way is to apply a domain name to a third-
party DDNS service provider. The service can be free or charged. If you want to understand the basic concepts
of DNS and Dynamic DNS, you can refer to Wikipedia website "%,

2.7.1 DNS & DDNS Configuration

Dynamic DNS

Inform
DDNS Server Network-A

e _ Global IP: 118.18.81.33 > .44 (U WANIP
TEL ~FQDN: mygw.no-ip.org Changed

£ Gateway

S
_______ Local IP: 10.0.75.2

@
Updateto el \
Root Name Server Public :

DNS Servers .
!

E-mail Server \5
Local IP: 10.0.75.101 §

No-IP
DDNS Server

Remote User File Server
Local IP: 10.0.75.102

Global IP: 118.18.81.44.

Access E-mail Server
(mygw.no-ip.org) from Internet

To host your server on a changing IP address, you
have to use dynamic domain name service (DDNS).
Therefore, anyone wishing to reach your host only
needs to know the domain name. Dynamic DNS will
map the name of your host to your current IP
address, which changes each time you connect your
Internet service provider.

The Dynamic DNS service allows the gateway to alias
a public dynamic IP address to a static domain name,
allowing the gateway to be more easily accessed
from various locations on the Internet. As shown in
the diagram, user registered a domain name to a

third-party DDNS service provider (NO-IP) to use DDNS function. Once the IP address of designated WAN
interface has changed, the dynamic DNS agent in the gateway will inform the DDNS server with the new IP
address. The server automatically re-maps your domain name with the changed IP address. So, other hosts or
remote users in the Internet world are able to link to your gateway by using your domain name regardless of

the changing global IP address.

7 http://en.wikipedia.org/wiki/Domain_Name_System
8 http://en.wikipedia.org/wiki/Dynamic_DNS

73



4G WAN Extender

DNS & DDNS Setting

Go to Basic Network > DNS & DDNS > Configuration Tab.

The DNS & DDNS setting allows user to setup Dynamic DNS feature and DNS redirect rules.

Setup Dynamic DNS

The gateway allows you to custom your Dynamic DNS settings.

= Dynamic DNS ’ x
ltem Setting

» DDNS [ Enable

» WAN Interface IWAN‘l *I

 Provider | DynDNS.org(Dynamic) - |

» Host Name |

» User Name / E-Mail |

+ Password / Key I

The box is unchecked by

DDNS Check the Enable box to activate this function.
default
WAN Interface WAN 1 is set by default Select the WAN Interface IP Address of the gateway.
Provider DynDNS.org (Dynamic) is Select your DDNS provider of Dynamic DNS. It can be DynDNS.org(Dynamic),
set by default DynDNS.org(Custom), NO-IP.com, etc...
1. String format can be any . .
Your registered host name of Dynamic DNS.
Host Name text Value R 0~63ch
alue Range: 0 ~ 63 characters.
2. A Must filled setting —ate Tange
1. String format can be any
User Name / E-

Mail text Enter your User name or E-mail addresss of Dynamic DNS.
2. A Must filled setting
1. String format can be any

Password / Key  text Enter your Password or Key of Dynamic DNS.
2. A Must filled setting

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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Setup DNS Redirect

DNS redirect is a special function to redirect certain traffics to a specified host. Administator can manage the
internet / intranet traffics that are going to access some restricted DNS and force those traffics to be redirected
to a specified host.

# DNS Redirect ®

ltem Setting

» DNS Redirect [ Enable

DNS Redirect Configuration

Item Value setting Description
. The box is unchecked b
DNS Redirect Y Check the Enable box to activate this function.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

If you enabled the DNS Redirect function, you have to further specify the redirect rules. According to the rules,
the gateway can redirect the traffic that matched the DNS to corresponding pre-defined IP address.

* RedirectRule | .l Delete

Mapping Rule Condition

Description

When Add button is applied, Redirect Rule screen will appear.

« Redirect Rule oo . x

Item Setting

Domain Name IP
Mapping Rule

| (* for Any)

Condition I Always - |

Description |

Enable ™ Enable

Redirect Rule Configuration

Item Value setting Description

1. String format can be any  Enter a domain name to be redirect. The traffic to specified domain name will
Domain Name text be redirect to the following IP address.

2. A Must filled setting Value Range: at least 1 character is required; ‘*' for any.
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Condition

Description

Enable

Save
Undo

1. IPv4 format
2. A Must filled setting

1. A Must filled setting
2. Always is selected by
default.

1. String format can be any
text

2. A Must filled setting

The box is unchecked by
default

N/A

N/A

Enter an IP Address as the target for the DNS redirect.

Specify when will the DNS redirect action can be applied.
It can be Always, or WAN Block.

Always: The DNS redirect function can be applied to matched DNS all the time.

WAN Block: The DNS redirect function can be applied to matched DNS only
when the WAN connection is disconneced, or un-reachable.

Enter a brief description for this rule.
Value Range: 0 ~ 63 characters.

Click the Enable button to activate this rule.

Click Save to save the settings
Click Undo to cancel the settings

76



4G WAN Extender

Chapter 3 Object Definition

3.1 Scheduling

Scheduling provides ability of adding/deleting time schedule rules, which can be applied to other functionality.

3.1.1 Scheduling Configuration

Go to Object Definition > Scheduling > Configuration tab.

= Time Schedule List | /.0i[| Delete

Rule Name

Button description

Item Value setting Description
Add N/A Click the Add button to configure time schedule rule
Delete N/A Click the Delete button to delete selected rule(s)

When Add button is applied, Time Schedule Configuration and Time Period Definition screens will appear.

= Time Schedule Configuration

Item Setting

» Rule Name |

F Rule POIiC'y" Inactivate = the Selected DEI.YS and Hours Below.

Time Schedule Configuration

Item Value Setting Description
Rule Name String: any text Set rule name
Rule Policy Default Inactivate Inactivate/activate the function been applied to in the time period below
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% Time Period Definition

ID Week Day Start Time (hh:mm) End Time (hh:mm)
1 | — choose one — | I— |—
2 | -- choose one -- j |— I—
3 | -- choose one — +| |— I—
4 | -- choose one — j I— |—
5 | -- choose one — +| |— I—
6 | -- choose one — +| |— I—
7 | -- choose one — j I— |—
8 | — choose one — | |— |—

\ Time Period Definition

Item Value Setting Description

Week Day Select from menu Select everyday or one of weekday

Start Time Time format (hh :mm) Start time in selected weekday

End Time Time format (hh :mm) End time in selected weekday

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Refresh N/A Click the Refresh button to refresh the time schedule list.
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3.2 User (not supported)

Not supported feature for the purchased product, leave it as blank.
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3.3 Grouping

The Grouping function allows user to make group for some services.

3.3.1 Host Grouping

Go to Object Definition > Grouping > Host Grouping tab.

The Host Grouping function allows user to make host group for some services, such as QoS, Firewall, and
Communication Bus. The supported service types could be different for the purchased product.

= Host Group List | /10| Delete "
ID Group Name Group Type Member List Bound Services Enable Actions

When Add button is applied, Host Group Configuration screen will appear.

% Host Group Configuration

Item Setting
¥ Group Name |
» Group Type |IP Address-based EI
» Member to Join | Join
» Member List
» Bound Services [~ Firewall
» Group | " Enable

Host Group Configuration

Item Value setting Description

1. String format can

Group Name be any text Enter a group name for the rule. It is a name that is easy for you to understand.
2. A Must filled setting

Select the group type for the host group. It can be IP Address-based, MAC

. Address-based, or Host Name-based.
1. IP Address-based is

Group Type selected by default.
2. A Must filled setting

When IP Address-based is selected, only IP address can be added in Member to
Join.

When MAC Address-based is selected, only MAC address can be added in
Member to Join.
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Member to Join

Member List

Bound Services

Group

Save
Undo

N/A

NA

The boxes are
unchecked by default

The box is unchecked
by default

N/A

N/A

When Host Name-based is selected, only host name can be added in Member
to Join.

Note: The available Group Type can be different for the purchased model.

Add the members to the group in this field.

You can enter the member information as specified in the Member Type above,
and press the Join button to add.

Only one member can be add at a time, so you have to add the members to the
group one by one.

This field will indicate the hosts (members) contained in the group.

Binding the services that the host group can be applied. If you enable the
Firewall, the produced group can be used in firewall service. Same as by enable
QoS, or other available service types.

Note: The supported service type can be different for the purchased product.
Check the Enable checkbox to activate the host group rule. So that the group
can be bound to selected service(s) for further configuration.

Click Save to save the settings

Click Undo to cancel the settings
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3.4 External Server

Go to Object Definition > External Server > External Server tab.

The External Server setting allows user to add external server.

Create External Server

= External Server List

Server Name Server Type Server IPIFQDN Server Port Actions
When Add button is applied, External Server Configuration screen will appear.
& External Server Configuration ' ®
ltem Setting
» Server Name |
IEmaiI Server j
» Server Type User Name: |
Password: |
» Server IP/FQDN |
» Server Port |25
» Server [v Enable
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1. String format can be
Sever Name any text Enter a server name. Enter a name that is easy for you to understand.
2. A Must filled setting

Specify the Server Type of the external server, and enter the required settings
for the accessing the server.

Email Server (A Must filled setting) :

When Email Server is selected, User Name, and Password are also required.
User Name (String format: any text)

Password (String format: any text)

RADIUS Server (A Must filled setting) :
When RADIUS Server is selected, the following settings are also required.
Primary :
Shared Key (String format: any text)
Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)
The values must be between 1 and 60.
Idle Timeout: (By default 1)
The values must be between 1 and 15.
Secondary :
Shared Key (String format: any text)
Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)
Server Type A Must filled setting The values must be between 1 and 60.
Idle Timeout: (By default 1)
The values must be between 1 and 15.

Active Directory Server (A Must filled setting) :
When Active Directory Server is selected, Domain setting is also required.
Domain (String format: any text)

LDAP Server (A Must filled setting) :

When LDAP Server is selected, the following settings are also required.
Base DN (String format: any text)

Identity (String format: any text)

Password (String format: any text)

UAM Server (A Must filled setting) :

When UAM Server is selected, the following settings are also required.
Login URL (String format: any text)

Shared Secret (String format: any text)

NAS/Gateway ID (String format: any text)

Location ID (String format: any text)

Location Name (String format: any text)
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TACACS+ Server (A Must filled setting) :

When TACACS+ Server is selected, the following settings are also required.
Shared Key (String format: any text)

Session Timeout (String format: any number)

The values must be between 1 and 60.

SCEP Server (A Must filled setting) :

When SCEP Server is selected, the following settings are also required.
Path (String format: any text, By default cgi-bin is filled)

Application (String format: any text, By default pkiclient.exe is filled)

FTP(SFTP) Server (A Must filled setting) :

When FTP(SFTP) Server is selected, the following settings are also required.
User Name (String format: any text)

Password (String format: any text)

Protocol (Select FTP or SFTP)

Encryprion (Select Plain, Explicit FTPS or Implicit FTPS)

Transfer mode (Select Passive or Active)

Server IP/FQDN

A Must filled setting

Specify the IP address or FQDN used for the external server.

Server Port

A Must filled setting

Specify the Port used for the external server. If you selected a certain server
type, the default server port number will be set.

For Email Server 25 will be set by default;

For Syslog Server, port 514 will be set by default;

For RADIUS Server, port 1812, 1823 will be set by default;
For Active Directory Server, port 389 will be set by default;
For LDAP Server, port 389 will be set by default;

For UAM Server, port 3990, 4990 will be set by default;
For TACACS+ Server, port 49 will be set by default;

For SCEP Server, port 80 will be set by default;

For FTP(SFTP) Server, port 21 will be set by default;

Value Range: 1 ~ 65535.

Account Port

1. A Must filled setting
2. 1813 is set by default

Specify the accounting port used if you selected external RADIUS server.
Value Range: 1 ~ 65535.

The box is checked by

Server Click Enable to activate this External Server.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
Refresh N/A Click the Refresh button to refresh the external server list.
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3.5 Certificate

In cryptography, a public key certificate (also known as a digital certificate or identity certificate) is an
electronic document used to prove ownership of a public key. The certificate includes information about the
key, information about its owner's identity, and the digital signature of an entity that has verified the
certificate's contents are genuine. If the signature is valid, and the person examining the certificate trusts the
signer, then they know they can use that key to communicate with its owner”.

In a typical public-key infrastructure (PKI) scheme, the signer is a certificate authority (CA), usually a company
such as VeriSign which charges customers to issue certificates for them. In a web of trust scheme, the signer is
either the key's owner (a self-signed certificate) or other users ("endorsements") whom the person examining
the certificate might know and trust. The device also plays as a CA role.

Certificates are an important component of Transport Layer Security (TLS, sometimes called by its older name
SSL), where they prevent an attacker from impersonating a secure website or other server. They are also used
in other important applications, such as email encryption and code signing. Here, it can be used in IPSec
tunneling for user authentication.

3.5.1 Configuration

The configuration setting allows user to create Root Certificate Authority (CA) certificate and configure to set
enable of SCEP. Root CA is the top-most certificate of the tree, the private key of which is used to "sign" other
certificates.

Go to Object Definition > Certificate > Configuration tab.

Create Root CA

J Generate |

ID Name Subject Issuer Vaild To Action

When Generate button is applied, Root CA Certificate Configuration screen will appear. The required
information to be filled for the root CA includes the name, key, subject name and validity.

9 http://en.wikipedia.org/wiki/Public_key_certificate.
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= Root CA Certificate Configuration

Item Setting

F Name I
» Key Key Type : I RSA ,l Key Length : I 512-hits .I Digest Algorithm : I MD5 .l
Country(C) : I State(ST) : I Location(L) : I

» Subject Name Organization(O) - | Organization Unit(OU) -

Common Name(CN) : | E-mail - |
» Validity Period I 20-years 'I

Root CA Certificate Configuration

Value setting Description \
1. String format can be any

Name text Enter a Root CA Certificate name. It will be a certificate file name
2. A Must filled setting

This field is to specify the key attribute of certificate.

Key Type to set public-key cryptosystems. It only supports RSA now.

Key Length to set s the size measured in bits of the key used in a cryptographic
Key A Must filled setting v ) g y yptograp

algorithm.

Digest Algorithm to set identifier in the signature algorithm identifier of

certificates

This field is to specify the information of certificate.
Country(C) is the two-letter ISO code for the country where your organization is
located.
State(ST) is the state where your organization is located.
Subject Name A Must filled setting Location(L) is the location where your organization is located.
Organization(0O) is the name of your organization.
Organization Unit(OU) is the name of your organization unit.
Common Name(CN) is the name of your organization.
Email is the email of your organization. It has to be email address style.
Validity Period A Must filled setting This field is to specify the validity period of certificate.
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Setup SCEP
& SCEP Configuration

ltem

Setting

» SCEP

™ Enable

certificates

» Automatically re-enroll aging [~ Enable

\ SCEP Configuration

\ Item

SCEP

Value setting
The box is unchecked by
default

Description

Check the Enable box to activate SCEP function.

Automatically
re-enroll aging

The box is unchecked by
default

When SCEP is activated, check the Enable box to activate this function.
It will be automatically check which certificate is aging. If certificate is aging, it

certificates will activate SCEP function to re-enroll automatically.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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3.5.2 My Certificate

My Certificate includes a Local Certificate List. Local Certificate List shows all generated certificates by the root
CA for the gateway. And it also stores the generated Certificate Signing Requests (CSR) which will be signed by
other external CAs. The signed certificates can be imported as the local ones of the gateway.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

ACS

) =
| l “@- Server
= ! = @
Application ke ‘ Database \
Server = [T server —

Creat
%C o atg Loca (VPN Tunnel (IPSec IKE+X.509) 0 Root CA
1
@ Import SranthCRTZ ® Create IPSec (IKE + X.500) CRT
— : VPN Tunnel )
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself or import any local certificates that are signed by other
external CAs. Also import the trusted certificates for other CAs and Clients. In addition, since it has the
root CA, it also can sign Certificate Signing Requests (CSR) to form corresponding certificates for others.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also import the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer
to following two sub-sections)

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.
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Parameter Setup Example

For Network-A at HQ

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Root CA Certificate Configuration]

Name

HQRootCA

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQRootCA E-mail: hgrootca@amit.com.tw

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

HQCRT Self-signed: m

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(0): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQCRT E-mail: hgcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name 52s-101
Interface WAN 1

Tunnel Scenario

Site to Site

Operation Mode

Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Remote Gateway

Local Subnet 10.0.76.0
Local Netmask 255.255,255.0
Full Tunnel Disable
Remote Subnet 10.0.75.0
Remote Netmask 255.255.255.0
118.18.81.33
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Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: HQCRT Remote Certificate: BranchCRT

Local ID

User Name Network-A

Remote ID

User Name Network-B

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

BranchCRT Self-signed: 0

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITBranch Organization Unit(OU): BranchRD
Common Name(CN): BranchCRT E-mail: branchcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name 52s-102
Interface WAN 1

Tunnel Scenario

Site to Site

Operation Mode

Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Remote Gateway

Local Subnet 10.0.75.0
Local Netmask 255.255,255.0
Full Tunnel Disable
Remote Subnet 10.0.76.0
Remote Netmask 255.255.255.0
203.95.80.22
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Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: BranchCRT Remote Certificate: HQCRT

Local ID

User Name Network-B

Remote ID

User Name Network-A

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

Scenario Operation Procedure

In above diagram, "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet is
10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client
Certificate List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate (BranchCRT)
(Please generate one not self-signed certificate in the Gateway 2, and click on the "View" button for
that CSR. Just downloads it). Take the CSR to be signed by the root CA of Gateway 1 and obtain the
BranchCRT certificate (you need rename it). Import the certificate into the "Trusted Client Certificate
List" of the Gateway 1 and the "Local Certificate List" of Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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My Certificate Setting

Go to Object Definition > Certificate > My Certificate tab.

The My Certificate setting allows user to create local certificates. In "My Certificate" page, there are two
configuration windows for the "My Certificate" function. The "Local Certificate List" window shows the stored
certificates or CSRs for representing the gateway. The "Local Certificate Configuration" window can let you fill
required information necessary for corresponding certificate to be generated by itself, or corresponding CSR
to be signed by other CAs.

Create Local Certificate

- Add | Import | Delete

ID | Name Subject Issuer Vaild To Actions

When Add button is applied, Local Certificate Configuration screen will appear. The required information to be
filled for the certificate or CSR includes the name, key and subject name. It is a certificate if the "Self-signed"
box is checked; otherwise, it is a CSR.

Item Setting

» Name | Self-signed - [7

b Key Key Type - I RSA ,l Key Length : I 1024-hits ,l Digest Algorithm : ISHA'I ,l
Country(C) : I State(ST) : I Location(L) : I

» Subject Name Organization(O) - | Organization Unit(OU) -

Common Name(CN) : | E-mail - |

Challenge Password: | Unstructured Name:
» Extra Attributes I

Enable: [  SCEP Server. |--- Option — j Add Object |

» SCEP Enrollment CA Certificate: I amit-IDG761AM-IH.crt j CA Encryption Certificate:
| Option — | (Optional) CA Identifier: | (Optional)
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Name

Key

Subject Name

Extra Attributes

SCEP Enrollment

Save
Back

1. String format can be any
text

2. A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

N/A
N/A

Enter a certificate name. It will be a certificate file name

If Self-signed is checked, it will be signed by root CA. If Self-signed is not
checked, it will generate a certificate signing request (CSR).

This field is to specify the key attributes of certificate.

Key Type to set public-key cryptosystems. Currently, only RSA is supported.

Key Length to set the length in bits of the key used in a cryptographic algorithm.
It can be 512/768/1024/1536/2048.

Digest Algorithm to set identifier in the signature algorithm identifier of
certificates. It can be MD5/SHA-1.

This field is to specify the information of certificate.

Country(C) is the two-letter I1SO code for the country where your organization is
located.

State(ST) is the state where your organization is located.

Location(L) is the location where your organization is located.

Organization(O) is the name of your organization.

Organization Unit(OU) is the name of your organization unit.

Common Name(CN) is the name of your organization.

Email is the email of your organization. It has to be email address setting only.
This field is to specify the extra information for generating a certificate.
Challenge Password for the password you can use to request certificate
revocation in the future.

Unstructured Name for additional information.

This field is to specify the information of SCEP.

If user wants to generate a certificate signing request (CSR) and then signed by
SCEP server online, user can check the Enable box.

Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition >
External Server > External Server. You may click Add Object button to
generate, and the settings are the same as those defined in Section 3.4 External
Server.

Select a CA Certificate to identify which certificate could be accepted by SCEP
server for authentication. It could be generated in Trusted Certificates.

Select an optional CA Encryption Certificate, if it is required, to identify which
certificate could be accepted by SCEP server for encryption data information. It
could be generated in Trusted Certificates.

Fill in optional CA Identifier to identify which CA could be used for signing
certificates.

Click the Save button to save the configuration.
When the Back button is clicked, the screen will return to previous page.
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When Import button is applied, an Import screen will appear. You can import a certificate from an existed
certificate file, or directly paste a PEM encoded string as the certificate.

Apply | Cancel

BiEE. | smimis

Value setting Description
Import A Must filled setting Select a certificate file from user’s computer, and click the Apply button to
import the specified certificate file to the gateway.
PEM Encoded 1. String format can be any  This is an alternative approach to import a certificate.
text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and
2. A Must filled setting click the Apply button to import the specified certificate to the gateway.
Apply N/A Click the Apply button to import the certificate.
Cancel N/A Click the Cancel button to discard the import operation and the screen will
return to the My Certificates page.
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3.5.3 Trusted Certificate

Trusted Certificate includes Trusted CA Certificate List, Trusted Client Certificate List, and Trusted Client Key
List. The Trusted CA Certificate List places the certificates of external trusted CAs. The Trusted Client
Certificate List places the others' certificates what you trust. And the Trusted Client Key List places the others’
keys what you trusted.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

-

I S ACS

: = *7'-‘.“_&"-'" Server

I

Application s Database \ %
Server ;'D Server

(D) Create HQ Root (4
@ Create Localt

VPN Tunnel (IPSec IKE+X.509]O RootCA

@ Import Brapgh 2 | ® CreateIPSec (IKE + X.500) CRT
' w— g VPN Tunnel .
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP:10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to
"My Certificate" and "Issue Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
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For Network-A at HQ

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issue Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File BranchCRT.crt

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issued Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted CA Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted CA Certificate Import from a File]
File HQRootCA.crt

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File HQCRT.crt

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its
Intranet is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-
1 interface. They both serve as the NAT security gateways.

In Gateway 2 import the certificates of the root CA and HQCRT that were generated and signed by
Gateway 1 into the "Trusted CA Certificate List" and "Trusted Client Certificate List" of Gateway 2.
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Import the obtained BranchCRT certificate (the derived BranchCSR certificate after Gateway 1’s root
CA signature) into the "Trusted Client Certificate List" of the Gateway 1 and the "Local Certificate List"
of the Gateway 2. For more details, refer to the Network-B operation procedure in "My Certificate"
section of this manual.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Trusted Certificate Setting

Go to Object Definition > Certificate > Trusted Certificate tab.

The Trusted Certificate setting allows user to import trusted certificates and keys.

Import Trusted CA Certificate

= Trusted CA Certificate List |1 [i¢/1¢

Vaild To

When Import button is applied, a Trusted CA import screen will appear. You can import a Trusted CA
certificate from an existed certificate file, or directly paste a PEM encoded string as the certificate.

= Trusted CA Certificate Import from a File | :1eJoi\0 | L@
B | FIRIEIEE ¢

* Trusted CA Certificate Import from a PEM | i0ioll 0 | 1050 (e

Trusted CA Certificate List

Item Value setting Description

Import from a A Must filled setting Select a CA certificate file from user’s computer, and click the Apply button to

File import the specified CA certificate file to the gateway.

Import from a 1. String format can be any This is an alternative approach to import a CA certificate.

PEM text You can directly fill in (Copy and Paste) the PEM encoded CA certificate string,
2. A Must filled setting and click the Apply button to import the specified CA certificate to the gateway.

Apply N/A Click the Apply button to import the certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will

return to the Trusted Certificates page.
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Instead of importing a Trusted CA certificate with mentioned approaches, you can also get the CA certificate
from the SECP server.

If SCEP is enabled (Refer to Object Definition > Certificate > Configuration), you can click Get CA button, a Get
CA Configuration screen will appear.

= Get CA Configuration

Item Setting
» SCEP Server | — Option — ¥ | | Add Object |
b CA Identifier li | (Optional)

Get CA Configuration

Item Value setting Description

SCEP Server A Must filled setting Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition >
External Server > External Server. You may click Add Object button to

generate.
CA Identifier 1. String format can be any  Fill in optional CA Identifier to identify which CA could be used for signing
text certificates.
Save N/A Click Save to save the settings.
Close N/A Click the Close button to return to the Trusted Certificates page.

Import Trusted Client Certificate

# Trusted Client Certificate List

Subject Issuer Vaild To Actions

When Import button is applied, a Trusted Client Certificate Import screen will appear. You can import a
Trusted Client Certificate from an existed certificate file, or directly paste a PEM encoded string as the
certificate.
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EEE. | ESEE

# Trusted Client Certificate Import from a PEM | :7o)el\ | L0

Trusted Client Certificate List

Item Value setting Description

Import from a A Must filled setting Select a certificate file from user’s computer, and click the Apply button to import the

File specified certificate file to the gateway.

Import from a 1. String format can be any  This is an alternative approach to import a certificate.

PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and click the
2. A Must filled setting Apply button to import the specified certificate to the gateway.

Apply N/A Click the Apply button to import certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the

Trusted Certificates page.

Import Trusted Client Key

%) Trusted Client Key List (L ] o b = (2]

1D Name Actions

When Import button is applied, a Trusted Client Key Import screen will appear. You can import a Trusted
Client Key from an existed file, or directly paste a PEM encoded string as the key.
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= Trusted Client Key Import from a File | [2Vgjsly2| | L8]]

Bl | iz

* Trusted Client Key Import from a PEM | :1i]o 2 [L0=][eE]

Trusted Client Key List

\ Item Value setting
Import from a A Must filled setting
File

Description
Select a certificate key file from user’s computer, and click the Apply button to import
the specified key file to the gateway.

Import from a 1. String format can be any  This is an alternative approach to import a certificate key.

PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate key string, and click
2. A Must filled setting the Apply button to import the specified certificate key to the gateway.

Apply N/A Click the Apply button to import the certificate key.

Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the

Trusted Certificates page.
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3.5.4 Issue Certificate

When you have a Certificate Signing Request (CSR) that needs to be certificated by the root CA of the device,
you can issue the request here and let Root CA sign it. There are two approaches to issue a certificate. One is
from a CSR file importing from the managing PC and another is copy-paste the CSR codes in gateway’s web-

based utility, and then click on the "Sign" button.

If the gateway signs a CSR successfully, the "Signed Certificate View" window will show the resulted certificate
contents. In addition, a "Download" button is available for you to download the certificate to a file in the

managing PC.

Self-signed Certificate Usage Scenario

@Creatf:
@Creatg
@ Impornt

Network-A @ HQ Data Center

| ACs
' Server

Application
Server

HQ Root 4
Loca

Security Gateway 1
with Root CA and Trusted
Client Certificates

Database
Server

Internet
\_ s

(VPN Tunnel (IPSec IKE+X.509) 0

Global IP: 203.95.80.22
Local IP: 10.0.76.2

® Create IPSec (IKE + X.509)
VPN Tunnel

Network-B @ Branch Office

Security Gateway 2
with Trusted CA &
Client Certificates

Global IP: 118.18.81.33
Local IP: 10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients.
These certificates can be used for two remote peers to make sure their identity during establishing a

VPN tun

nel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Also imports a trusted

RootCA
CRT

certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer
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to "My Certificate" and "Trusted Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
For Network-A at HQ

Following tables list the parameter configuration as an example for the "Issue Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Trusted Certificate"
sections to complete the setup for whole user scenario.

Configuration Path [Issue Certificate]-[Certificate Signing Request Import from a File]

Browse

C:/BranchCSR

Command Button

Sign

Configuration Path

[Issue Certificate]-[Signed Certificate View]

Command Button

Download (default name is "issued.crt")

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its
Intranet is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-
1 interface. They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client
Certificate List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate BranchCRT to be
signed by root CA (Please generate one not self-signed certificate in the Gateway 2, and click on the
"View" button for that CSR. Just downloads it). Take the CSR to be signed by the root CA of the
Gateway 1 and obtain the BranchCRT certificate (you need rename it). Import the certificate into the
"Trusted Client Certificate List" of the Gateway 1 and the "Local Certificate List" of the Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Issue Certificate Setting

Go to Object Definition > Certificate > Issue Certificate tab.

The Issue Certificate setting allows user to import Certificate Signing Request (CSR) to be signed by root CA.

Import and Issue Certificate

'Y\ Certificate Signing Request (CSR) import from a File

| Choose File |No file chosen

# Certificate Signing Request (CSR) Import from a PEM [B=1le4]

Value setting Description

Certificate Signing Select a certificate signing request file you’re your

Request (CSR) Import A Must filled setting . .

from a File computer for importing to the gateway.

Certificate Signing . - -

Request (CSR) Import 1. String format can be any text Enter (copy-paste) the certificate signing request PEM
from a PEM 2. A Must filled setting encoded certificate to the gateway.

When root CA is exist, click the Sign button sign and

Sign N/A
g / issue the imported certificate by root CA.
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Chapter 4 Field Communication

4.1 Bus & Protocol

The gateway may equip a serial port for various serial communication use through connecting the RS-232 or
RS-485 serial device to an IP-based Ethernet LAN. These communication protocols make user access serial
devices anywhere over a local LAN or the Internet easily.

4.1.1 Port Configuration

Before using the supported field communication function, like Virtual COM, you need to configure the physical
communication port first.

The port configuration screen allows user to configure the operation mode and physical layer settings for each
serial interface, and also can quick switch from one communication protocol to another for the serial port. The
number of ports and type of the supported protocols could be different for the purchased gateway model.

Port Configuration Setting

Go to Field Communication > Bus & Protocol > Port Configuration tab.

In "Port Configuration" page, there is only one configuration window for the serial port settings. The
"Configuration" window can let you specify serial port parameters including the operation mode being
"Virtual COM" or disabled, the interface, the baud rate, the data bit length, the stop bit length, the flow
control being "RTS/CTS", "DTS/DSR" or "None", and the parity.

Serial Port Operation Mode Interface Baud Rate Data Bits Stop Bits | Flow Control Parity Action
SPort-0 Disable  v| [RS232+| [9600 g v 1w None v None v | Edit [\
Serial Port N/A It displays the serial port ID of the serial port.
The number of serial ports varies from the purchased model.
Operation Mode Disable is set by default It displays the current selected operation mode for the serial interface.
Interface RS-232 is set by default Select the physical interface type for connecting to the access device(s) with the

same interface specification.
Depending on the purchase model, the supported interface type could be RS-
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232 or RS-485.
Baud Rate 19200 is set by default Select the appropriate baud rate for serial device communication.
RS-232: 1200 / 2400 / 4800 / 9600 / 19200 / 38400/ 57600 / 115200
RS-485 can use higher baud rate for 230400 and 460800. It depends on the
cable length and the installed environment. The longer cable, the lower baud

rate for it.
Data Bits 8 is set by default Select 8 or 7 for data bits.
Stop Bits 1 is set by default Select 1 or 2 for stop bits.
Flow Control None is set by default Select None / RTS, CTS / DTS, DSR for Flow Control in RS-232 mode.
The supporting of Flow Control depends on the purchased model.
Parity None is set by default Select None / Even / Odd for Parity bit.
Action Click Edit button to change the operation mode, or modify the parameters
N/A mentioned above for the serial interface communication.
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.
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4.1.2 Virtual COM

Create a virtual COM port on user’s PC/Host to provide access to serial device connected to the serial port on
gateway. Therefore, users can access, control, and manage the connected serial device through Internet (fixed
line, or cellular network) anywhere. This application is also known as Ethernet pass-through communication.

Serial = Operation | Listen | Trust Max Connection Connection Idle Alive Check
Enable | Action
Port Mode Port Type | Connection Control Timeout Timeout
SPort-0 Disable N/A MNIA N/A N/A IN/A N/A Edit

Virtual COM setting screen enables user to connect a Virtual COM port based device to the Internet. It allows
user to access serial data remotely. There are Disable, TCP Client, TCP Server, UDP, and RFC2217 modes for
remote accessing the connected serial device. These operation modes are illustrated as below.

TCP Client Mode

Intranet & Internet

AMIT Product

M2M-loT (
Gateway \'] )

Operation Mode
:TCP Client

nternet ,

IP-based Ethernet

_——— e ——— -

Remote Host\ communication
Device \ ————— / N\ JUP™ _________
€=—== @_ 74800 Serial Device
! : : OConnection Control:
i JTo Remote Host: L e on-demand
" P:140.116.82.98 ; UConnection Idle Timeout:
" Port: 4001 . 5 min

) Gateway get Data received from Serial Device.
@) Establish a TCP Connection and Transmit Data to Remote Host.

€ Terminate this TCP Connection once Idle Timeout reached 5 mins.

When the administrator expects the gateway to
actively establish a TCP connection to a pre-defined
host computer when serial data arrives, the
operation mode for the "Virtual COM" function is
required to be "TCP Client" and when the connection
control of virtual COM is "On-demand", once the
gateway receives data from the connected serial
device, it will establish a TCP connection to transfer
the received serial data to the remote host. Besides,
after the data has been transferred, the gateway
automatically disconnects the established TCP
session from the host computer by using the TCP
alive check timeout or idle timeout settings.
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TCP Server Mode

AMIT Product Operation Mode
:TCP Server
MZM-!OT(( )) pr—————————y
4 Gateway
i y

i

N

. U Trust Type :

\
1
1
1
1
1
1
1
'

O HostIP: i GatewayIP: * Specific IPs:

! %140.116.82.98 140.113.71.125 140.116.82.98

Gl ] Listen Port 1 4001 U Connection Idle Timeout:
) "5 min

) Gateway remain Listening and Host will Establish a TCP Connection withiit.
) Host Send Data then Gateway Transmit it to the Serial Device.

€) Terminate this TCP Connection once Idle Timeout reached 5 mins.

UDP Mode

Intranet & Internet

AMIT Product Operation Mode
:UDP

M2M-loT((@)) P ———
| Gateway

A

. Serial Device

________ -

IP-based Ethernet
Remote Host», Communication

Data is Transferred between Remote Host and Serial Device Directly

Gateway IP:
{ 140.113.71.125
i QListen Port : 4001

U Remote Host:
{ "1P:140.116.82.98
i =Port: 4001

When the administrator expects the gateway to wait
passively for the serial data requests from the Host
Device (usually we use a computer to play as a Host),
and the Host will establish a TCP connection to get
data from the serial device, the operation mode for
the "Virtual COM" function is required to be "TCP
Server". In this mode, the gateway provides a unique
"IP: Port" address on a TCP/IP network. It supports up
to 4 simultaneous connections, so that multiple hosts
can collect data from the same serial device at the
same time. After the data has been transferred, the
TCP connection will be automatically disconnected
from the host computer by using the TCP alive check
timeout or idle timeout settings.

If both the Remote Host Computer and the serial
device are expected to initiate a data transfer when it
requires doing that, the operation mode for the
"Virtual COM" function in the gateway is required to
be "UDP". In this mode, the UDP data can be
transferred between the gateway and multiple host
computers from either peer, making this mode ideal
for message display applications.

The remote host computer can directly send UDP
data to the serial device via the gateway, and also
receive UDP data from the serial device via the
gateway at the same time. The gateway supports up

to 4 legal hosts to connect simultaneously to the serial device via the gateway.
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RFC-2217 Mode

Intranet & Internet

AMIT Product

IP-based Ethernet
Communication

Host

‘T’

with RFC-2217

Virtual COM e T

driver installed

Operation Mode
:RFC-2217

DHosﬂp .............. Y s 5; { Orust Type

2140.116.82. 98 : 140.113.71.125 ii =SpecificIPs: 140.116.82.98 |

O EI Listen Port : 4001 | : OConnectionldle Timeout: :
a5 min

€ Send data to each other directly viaa transparent connection established

) Terminate this Connection once ldle Timeout reached 5 mins.

port on the host computer.

RFC-2217 defines general COM port control
options based on telnet protocol. A host
computer with RFC-2217 driver installed can
monitor and manage the remote serial device
attached to the gateway’s serial port, as though
they were connected to the local serial
port. When a virtual serial port on the local
serial device is being created, it is required to
specify the IP-address of the host computers to
establish connection with.

Any 3rd party driver supporting RFC2217 can be
used to install in the host computer, the driver
establishes a transparent connection between
host and serial device by mapping the IP:Port of
the gateway’s serial port to a virtual local COM

The host computer can directly send data to the serial device via the gateway, and also receive data from the
serial device via the gateway at the same time. The gateway supports up to 4 Internet host computers.
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Virtual COM Setting

Virtual COM setting screen enables user to connect a Virtual COM port based device to the Internet. It allows
user to access serial data remotely. There are Disable, TCP Client, TCP Server, UDP, and RFC2217 modes for
remote accessing the connected serial device. By default, it is configured in Disable mode.

To use the Virtual COM function, you have to specify the operation mode for the multi-function serial port first.
Go to Field Communication > Bus & Protocol > Port Configuration tab, select the Virtual COM as expected
operation mode, and finish the related port configuration as well.

After that, go to Field Communication > Bus & Protocol > Virtual COM tab for detailed configuration of Virtual
COM setting.

Enable TCP Client Mode

Configure the gateway as the TCP (Transmission Control Protocol) Client. In TCP Client mode, device initiates a
TCP connection with a TCP server when there is data to transmit. Device disconnects from the server when the
connection is Idle for a specified period. You may also enable full time connection with the TCP server.

Serial Max Connection Connection Idle | Alive Check
Operation Mode Listen Port Trust Type Enable | Action
Port Connection Control Timeout Timeout
SPort.0 | [TCP Client v Ll AlowAl v || [ Alwayson v 0 _j@ 0 _J@ Edit
(1~65535) 3600secs) 3600secs)
Operation Mode A Must filled setting Select TCP Client.
Connection Control Always on is set by Choose Always on for a TCP full time connection. Otherwise, choose On-
default Demand to initiate TCP connection only when required to transmit and
disconnect at idle timeout.
Connection Idle 1. 0 is set by default Enter the idle timeout in minutes.
Timeout 2. Range 0 to 3600 sec. The idle timeout is used to disconnect the TCP connection when idle time
elapsed .
Idle timeout is only available when On-Demand is selected in the Connection
Control field.
Value Range: 0 ~ 3600 seconds.
Alive Check Timeout 1.0 is set by default Enter the time period of alive check timeout. The TCP connection will be
2. Range 0 to 3600 sec. terminated if it doesn’t receive response of alive-check longer than this
timeout setting
Alive check timeout is only available when On-Demand is selected in the
Connection Control field.
Value Range: 0 ~ 3600 seconds.
Enable The box is unchecked by  Check the Enable box to activate the corresponding serial port in specified
default. operation mode.
Save N/A Click the Save button to save the configuration
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Specify Data Packing Parameters

% Data Packing (for TCP Client, TCP Server and UDP operation mode) . ®

Serial Port Data Buffer Length Delimiter Character 1 Delimiter Character 2 Data Timeout Transmit
CENN -
SPort-0 (0~1024) o« (0~1000ms)
o] — - o]

Data Packing Configuration

Item

Value setting

Description

Character 1

Data Buffer 1.An optional filled setting  Enter the data buffer length for the serieal port.
Length 2.Default value is 0 Value Range: 0 ~ 1024.
Delimiter 1.An optional filled setting  Check the Enable box to activate the Delimiter character 1, and enter the Hex

2.Default value is 0

code for it.
Value Range: 0x00 ~ OxFF.

Delimiter
Character 2

1.An optional filled setting
2.Default value is 0

Check the Enable box to activate the Delimiter character 2, and enter the Hex
code for it.
Value Range: 0x00 ~ OxFF.

Data Timeout

1.An optional filled setting

Enter the data timeout interval for transmitting serial data through the port.

Transmit 2.Default value is 0 By default, itis set to 0 and the timeout function is disabled.
Value Range: 0 ~ 1000ms.
Save N/A Click the Save button to save the configuration

Specify Remote TCP Server

#) Legal Host IP/ FQDN Definition (for TCP Client operation mode) .
ID To Remote Host Remote Port Serial Port Definition Enable | Action
1 4001 SPort-0
2 4001 SPort-0
3 4001 SPort-0
4 4001 SPort-0

Specify TCP Server Window

\ Item
To Remote Host

Value setting
A Must filled setting

Description
Press Edit button to enter IP address or FQDN of the remote TCP server to
transmit serial data.

Remote Port

1.A Must filled setting
2.Default value is 4001

Enter the TCP port number. This is the listen port of the remote TCP server.
Value Range: 1 ~ 65535.

Serial Port SPort-0 is set by default Apply the TCP server connection for a selected serial port. Up to 4 TCP servers
can be configured at the same time for each serial port.

Definition The box is unchecked by Check the Enable box to enable the TCP server configuration.

Enable default

Save N/A Click the Save button to save the configuration
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Enable TCP Server Mode

Configure the gateway as the TCP (Transmission Control Protocol) Server. The TCP Server waits for connections
to be initiated by a remote TCP client device to receive serial data. The setting allows user to specify specific
TCP clients or allow any to send serial data for serial data transmission bandwidth control and access control.

The TCP Server supports up to 128 simultaneous connections to receive serial data from multiple TCP clients.

Serial
Operation Mode

Port
SPort-0 | | TCP Server v

Operation Mode
Listen Port

Trust Type

Max Connection

Connection Idle
Timeout

Alive Check Timeout

Enable

Save

Max Connection Connection Idle | Alive Check
Listen Port Trust Type Enable | Action
Connection Control Timeout Timeout
4001 AlowAl  v| | [1 Always on v 0@ o _Jo Edit
(1~65535) 2600secs) 3600secs)

A Must filled setting
4001 is set by default

Allow All is set by
default

1. Max. 128 connections
2.1 is set by default

1. 0 is set by default
2. Range 0 to 3600 sec.

1. 0 is set by default
2. Range 0 to 3600 sec.

The box is unchecked by
default.
N/A

Select TCP Server mode.

Indicate the listening port of TCP connection.

Value Range: 1 ~ 65535.

Choose Allow All to allow any TCP clients to connect. Otherwise choose
Specific IP to limit certain TCP clients.

Set the maximum number of concurrent TCP connections. Up to 128
simultaneous TCP connections can be established.

Value Range: 1 ~ 128.

Enter the idle timeout in minutes.

The idle timeout is used to disconnect the TCP connection when idle time
elapsed .

Idle timeout is only available when On-Demand is selected in the Connection
Control field.

Value Range: 0 ~ 3600 seconds.

Enter the time period of alive check timeout. The TCP connection will be
terminated if it doesn’t receive response of alive-check longer than this
timeout setting

Alive check timeout is only available when On-Demand is selected in the
Connection Control field.

Value Range: 0 ~ 3600 seconds.

Check the Enable box to activate the corresponding serial port in specified
operation mode.

Click Save button to save the settings.
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Specify TCP Clients for TCP Server Access

If you selected Specific IPs as the trust Type, the Trusted IP Definition window appears. The settings are valid
for both TCP Server and RFC-2217 modes.

% Trusted IP Definition (for TCP Server & RFC-2217 operation mode) -

ID Host Serial Port Definition Enable Action

1 O Edit

2 Edit

Edit

Edit

Edit

Edit

Edit

Ojgojojo|o|d

Edit

Specify TCP Clients Window

Item Value setting Description

Host A Must filled setting Enter the IP address range of allowed TCP clients.

Serial Port The box is unchecked by Check the box to specify the rule for selected Serial Port.
default

Definition The box is unchecked by Check the Enable box to enable the rule.

Enable default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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Enable UDP Mode

UDP (User Datagram Protocol) enables applications using UDP socket programs to communicate with the serial
ports on the serial server. The UDP mode provides connectionless communications, which enable you to multicast
data from the serial device to multiple host computers, and vice versa, making this mode ideal for message display
applications.

= Operation Mode Definition for each Serial Port

Serial Max Connection Connection Idle | Alive Check
Operation Mode Listen Port Trust Type Enable | Action
Port Connection Control Timeout Timeout
SPort.0 | [UDP v 400 AowAl +]| [ | [Awason v]| @ 1@ | P_Je Edit
(1~65535) 3600secs) 3600secs)

\ Enable UDP Mode Window

Item Value setting Description
Operation Mode A Must filled setting Select UDP mode.
Listen Port 4001 is set by default Indicate the listening port of UDP connection.
Value Range: 1 ~ 65535
Enable The box is unchecked by  Check the Enable box to activate the corresponding serial port in specified
default. operation mode.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Specify Remote UDP

# Legal Host IP Definition (for UDP operation mode)

ID Remote Host Remote Port Serial Port Definition Enable | Action
1 4001 SPort0
2 4001 SPort-0 Edit
3 4001 SPort.0
4 4001 SPort-0 Edit

\ Specify Remote UDP hosts Window

Item Value setting Description

Host A Must filled setting Press Edit button to enter IP address range of remote UDP hosts.

Remote Port 4001 is set by default Indicate the UDP port of peer UDP hosts.
Value Range: 1 ~ 65535

Serial Port SPort-0 is set by default Apply the UDP hosts for a selected serial port. Up to 4 UDP servers can be
configured at the same time for each serial port.

Definition The box is unchecked by Check the Enable box to enable the rule.

Enable default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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Enable RFC-2217 Mode

RFC-2217 defines general COM port control options based on telnet protocol. With the RFC-2217 mode,
remote host can monitor and manage remote serially attached devices, as though they were connected to the
local serial port. When a virtual serial port on the local serial device is being created, it is required to specify
the IP-address of the remote hosts to establish connection with.

Serial
Operation Mode

Port
SPort-0 | |RFC-2217 ~

Operation Mode
Listen Port

Trust Type

Connection Idle
Timeout

Alive Check Timeout

Enable

Save
Undo

Max Connection Connection Idle | Alive Check
Listen Port Trust Type Enable | Action
Connection Control Timeout Timeout
4001 Allow Al v 1 Alwayson v 0 JjO | o J@ Edit
(1~65535) 3600secs) 3600secs)

A Must filled setting
4001 is set by default

Allow All is set by
default

1. 0 is set by default

2. Range 0 to 3600 sec.

1. 0 is set by default
2. Range 0 to 3600 sec.

The box is unchecked by
default.

N/A
N/A

Select RFC-2217 mode.

Indicate the listening port of RFC-2217 connection.

Value Range: 1 ~ 65535

Choose Allow All to allow any clients to connect. Otherwise choose Specific IP
to limit certain clients.

Enter the idle timeout in minutes.

The idle timeout is used to disconnect the TCP connection when idle time
elapsed .

Idle timeout is only available when On-Demand is selected in the Connection
Control field.

Value Range: 0 ~ 3600 seconds.

Enter the time period of alive check timeout. The TCP connection will be
terminated if it doesn’t receive response of alive-check longer than this
timeout setting

Alive check timeout is only available when On-Demand is selected in the
Connection Control field.

Value Range: 0 ~ 3600 seconds.

Check the Enable box to activate the corresponding serial port in specified
operation mode.

Click Save to save the settings
Click Undo to cancel the settings
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Specify Remote Host for Access

If you selected Specific IPs as the trust Type, the Trusted IP Definition window appears. The settings are valid
for both TCP Server and RFC-2217 modes.

% Trusted IP Definition (for TCP Server & RFC-2217 operation mode) -

ID Host Serial Port Definition Enable Action

1 O Edit

2 Edit

Edit

Edit

Edit

Edit

Edit

Edit

Ojgojojo|o|d

Specify RFC-2217 Clients for Access Window

Item Value setting Description

Host A Must filled setting Enter the IP address range of allowed clients.

Serial Port The box is unchecked by Check the box to specify the rule for selected Serial Port.
default

Definition The box is unchecked by Check the Enable box to enable the rule.

Enable default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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Chapter 5 Security

5.1 VPN

A virtual private network (VPN) extends a private network across a public network, such as the Internet. It
enables a computer to send and receive data across shared or public networks as if it were directly connected
to the private network, while benefitting from the functionality, security and management policies of the
private network. This is done by establishing a virtual point-to-point connection through the use of dedicated
connections, encryption, or a combination of the two. The tunnel technology supports data confidentiality,
data origin authentication and data integrity of network information by utilizing encapsulation protocols,
encryption algorithms, and hashing algorithms.

sy - - T T T—T—T—~—~% by

VPN Concentrator M2M-loT [ Multio Meter  prc )

Gateway I '

VPN Servic _ ' BT

IPSec Serial Cable : ©vo0e | — [
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= ! FTU !

VPN Servic ﬁp' ": FRTU/IED . T :
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el ]

e ———— | - ———— <

i'_ 4 ﬁ Data over IP Packet I Serial-based devices
Control Room via VPN Tunnel I

/“ATM  POS  Host N
1

| ) 1

¥ EIRaR

1 1

| !

| - 1

VPN Servic | g:g::'ge I

% PPTP | 1P CAM :

o | 1

Application RI-45 i

| 1

“. . - 4 ¥

Access & Control Ethernet-based devices

The product series supports different tunneling technologies to establish secure tunnels between multiple
sites for data transferring, such as IPSec, OpenVPN, L2TP (over IPSec), PPTP and GRE. Besides, some advanced
functions, like Full Tunnel, Tunnel Failover, Tunnel Load Balance, NetBIOS over IPSec, NAT Traversal and
Dynamic VPN, are also supported.
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5.1.1 IPSec

Internet Protocol Security (IPSec) is a protocol suite for securing Internet Protocol (IP) communications by
authenticating and encrypting each IP packet of a communication session. IPSec includes protocols for
establishing mutual authentication between agents at the beginning of the session and negotiation of
cryptographic keys to be used during the session.

An IPSec VPN tunnel is established between IPSec client and server. Sometimes, we call the IPSec VPN client as
the initiator and the IPSec VPN server as the responder. This gateway can be configured as different roles and
establish number of tunnels with various remote devices. Before going to setup the VPN connections, you may
need to decide the scenario type for the tunneling.

IPSec Tunnel Scenarios
To build IPSec tunnel, you need to fill in

Network-A @ .
Control Center Network 8 @ remote gateway global IP, and optional
: Remote Site . .
- IPSec VPN Tunnel Scenario subnet if the hosts behind IPSec peer
e 1007 < M2M Sd:ne:1921651x can access to remote site or hosts.
e \ Securit Gat : T H
%ﬂ i \ Gateway 1-Site t atewsy, Under such configuration, there are
<. - T _%3_,405_@02_',}2"1“"1‘){;}__ four scenarios
B g 4. Host to Host T . .
Globalip:203.95 5052 ;e;;d; - —":mm:- — aebaeaississ "ot ®e|  Site to Site: You need to setup remote
Local IP:10.0.76.253 Local IP:192.168.1.253
(server) (Client) gateway IP and subnet of both
gateways. After the IPSec tunnel
€ > Siteto Site: Tunnel between M2M gateway /w 192.168.1.x subnetand UTM /w 10.0.76.x subnet . .
) established, hosts behind both
R > Siteto Host: Tunnel between M2M gateway /w 192.168.1.x subnet and Host-DC under UTM i i
€~ + —> Host to Site: Tunnel between Host-Re under M2M Gateway and UTM /w 10.0.76.x subnet gateways can communication eaCh
<€— — ?» HosttoHost: Tunnel between Host-Re under M2M Gateway and Host-DC under UTM Other through the tunne"

Site to Host: Site to Host is suitable for tunneling between clients in a subnet and an application server (host).
As in the diagram, the clients behind the M2M gateway can access to the host "Host-DC" located in the
control center through Site to Host VPN tunnel.

Host to Site: On the contrast, for a single host (or mobile user to) to access the resources located in an
intranet, the Host to Site scenario can be applied.

Host to Host: Host to Host is a special configuration for building a VPN tunnel between two single hosts.
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IPSec Setting

Go to Security > VPN > IPSec tab.

The IPSec Setting allows user to create and configure IPSec tunnels.

Enable IPSec

= Configuration . =
Item Setting

» IPSec () Enable

» Max. Concurrent IPSec Tunnels 18

Configuration Window

Item Value setting Description

IPsec Unchecked by default  Click the Enable box to enable IPSec function.

Max. Concurrent Depends on Product The specified value will limit the maximum number of simultaneous IPSec
IPSec Tunnels specification. tunnel connection. The default value can be different for the purchased model.
Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Create/Edit IPSec tunnel

Ensure that the IPSec enable box is checked to enable before further configuring the IPSec tunnel settings.

= IPSec Tunnel List

Tunnel Name Remote Gateway

Interface Remote Subnet Enable Actions

When Add/Edit button is applied, a series of configuration screens will appear. They are Tunnel Configuration,
Local & Remote Configuration, Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec
Proposal Definition. You have to configure the tunnel details for both local and remote VPN devices.
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= Tunnel Configuration

ltem Setting
» Tunnel [ Enable
» Tunnel Name [IPSec#1 |
v Interface WAN1 ¥
+ Tunnel Scenario | Site-to-Site(Tunnel mode) v
» Tunnel TCP MSS Auto v| [0 | (B4~1500 Bytes)
+ Encapsulation Protocol ESP v
v |KE Version @

Tunnel Configuration Window

Item
Tunnel

Value setting
Unchecked by default

Description
Check the Enable box to activate the IPSec tunnel

Tunnel Name

1. A Must fill setting
2. String format can be
any text

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 19 characters.

Interface

1. A Must fill setting
2. WAN 1 is selected
by default

Select the interface on which IPSec tunnel is to be established. It can be the
available WAN and LAN interfaces.

Tunnel Scenario

1. A Must fill setting
2. Site to site is
selected by default

Select an IPSec tunneling scenario from the dropdown box for your application.
Select Site-to-Site, Site-to-Host, Host-to-Site, or Host-to-Host. If LAN interface
is selected, only Host-to-Host scenario is available.

With Site-to-Site or Site-to-Host or Host-to-Site, IPSec operates in tunnel mode.
The difference among them is the number of subnets. With Host-to-Host, IPSec
operates in transport mode.

Tunel TCP MSS

1. An optional setting
2. Auto is set by
default

Select from the dropdown box to define the size of Tunel TCP MSS.
Select Auto, and all devices will adjust this parameter automatically.
Select Manual, and specify an expected vaule for Tunel TCP MSS.
Value Range: 64 ~ 1500 bytes.

Encapsulation

1. A Must fill setting
2. ESP is selected by

Select the Encapsulation Protocol from the dropdown box for this IPSec tunnel.

Protocol Available encapsulations are ESP and AH.
default
1. A Must fill setting . . .
. . Specify the IKE version for this IPSec tunnel. Select v1 or v2.
IKE Version 2. vl is selected by

default

* Local & Remote Configuration

ltem Setting
D Subnet IP Address Subnet Mask Actions
+ Local Subnet List 1 192.168.66.0 255.255.255.0(/24) '~ Delete
Add
ID Subnet IP Address Subnet Mask Actions
» Remote Subnet List 1 ] 255.255.265.0(/24) v Delete
Add
+ Remote Gateway (IP Address/FQDN)
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Local Subnet List

Remote Subnet List

Remote Gateway

Item
» Key Management
» Local ID
» Remote ID

Key Management

Local ID

Remote ID

A Must fill setting

A Must fill setting

1. A Must fill setting.
2. Format can be a
ipv4 address or FQDN

IKE+Pre-shared Key v

Type:
Type:

1. A Must fill setting
2. Pre-shared Key 8 to
32 characters.

An optional setting

An optional setting

User Name v | |D:

Specify the Local Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete a Local Subnet.

Note_1: When Dynamic VPN option in Tunnel Scenario is selected, there will be
only one subnet available.

Note_2: When Host-to-Site or Host-to-Host option in Tunnel Scenario is
selected, Local Subnet will not be available.

Note_3: When Hub and Spoke option in Hub and Spoke is selected, there will be
only one subnet available.

Specify the Remote Subnet IP address and Subnet Mask.

Click the Add or Delete button to add or delete Remote Subnet setting.

Specify the Remote Gateway.

Setting

o
=
m
o
it
i

(Optional)

User Name v | ID:

Select Key Management from the dropdown box for this IPSec tunnel.
IKE+Pre-shared Key: user needs to set a key (8 ~ 32 characters).

IKE+X.509: user needs Certificate to authenticate. IKE+X.509 will be available
only when Certificate has been configured properly. Refer to Certificate section
of this manual and also Object Definition > Certificate in web-based utility.
Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.

Select Key ID for Local ID and enter the Key ID (English alphabet or number).
Specify the Remote ID for this IPSec tunnel to authenticate.

Select User Name for Remote ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Remote ID and enter the User@FQDN.

Select Key ID for Remote ID and enter the Key ID (English alphabet or number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.
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ltem Setting
+ Negotiation Mode Main Mode v
v X-Auth None ¥ || X-Auth Account |(Opfional)

User Name : Password :

» Dead Peer Detection (DFD)

# Enable

Timeout : (seconds) Delay : [30 (seconds)

+ Phase1 Key Life Time

[3600

(seconds) (Max. 86400)

IKE Phase Window

Item

Negotiation Mode

Value setting

Main Mode is set by

default default

Description

Specify the Negotiation Mode for this IPSec tunnel. Select Main Mode or
Aggressive Mode.

X-Auth

None is selected by
default

Specify the X-Auth role for this IPSec tunnel. Select Server, Client, or None.
Selected None no X-Auth authentication is required.

Selected Server this gateway will be an X-Auth server. Click on the X-Auth
Account button to create remote X-Auth client account.

Selected Client this gateway will be an X-Auth client. Enter User name and
Password to be authenticated by the X-Auth server gateway.

Note: X-Auth Client will not be available for Dynamic VPN option selected in
Tunnel Scenario.

(DPD)

Dead Peer Detection

1. Checked by default

2. Default Timeout
180s and Delay 30s

Click Enable box to enable DPD function. Specify the Timeout and Delay time in
seconds.
Value Range: 0 ~ 999 seconds for Timeout and Delay.

Phasel Key Life
Time

1. A Must fill setting
2. Default 3600s
3. Max. 86400s

Specify the Phasel Key Life Time.
Value Range: 30 ~ 86400.

« IKE Proposal Definition

[[n] Encryption Authentication DH Group Definition
1 [AES-128 7] SHAT v [Group2 v] [# Enable
2 MD5 v ¥ Enable
3 SHAT v 4 Enzble
4 [3DES | [SHA1 v [Group2 v # Enable

IKE Proposal Definition Window

Item

IKE Proposal
Definition

Value setting

A Must fill setting

Description
Specify the Phase 1 Encryption method. It can be DES / 3DES / AES-128 / AES-
192 / AES-256.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.

Specify the DH Group. It can be None / Group1 / Group2 / Group5 / Group14 /
Groupl5 / Groupl16 / Groupl7 / Group1l8.

Check Enable box to enable this setting
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» Phase2 Key Life Time

[28800

| {seconds) (Max. 86400)

IPSec Phase Window

Item

Phase2 Key Life Time

Value setting

1. A Must fill setting
2.28800s is set by
default

3. Max. 86400s

Description

Specify the Phase2 Key Life Time in second.
Value Range: 30 ~ 86400.

= IPSec Proposal Definition

[[n]} Encryption Authentication PFS Group Definition

1 AES-128 v SHA1 v [# Enable

2 AES-128 v MD5 Enable
‘

3 DES v SHA1 v # Enable

4 [3DES | | SHA1 v # Enable

IPSec Proposal Definition Window

\ Item

IPSec Proposal

Value setting

A Must fill setting

Description

Specify the Encryption method. It can be DES / 3DES / AES-128 / AES-192 / AES-
256.

Note: None is available when Encapsulation Protocol is set as AH.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.
Note: None and SHA2-256 are available only when Encapsulation Protocol is set

Definition as ESP; they are not available for AH Encapsulation.
Specify the PFS Group. It can be None / Groupl / Group2 / Group5 / Group14 /
Group15 / Group16 / Group17 / Group18.
Click Enable to enable this setting

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Back N/A Click Back to return to the previous page.
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Create/Edit Dynamic VPN Server List

i Add [l Delete || Refresh ’u

Similar to create an IPSec VPN Tunnel for site/host to site/host scenario, when Add / Edit button is applied a
series of configuration screen will appear. They are Tunnel Configuration, Local & Remote Configuration,
Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition. You have to
configure the tunnel details for the gateway as a Dynamic VPN server.

Note: For the purchased gateway, you can configure one Dynamic VPN server for each WAN interface.

« Tunnel Configuration

Item Setting
» Tunnel [ Enable
» Tunnel Name
» Interface
» Tunnsl Scanario
+ Encapsulation Protocol
» IKE Varsion

Tunnel Configuration Window

Item
Tunnel

Value setting
Unchecked by default

Description
Check the Enable box to activate the Dynamic IPSec VPN tunnel.

Tunnel Name

1. A Must fill setting
2. String format can be
any text

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 19 characters.

Interface

1. A Must fill setting
2. WAN 1 is selected
by default

Select WAN interface on which IPSec tunnel is to be established.

Tunnel Scenario

1. A Must fill setting
2. Tunnel Mode is
selected by default

Select the Dynamic IPSec tunneling scenario. It can be Tunnel Mode or
Transport Mode.

Encapsulation

1. A Must fill setting
2. ESP is selected by

Select the Encapsulation Protocol from the dropdown box for this IPSec tunnel.

Protocol Available encapsulations are ESP and AH.
default
1. A Must fill setting

IKE Version 2. vl is selected by Specify the IKE version for this IPSec tunnel.

default

= Local & Remote Configuration

Item Setting
» Local Subnet 192.168.66.0
» Local Metmask [255.255.255.0(24) v |

Local & Remote Configuration Window

Item Value setting Description
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Local Subnet
Local Netmask

Item

+ Key Management
v Local ID
» Remote [D

Key Management

Local ID

Remote ID

A Must fill setting
A Must fill setting

Specify the Local Subnet IP address.
Specify the Local Subnet Mask.

Setting

IKE+Pre-shared Key ¥ (Min. 8 characters

Type: [UserName ¥ | ID (Optional)

Type: |UserMName ¥ | ID

1. A Must fill setting
2. Pre-shared Key 8 to
32 characters.

An optional setting

An optional setting

Select Key Management from the dropdown box for this IPSec tunnel.
IKE+Pre-shared Key: user needs to set a key (8 ~ 32 characters).

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.

Select Key ID for Local ID and enter the Key ID (English alphabet or number).
Specify the Remote ID for this IPSec tunnel to authenticate.

Select User Name for Remote ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Remote ID and enter the User@FQDN.

Select Key ID for Remote ID and enter the Key ID (English alphabet or number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.

For the rest IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition settings, they are the
same as that of creating an IPSec Tunnel described in previous section. Please refer to the related description.
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5.1.2 OpenVPN

OpenVPN is an application that implements virtual private network (VPN) techniques for creating secure
point-to-point or site-to-site connections in routed or bridged configurations and remote access facilities. It
uses a custom security protocol that utilizes SSL/TLS for key exchange. It is capable of traversing network
address translators (NATs) and firewalls.

OpenVPN allows peers to authenticate each other using a Static Key (pre-shared key) or certificates. When
used in a multi-client-server configuration, it allows the server to release an authentication certificate for
every client, using signature and certificate authority. It uses the OpenSSL encryption library extensively, as
well as the SSLv3/TLSv1 protocol, and contains many security and control features.

OpenVPN Tunneling is a Client and Server based tunneling technology. The OpenVPN Server must have a
Static IP or a FQDN, and maintain a Client list. The OpenVPN Client may be a mobile user or mobile site with
public IP or private IP, and requesting the OpenVPN tunnel connection. The product supports both OpenVPN
Server and OpenVPN Client features to meet different application requirements.

There are two OpenVPN connection scenarios. They are the TAP and TUN scenarios. The product can create
either a layer-3 based IP tunnel (TUN), or a layer-2 based Ethernet TAP that can carry any type of Ethernet
traffic. In addition to configuring the device as a Server or Client, you have to specify which type of OpenVPN
connection scenario is to be adopted.

OpenVPN TUN Scenario
[Networkch @ Cortolcentr | [Neworks @ Remotesie | The term "TUN" mode is referred to routing mode and
=Ae

5 : m;.%;, = operates with layer 3 packets. In routing mode, the VPN
3 N & B 2 client is given an IP address on a different subnet than
scavh Agﬁg;::f" Enabled =" , the local LAN under the OpenVPN server. This virtual
6 > & m@mmed subnet is created for connecting to any remote VPN

Admin User

e e

-E..__ OpenVPN TUN '\ computers. In routing mode, the OpenVPN server

VPN Gateway/Concentrator| n n o . .
with 3 “Static |P* or FQDN- | L.coses from M2M-JoT Gateway creates a "TUN" interface with its own IP address pool
and RootCA. with “Public/Private IP” H H H
OpenVPNTUN Server OpenVPNTUN Crient \A{hlc.h |s.d|fferent to the Ioca_l LAN. Remgte hosts that
GW  Global b: 60249.211.108 GW: WAN IP: 192168168 111 dial-in will get an IP address inside the virtual network
FQDN : main-gw.ddns.net LAN IP: 192.168.123.254 VPN IP: 10.8.0.2 .
Local IP: 192.168.100.100 ne: 1216812321 veniewos022  and will have access On|y to the server where OpenVPN
1. M2M-loT Gateway (as OpenVPN TUN Client) connects to peer VPN reSideS_

Gateway/Concentrator (as OpenVPN TUN Server).
2. M2M-loT Gateway will be assigned 10.8.0.2 IP Address after OpenVPNTUN

Connection estabilshed. [10.8.0-x s a virtual subnet) If you want to offer remote access to a VPN server from

3. local networked device will get a virtual IP 10.8.0.x if its trafficgoes through the
OpenVPN TUN connection (when NAT disabled & Redirect Internet Trafficenabled). C||ent(s)' and |nh|b|t the access to remote LAN resources

4. SCADA Serverin Control Center can access remote attached device(s) with the

assigned IP Address 10.8.0.2. under VPN server, OpenVPN TUN mode is the simplest
solution.

As shown in the diagram, the M2M-loT Gateway is configured as an OpenVPN TUN Client, and connects to an
OpenVPN UN Server. Once the OpenVPN TUN connection is established, the connected TUN client will be
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assigned a virtual IP (10.8.0.2) which is belong to a virtual subnet that is different to the local subnet in Control
Center. With such connection, the local networked devices will get a virtual IP 10.8.0.x if its traffic goes
through the OpenVPN TUN connection when Redirect Internet Traffic settings is enabled; Besides, the SCADA
Server in Control Center can access remote attached serial device(s) with the virtual IP address (10.8.0.2).

OpenVPN TAP Scenario

SCADA \

tenr

sl

Admin User;

VPN Gateway/Concentrator
with a “Static IP” or “FODN"”
and RootCA.

OpenVPN TAP Server

i
Application
Servers

1| serial cable

()

-E"—--_

OpenVPN TAP

GwW

Global IP: 60.249.211.108
FQDN : main-gw.ddns.net
Local IP: 192.168.100.100

M2M-loT Gateway
with a “Public or
Private IP”
OpenVPN TAP Client

WAN IP: 192.168.168.111
Local IP: 192.168.123.254

M2M-loT Gateway (as OpenVPN TAP Client) connects to peer VPN
Gateway/Concentrator (as OpenVPN TAP Server).
M2M-loT Gateway will be assigned 192.168.100.210 IP Address after

OpenVPNTAP Connection estabilshed. (same subnetasin Control Center)
SCADA Server in Control Center can access remote attached device(s) with
the assigned IP Address 192.168.100.210.

The term "TAP" is referred to bridge mode and operates
with layer 2 packets. In bridge mode, the VPN client is
given an IP address on the same subnet as the LAN
resided under the OpenVPN server. Under such
configuration, the OpenVPN client can directly access to
the resources in LAN. If you want to offer remote access
to the entire remote LAN for VPN client(s), you have to
setup OpenVPN in “TAP” bridge mode.

As shown in the diagram, the M2M-loT Gateway is
configured as an OpenVPN TAP Client, and connects to an
OpenVPN TAP Server. Once the OpenVPN TAP connection
is established, the connected TAP client will be assigned a
virtual IP (192.168.100.210) which is the same subnet as

that of local subnet in Control Center. With such connection, the SCADA Server in Control Center can access
remote attached serial device(s) with the virtual IP address (192.168.100.210).
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Open VPN Setting

Go to Security > VPN > OpenVPN tab.

The OpenVPN setting allows user to create and configure OpenVPN tunnels.

Enable OpenVPN

Enable OpenVPN and select an expected configuration, either server or client, for the gateway to operate.

N |-

[temn Setting

» OpenVPN [# Enable

» Server / Client

Configuration

Item Value setting Description

OpenVPN The box is unchecked by Check the Enable box to activate the OpenVPN function.

default
Server/ Server Configuration is When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.

When Client is selected, you can specify the client settings in another client
configuration window.
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As an OpenVPN Server

If Server is selected, an OpenVPN

Server Configuration screen will appear. OpenVPN Server Configuration

window can let you enable the OpenVPN server function, specify the virtual IP address of OpenVPN server,

when remote OpenVPN clients dial i

n, and the authentication protocol.

Item Value setting

OpenVPN 1. An Optional setting.
Configuration 2. The box is unchecked by
File default.

ltem Setting
» OpenVPN |# Enable
v Server f Client
» OpenVPN Configuration file Enable] Export | client.ovpn

Configuration

Description

Click the Enable box to activate the export feature of OpenVPN Client
configuration to a .ovpn file. You have to further click the Export button to get
the configuration file.

The OpenVPN Server supports up to

* OpenVPN Server Configuration

4 TUN / TAP tunnels at the same time.

Authorization Mode

Item Setting
» OpenVPN Server ) Enable
» Protocol
» Port 14430 |
* Tunnel Scenario
TLS v

CA Cert: |amit-IDG761AM-JH crt v

Server CGert.: | LocalCert1 =

Server Virtual IP

110.8.0.0 |

DHCP-Proxy Mode

+ Enable

» IP Pool Starting Address: | -~ Ending Address:
» Gateway | |
» Netmask | 255 255 255 0(/24) v |

Redirect Default Gateway

Encryption Cipher

o &
g m

i
5
[ =3
=
*

» Hash Algorithm SHA-1 v
¥ LZO Compression
» Persist Key Enable

» Persist Tun Enable

» Advanced Configuration Edit
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OpenVPN Server

Protocol

Port

Tunnel Scenario

Authorization
Mode

Local Endpoint
IP Address

Remote
Endpoint IP
Address

Static Key

Server Virtual IP

DHCP-Proxy
Mode

IP Pool

The box is unchecked by

default.

1. A Must filled setting

2. Bydefault TCPis
selected.

A Must filled setting

A Must filled setting
By default TUN is
selected.

A Must filled setting
2. Bydefault TLS is
selected.

NEINe

=

A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

1. A Must filled setting
2. The box is checked by
default.

A Must filled setting

By default 4430 is set.

Click the Enable to activate OpenVPN Server functions.

Define the selected Protocol for connecting to the OpenVPN Server.

e Select TCP, or UDP

-> The TCP protocol will be used to access the OpenVPN Server, and Port will be

set as 4430 automatically.

e Select UDP

->The UDP protocol will be used to access the OpenVPN Server, and Port will be
set as 1194 automatically.

Specify the Port for connecting to the OpenVPN Server.

Value Range: 1 ~ 65535.

Specify the type of Tunnel Scenario for connecting to the OpenVPN Server. It
can be TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.

Specify the authorization mode for the OpenVPN Server.

o TLS

->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Server Cert. and DH PEM will be displayed.

CA Cert. could be generated in Certificate. Refer to Object Definition >
Certificate > Trusted Certificate.

Server Cert. could be generated in Certificate. Refer to Object Definition >
Certificate > My Certificate.

e Static Key

->The OpenVPN will use static key (pre-shared) authorization mode, and the
following items Local Endpoint IP Address, Remote Endpoint IP Address and
Static Key will be displayed.

Note: Static Key will be available only when TUN is chosen in Tunnel Scenario.
Specify the virtual Local Endpoint IP Address of this OpenVPN gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is chosen
in Authorization Mode.

Specify the virtual Remote Endpoint IP Address of the peer OpenVPN gateway.
Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Server Virtual IP.

Value Range: The IP format is 10.y.0.0, the range of y is 1~254.

Note: Server Virtual IP will be available only when TLS is chosen in Authorization
Mode.

Check the Enable box to activate the DHCP-Proxy Mode.

Note: DHCP-Proxy Mode will be available only when TAP is chosen in Tunnel
Device.

Specify the virtual IP pool setting for the OpenVPN server. You have to specify
the Starting Address and Ending Address as the IP address pool for the
OpenVPN clients.

Note: IP Pool will be available only when TAP is chosen in Tunnel Device, and

131



4G WAN Extender

Gateway

Netmask

Redirect Default
Gateway

Encryption
Cipher

Hash Algorithm
Lzo

Compression
Persis Key

Persis Tun

Advanced
Configuration

Save
Undo

A Must filled setting

By default - select one - is
selected.

1. An Optional setting.

2. The box is unchecked by

default.

1. A Must filled setting.
2. By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked by
default.

1. An Optional setting.
2. The box is checked by
default.

N/A

N/A
N/A

DHCP-Proxy Mode is unchecked (disabled).

Specify the Gateway setting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Note: Gateway will be available only when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Specify the Netmask setting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Value Range: 255.255.255.0/24 (only support class C)

Note_1: Netmask will be available when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Note_2: Netmask will also be available when TUN is chosen in Tunnel Device.
Check the Enable box to activate the Redirect Default Gateway function.

Specify the Encryption Cipher from the dropdown list.
It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm from the dropdown list.

It can be SHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.
Specify the LZO Compression scheme.

It can be Adaptive/YES/NO/Default.

Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the
OpenVPN server.

If the button is clicked, Advanced Configuration will be displayed below.

Click Save to save the settings.

Click X to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Server Advanced Configuration screen will appear.

% OpenVPN Server Advanced Configuration ®

Item Setting
» TLS Cipher 'None v |
¥ TLS Auth. Key )
(Optional)
» Client to Client ¥ Enable
» Duplicate CN ¥ Enable
» Tunnel MTU 1500 |
¥ Tunnel UDP Fragment ‘U ‘
» Tunnel UDP MSS-Fix Enable

-

CCD-Dir Default File

-

Client Connection Script

» Additional Configuration

OpenVPN Server Advanced Configuration

Item Value setting Description

TLS Cipher 1. A Must filled setting. Specify the TLS Cipher from the dropdown list.
2. TLS-RSA-WITH-AES128- It can be None / TLS-RSA-WITH-RC4-MD5 / TLS-RSA-WITH-AES128-SHA / TLS-
SHA is selected by default RSA-WITH-AES256-SHA / TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.
Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.
TLS Auth. Key 1. An Optional setting. Specify the TLS Auth. Key.
2. String format: any text Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.
Client to Client The box is checked by Check the Enable box to enable the traffics among different OpenVPN Clients.
default Note: Client to Client will be available only when TLS is chosen in Authorization
Mode
Duplicate CN The box is checked by Check the Enable box to activate the Duplicate CN function.
default Note: Duplicate CN will be available only when TLS is chosen in Authorization
Mode
Tunnel MTU 1. A Must filled setting Specify the Tunnel MTU.
2. The value is 1500 by Value Range: 0 ~ 1500.
default
Tunnel UDP 1. A Must filled setting Specify the Tunnel UDP Fragment. By default, it is equal to Tunnel MTU.
Fragment 2. The value is 1500 by Value Range: 0 ~ 1500.
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default Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Tunnel UDP 1. An Optional setting. Check the Enable box to activate the Tunnel UDP MSS-Fix Function.

MSS-Fix 2. The box is unchecked by Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
default. Protocol.

CCD-Dir Default 1. An Optional setting. Specify the CCD-Dir Default File.

File 2. String format: any text Value Range: 0 ~ 256 characters.

Client 1. An Optional setting. Specify the Client Connection Script.

Connection 2. String format: any text Value Range: 0 ~ 256 characters.

Script

Additional 1. An Optional setting. Specify the Additional Configuration.

Configuration 2. String format: any text Value Range: 0 ~ 256 characters.
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As an OpenVPN Client

If Client is selected, the configuration screen will be changed as below and an OpenVPN Client List screen
appear.

# Configuration . ®

ltem Setting

» OpenVPN | Enable

» Server / Client

» OpenVPN Configuration file | [J Enabl

OpenVPN Configuration

Item \ Value setting | Description
OpenVPN The box is unchecked Check the Enable box to activate the OpenVPN function.
by default
Server/ Server Configuration is When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.

When Client is selected, you can specify the client settings in another client
configuration window.
OpenVPN 1. An Optional setting.  Click the Enable box to activate the OpenVPN Client configuration via a pre-
Configuration file 2. The box is defined configuration file. You have to further click the Upgrade button to
unchecked by default.  upload the configuration from a .ovpn file.

If you enabled this function, you can’t add any OpenVPN clients manually.

= OpenVPN Client List [JXe:)

Interface  Protocol | Port

Redirect
Internet | NAT
Traffic

Remote | Remote
Scenario | IP/FQDN | Subnet

Authorization | Encryption
Mode Cipher

Algorithm Enable | Actions

When Add button is applied, OpenVPN Client Configuration screen will appear. OpenVPN Client Configuration
window let you specify the required parameters for an OpenVPN VPN client, such as "OpenVPN Client Name",
"Interface", "Protocol", "Tunnel Scenario", "Remote IP/FQDN", "Remote Subnet", "Authorization Mode",
"Encryption Cipher", "Hash Algorithm" and tunnel activation.
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Item

r OpenVPN Client Name

-

Interface
» Protocol

» Tunnel Scenario

-

Remote IP/FQDN

Remote Subnet

-

Redirect Internet Traffic

 NAT

» Authorization Mode

» Encryption Cipher

-

Hash Algorithm

b LZ0 Compression

]

e
[ae]
ol

rsist Key

b Per

ol

st Tun

» Advanced Configuration

» Tunne|

OpenVPN Client #1
WAN1 ~
TCP r
TUN *

Port (443

(o]
451
(%]
=]

%3]
(%3]

Enable 2
Enable
# Enabls
TLS v
CACert: | v
Blowfish ¥
SHA-1 v

Client Cert. ¥ | Client Key.:

Adaptive ¥
# Enable

¥ Enable

[43]

(%3]

Setting

Flease set the Ceriificate.

Edit

Enable

OpenVPN Client
Name
Interface

Protocol

Port

Tunnel Scenario

Remote IP/FQDN

Remote Subnet

Redirect Internet

Traffic

NAT

A Must filled setting

1. A Must filled setting
2. By default WAN-1 is
selected.

1. A Must filled setting
2. By default TCP is
selected.

1. A Must filled setting
2. By default 443 is
set.

1. A Must filled setting
2. By default TUN is
selected.

A Must filled setting

1. An Optional setting.
2. The box is

unchecked by default.
1. An Optional setting.
2. The box is

unchecked by default.
1. An Optional setting.

The OpenVPN Client Name will be used to identify the client in the tunnel list.
Value Range: 1 ~ 32 characters.
Define the physical interface to be used for this OpenVPN Client tunnel.

Define the Protocol for the OpenVPN Client.

e Select TCP

->The OpenVPN will use TCP protocol, and Port will be set as 443 automatically.
e Select UDP

->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.

Specify the Port for the OpenVPN Client to use.

Value Range: 1 ~ 65535.

Specify the type of Tunnel Scenario for the OpenVPN Client to use. It can be
TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.

Specify the Remote IP/FQDN of the peer OpenVPN Server for this OpenVPN
Client tunnel.

Fill in the IP address or FQDN.

Check the Enable box to activate remote subnet function, and specify Remote
Subnet of the peer OpenVPN Server for this OpenVPN Client tunnel.

Fill in the remote subnet address and remote subnet mask.

Check the Enable box to activate the Redirect Internet Traffic function.

Check the Enable box to activate the NAT function.
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Authorization Mode

Local Endpoint IP
Address

Remote Endpoint IP
Address

Static Key

Encryption Cipher
Hash Algorithm
LZO Compression

Persis Key

Persis Tun

Advanced

Configuration

Tunnel

Save
Undo

2. The box is checked
by default.

1. A Must filled setting
2. By default TLS is
selected.

A Must filled setting

A Must filled setting

A Must filled setting

By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

N/A

The box is unchecked
by default

N/A

N/A

Specify the authorization mode for the OpenVPN Server.

o TLS

->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Client Cert. and Client Key will be displayed.

CA Cert. could be selected in Trusted CA Certificate List. Refer to Object
Definition > Certificate > Trusted Certificate.

Client Cert. could be selected in Local Certificate List. Refer to Object Definition
> Certificate > My Certificate.

Client Key could be selected in Trusted Client key List. Refer to Object Definition
> Certificate > Trusted Certificate.

e StaticKey

->The OpenVPN will use static key authorization mode, and the following items
Local Endpoint IP Address, Remote Endpoint IP Address and Static Key will be
displayed.

Specify the virtual Local Endpoint IP Address of this OpenVPN gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is chosen
in Authorization Mode.

Specify the virtual Remote Endpoint IP Address of the peer OpenVPN gateway.
Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Encryption Cipher.

It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm.

It can be SHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.

Specify the LZO Compression scheme.

It can be Adaptive/YES/NO/Default.

Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the
OpenVPN server.

If the button is clicked, Advanced Configuration will be displayed below.

Check the Enable box to activate this OpenVPN tunnel.

Click Save to save the settings.
Click X to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Client Advanced Configuration screen will appear.

» TLS Cipher

b User Name(Optional)
¢ Password(Optional)
» Bridge TAF to

+ Firewall Protection

v Client IP Address

¢ Tunnel MTU

» Tunnel UDP Fragment

» Tunnel UDP MSS-Fix

r nsCertType Verification

r DN3S

» Additional Configuration

Item

» TLS Auth. Key(Optional)

+ TLS Renegotiation Time(seconds)

» Conneclion Retry({seconds)

None

Setting

A(Optional)
(Cptional)
(Cptional)

VLAN 1 ¥

Enable

Dynamic IP

1500
1500

Enable
Enable
3600
-1

(seconds)

(seconds)

Automatically ¥

TLS Cipher

TLS Auth. Key

User Name

Password

Bridge TAP to

Firewall Protection

1. A Must filled setting.
2. TLS-RSA-WITH-
AES128-SHA is selected
by default

1. An Optional setting.
2. String format: any text

An Optional setting.

An Optional setting.

By default VLAN 1 is
selected

The box is unchecked by
default.

Specify the TLS Cipher from the dropdown list.

It can be None / TLS-RSA-WITH-RC4-MD5 / TLS-RSA-WITH-AES128-SHA / TLS-
RSA-WITH-AES256-SHA / TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.

Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.

Specify the TLS Auth. Key for connecting to an OpenVPN server, if the server
required it.

Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.

Enter the User account for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Enter the Password for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Specify the setting of “Bridge TAP to” to bridge the TAP interface to a certain
local network interface or VLAN.

Note: Bridge TAP to will be available only when TAP is chosen in Tunnel
Scenario and NAT is unchecked.

Check the box to activate the Firewall Protection function.

Note: Firewall Protection will be available only when NAT is enabled.

138




4G WAN Extender

Client IP Address

Tunnel MTU

Tunnel UDP
Fragment

Tunnel UDP MSS-
Fix

nsCerType
Verification

TLS Renegotiation
Time (seconds)
Connection
Retry(seconds)

DNS

Additional
Configuration
Save

Undo

By default Dynamic IP is
selected

1.A Must filled setting
2.The value is 1500 by
default

The value is 1500 by
default

The box is unchecked by
default.

The box is unchecked by
default.

The value is 3600 by
default

The value is -1 by default

By default Automatically
is selected

An Optional setting.

N/A
N/A

Specify the virtual IP Address for the OpenVPN Client.
It can be Dynamic IP/Static IP.

Specify the value of Tunnel MTU.

Value Range: 0 ~ 1500.

Specify the value of Tunnel UDP Fragment.

Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Check the Enable box to activate the Tunnel UDP MSS-Fix function.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
Protocol.

Check the Enable box to activate the nsCerType Verification function.

Note: nsCerType Verification will be available only when TLS is chosen in
Authorization Mode.

Specify the time interval of TLS Renegotiation Time.

Value Range: -1 ~ 86400.

Specify the time interval of Connection Retry.

The default -1 means that it is no need to execute connection retry.

Value Range: -1 ~ 86400, and -1 means no retry is required.

Specify the setting of DNS.

It can be Automatically/Manually.

Enter optional configuration string here. Up to 256 characters is allowable.
Value Range: 0 ~ 256characters.

Click Save to save the settings.

Click X to cancel the changes and return to last page.
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5.1.3 L2TP
= Configuration [ - ] ]
Item Setting
» L2TP [ Enable
+ Client/Server
= L2TP Server Configuration [ - ] ]
Item Setting
» L2TP Server Enable
+ Interface
» L2TF over IPsec Enable Preshared Key | | (Min. & characters)
» Server Virtual IP [192.168.10.1 |
» IP Pool Starting Address
» |P Pool Ending Address
» Authentication Protocol PAP 1 CHAP [ MS-CHAP = MS-CHAP v2
» MPPE Encryption Enable
» Service Port [1701 |
« L2TP Server Status [ - ] ]
User Name Remote IP Remote Virtual IP Remote Call ID Actions
Mo connection from remote
« User Account List [T [ - | %]
1D User Name Password Enable Actions

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol used to support virtual private networks (VPNs) or as
part of the delivery of services by ISPs. It does not provide any encryption or confidentiality by itself. Rather, it
relies on an encryption protocol that it passes within the tunnel to provide privacy. This Gateway can behave
as a L2TP server and a L2TP client both at the same time.

L2TP Server: It must have a static IP or a FQDN for clients to create L2TP tunnels. It also maintains “User
Account list” (user name/ password) for client login authentication; There is a virtual IP pool to assign virtual IP
to each connected L2TP client.

L2TP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the L2TP tunnel in the “Default Gateway / Remote Subnet”

parameter.
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Network-A @ HQ Data Center
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Network-B @ Remote Office
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Application G i ?
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Security —_—E === — = — — i M2M
Gateway 2 .-__LZ_-LE_IlLflfle_l____( . Gateway
“StaticIP” [f&) o “Dynamic IP”
: Server Clién v

y LN
Global IP: 203.95.80.22

Local IP: 10.0.76.2

[L2TP]-[L2TP Server Configuration]

L2TP over IPSec:

Enable Preshare Key, 12345678
ServerVirtual IP: 192.168.101.253
IP Pool Starting Address: 10
IP Pool Ending Address: 50
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits
Service Port: 1701

ID1:
User Name: Client-1
Password: 1234

1-

= Global IP: 118.18.81.33
Local IP: 10.0.75.2

[L2TP]-[L2TP Client Configuration]

1 Create tunnel by Client,
Authentication by Server.

2 Server assign Virtual IP,
Tunnel created.

Client subnet can access
3 HQ server via tunnel.

Internet packets go through
4 Tunnel if "Default Gateway”
option Is enabled.

Operation Mode: Always on

L2TP over IPSec: Enable

Preshare Key: 12345678

Remote LNS IP/FQDN: 203.95.80.22
Remote LNS Port: 1701

User Name: Client-1

Password: 1234

Remote Subnet: 10.0.76.0/24
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable,128 bits
Service Port: Auto

Besides, for the L2TP client peer, a Remote
Subnet item is required. It is for the Intranet
of L2TP server peer. So, at L2TP client peer,
the packets whose destination is in the
dedicated subnet will be transferred via the
L2TP tunnel. Others will be transferred based
on current routing policy of the gateway at
L2TP client peer. But, if you entered 0.0.0.0/0
in the Remote Subnet field, it will be treated
as a "Default Gateway" setting for the L2TP
client peer, all packets, including the Internet
accessing of L2TP client peer, will go through
the established L2TP tunnel. That means the
remote L2TP server peer controls the flow of
any packets from the L2TP client peer.
Certainly, those packets come through the
L2TP tunnel.
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L2TP Setting

Go to Security > VPN > L2TP tab.

The L2TP setting allows user to create and configure L2TP tunnels.

Enable L2TP

® Configuration

ltem Setting

() Enable

Server v

» L2TP

» Client/Server

Enable L2TP Window

Value setting

Description

Click the Enable box to activate L2TP function.

Specify the role of L2TP. Select Server or Client role your gateway will take.
Below are the configuration windows for L2TP Server and for L2TP Client.

Unchecked by default

Client/Server A Must filled setting

Save N/A

Click Save button to save the settings

As a L2TP Server

When select Server in Client/Server, the L2TP server Configuration will appear.
* L2TP Server Configuration

Item Setting

» L2TP Server

Enable

¥ Interface

WANT  »

» L2TP over IPsec

[ 1 Enable Preshared Key |1234567890 | (Min. 8 characters)

¥ Server Virtual IP

192.168.13.1 |

¥ |P Pool Starting Address

¥ |IP Pool Ending Address

= || [ =
=]

» Authentication Pratocaol + PAP ¢ CHAP MS-CHAP MS-CHAP v2
» MPPE Encryption Enable | 40 bits v

» Service Port

1701 |
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L2TP Server Configuration

Item Value setting Description

The box is unchecked

When click the Enable box

L2TP Server
by default It will active L2TP server
1. A Must fill setting . . . .
. Select the interface on which L2TP tunnel is to be established. It can be the
Interface 2. All WANSs is selected

by default

available WAN interfaces.

L2TP over IPSec

The box is unchecked
by default

When click the Enable box.
It will enable L2TP over IPSec and need to fill in the Pre-shared Key (8~32
characters).

Server Virtual IP

A Must filled setting

Specify the L2TP server Virtual IP
It will set as this L2TP server local virtual IP

IP Pool Starting

1. A Must filled setting

Specify the L2TP server starting IP of virtual IP pool
It will set as the starting IP which assign to L2TP client

Address 2.10is set by default.
Value Range: 1 ~ 254.
. Specify the L2TP server ending IP of virtual IP pool
IP Pool Ending 1. A Must filled setting It will set as the ending IP which assign to L2TP client
Address 2. 17 is set by default. 8 &

Value Range: >= Starting Address, and < (Starting Address + 8) or 254.

Authentication
Protocol

A Must filled setting

Select single or multiple Authentication Protocols for the L2TP server with
which to authenticate L2TP clients. Available authentication protocols are PAP /
CHAP / MS-CHAP / MS-CHAP v2.

MPPE Encryption

A Must filled setting

Specify whether to support MPPE Protocol. Click the Enable box to enable
MPPE and from dropdown box to select 40 bits / 56 bits / 128 bits.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Service Port

A Must filled setting

Specify the Service Port which L2TP server use.
Value Range: 1 ~ 65535.

Save

N/A

Click the Save button to save the configuration.

Undo

N/A

Click the Undo button to recovery the configuration.

User Name

& L2TP Server Status

Refresh

Remote IP

Remote Virtual IP Remote Call ID Actions

No connection from remaote

L2TP Server Status
Item

L2TP Server Status

Value setting

N/A

Description
It displays the User Name, Remote IP, Remote Virtual IP, and Remote Call ID of

the connected L2TP clients.
Click the Refresh button to renew the L2TP client information.
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= User Account List R0 - | 2]
1D User Name Password Enable Actions
User Name Password Account
| | [ | [ Enable
[save ]

User Account List Window

Item Value setting Description
This is the L2TP authentication user account entry. You can create and add

accounts for remote clients to establish L2TP VPN connection to the gateway
device.
Click Add button to add user account. Enter User name and password. Then
. Max.of 10 user
User Account List accounts check the enable box to enable the user.
u
Click Save button to save new user account.
The selected user account can permanently be deleted by clicking the Delete
button.

Value Range: 1 ~ 32 characters.
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As a L2TP Client

When select Client in Client/Server, a series L2TP Client Configuration will appear.
»

Item Setting

» L2TP Client | Enable

| L2TP Client Configuration

Item Setting Value setting
L2TP Client The box is unchecked
x1su Check the Enable box to enable L2TP client role of the gateway.
by default
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.

Create/Edit L2TP Client

« L27TP Client List & Status m "

D Tunnel Name Interface Virtual IP Iﬁ?l—z?'.loé:l Remote Subnet Status Enable Actions
1 L2TP #1 WAN 1 0000 |192.168.127.72 [ Select

When Add/Edit button is applied, a series of configuration screen will appear. You can add up to 8 L2TP
Clients.

= LZTP Client Configuration

Item Setting
+ Tunnel Name [L2TP #1 |
» Interface WANT »
» L2TP over IPsec [ Enable Preshared Key | | (Min. 8 characters)
» Remote LNS IPIFQDN 1
» MTU
» Remofe LNS Port [1701
» User Mame |:|
» Password [ 1
» Tunneling Password (Optional) | |
» Remote Subnet [ ]
» Authentication Protocol [0 PAP [0 CHAP [0 MS-CHAP [0 MS-CHAP v2
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» MPFE Encryption

NAT before Tunneling

LCF Echo Type

Service Port

» Tunnel

Enable
Enable

Auto v

nterval |30
Auto
Enable

seconds  Max. Failure Time |6 fimes

Y| [0

Tunnel Name

Interface

L2TP over IPSec

Remote LNS
IP/FQDN

MTU

Remote LNS Port

User Name

Password

Tunneling
Password(Optional)

Remote Subnet

Authentication
Protocol

A Must filled setting

A Must filled setting

The box is unchecked
by default

A Must filled setting

1.A Must filled setting
2.The value is 1500 by
default

1. A Must filled setting
2.1701 is set by
default

A Must filled setting

A Must filled setting

An Optional filled
setting

A Must filled setting

1. A Must filled setting
2. Unchecked by

Enter a tunnel name. Enter a name that is easy for you to identify.

Value Range: 1 ~ 32 characters.

Define the selected interface to be the used for this L2TP tunnel

(WAN-1 is available only when WAN-1 interface is enabled)

The same applies to other WAN interfaces (e.g. WAN-2).

Check the Enable box to activate L2TP over IPSec, and further specify a Pre-
shared Key (8~32 characters).

Enter the public IP address or the FQDN of the L2TP server.

Specify the MTU.
Value Range: 0 ~ 1500.

Enter the Remote LNS Port for this L2TP tunnel.
Value Range: 1 ~ 65535.

Enter the User Name for this L2TP tunnel to be authenticated when connect to
L2TP server.

Value Range: 1 ~ 32 characters.

Enter the Password for this L2TP tunnel to be authenticated when connect to
L2TP server.

Enter the Tunneling Password for this L2TP tunnel to authenticate.

Specify the remote subnet for this L2TP tunnel to reach L2TP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of L2TP VPN server. So, at L2TP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the L2TP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at L2TP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the L2TP client peer, all packets, including the
Internet accessing of L2TP Client peer, will go through the established L2TP VPN
tunnel. That means the remote L2TP VPN server controls the flow of any
packets from the L2TP client peer. Certainly, those packets come through the
L2TP VPN tunnel.

Specify one ore multiple Authentication Protocol for this L2TP tunnel.
Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.
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MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Service Port

Tunnel
Save
Undo

default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

1. Auto is set by
default

A Must filled setting

Unchecked by default
N/A
N/A

Specify whether L2TP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this L2TP tunnel.

Specify the LCP Echo Type for this L2TP tunnel. It can be Auto, User-defined, or
Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Specify the Service Port for this L2TP tunnel to use. It can be Auto, (1701) for
Cisco), or User-defined.

Auto: The system determines the service port.

1701 (for Cisco): The system use port 1701 for connecting with CISCO L2TP
Server.

User-defined: Enter the service port. The default value is 0.

Value Range: 0 ~ 65535.

Check the Enable box to enable this L2TP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.4 PPTP

« Configuration a n
Iltem Setting

» PPTP O Enable

» Client/Server
Item Setting

» PPTP Server Enable

» Interface

» Server Virtual IP

» IP Pool Starting Address

» IP Pool Ending Address

+ Authentication Protocol PAP [ CHAP ' MS-CHAP [ MS-CHAP v2

» MPPE Encryption Enable 40 bits v |

= PPTP Server Status [0 an

User Name Remote IP Remote Virtual IP Remaote Call ID Actions
No connection from remote
= User Account List [[T] - | =]
D User Name Password Enable Actions

Point-to-Point Tunneling Protocol (PPTP) is a method for implementing virtual private networks. PPTP uses a
control channel over TCP and a GRE tunnel operating to encapsulate PPP packets. It is a client-server based
technology. There are various levels of authentication and encryption for PPTP tunneling, usually natively as
standard features of the Windows PPTP stack. The security gateway can play either "PPTP Server" role or
"PPTP Client" role for a PPTP VPN tunnel, or both at the same time for different tunnels. PPTP tunnel process
is nearly the same as L2TP.

PPTP Server: It must have a static IP or a FQDN for clients to create PPTP tunnels. It also maintains “User
Account list” (user name / password) for client login authentication; There is a virtual IP pool to assign virtual
IP to each connected PPTP client. u

PPTP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also

define what kind of traffics will pass through the PPTP tunnel in the “Default Gateway / Remote Subnet”
parameter.
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Network-A @ HQ Data Center

=e
WD e’
Application e fickr
Ser\rer Database el T
T e v
Sk | 10.0.76.0/24
G e
a i

Network-B @ Remote Office

N
Security B M2M
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N
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Local IP: 10.0.76.2

[PPTP]-[PPTP Server Configuration]

Server Virtual IP: 192.168.101.253
IP Pool Starting Address: 10
IP Pool Ending Address: 50
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits 3

4 Create tunnel by Client,
Authentication by Server.

2 Server assign Virtual IP,
Tunnel created.

Client subnet can access
HQ servervia tunnel.

ID1:
User Name: Client-1 4
Password: 1234

Internet packets go through

hled

option Is

Local IP: 10.0.75.2

[PPTP]-[PPTP Client Configuration]

Operation Mode: Always on
Remote IP/FQDN: 203.95.80.22
User Name: Client-1

Password: 1234

Remote Subnet: 10.0.76.0/24
Authentication: MS-CHAP

MPPE Encryption: Enable, 128 bits

Tunnel if “Default Gateway”

Certainly, those packets come through the PPTP tunnel.

Besides, for the PPTP client peer, a Remote
Subnet item is required. It is for the Intranet
of PPTP server peer. So, at PPTP client peer,
the packets whose destination is in the
dedicated subnet will be transferred via the
PPTP tunnel. Others will be transferred based
on current routing policy of the gateway at
PPTP client peer. But, if you entered 0.0.0.0/0
in the Remote Subnet field, it will be treated
as a "Default Gateway" setting for the PPTP
client peer, all packets, including the Internet
accessing of PPTP client peer, will go through
the established PPTP tunnel. That means the
remote PPTP server peer controls the flow of
any packets from the PPTP client peer.
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PPTP Setting

Go to Security > VPN > PPTP tab.

The PPTP setting allows user to create and configure PPTP tunnels.

Enable PPTP

* Configuration ' x
Item Setting
» PPTP [J Enable
¥ Client/Server
Enable PPTP Window
Item Value setting Description
PPTP Unchecked by default  Click the Enable box to activate PPTP function.
. Specify the role of PPTP. Select Server or Client role your gateway will take.
Client/Server A Must fill setting pectty youre y

Below are the configuration windows for PPTP Server and for Client.
Save N/A Click Save button to save the settings.

As a PPTP Server

The gateway supports up to a maximum of 10 PPTP user accounts.
When Server in the Client/Server field is selected, the PPTP server configuration window will appear.

%] PPTP Server Configuration n *
Item Setting

» PPTP Server Enable

¥ Interface WAN1 v

» Server Virtual IP |192.158.12.1 |

¥ |IP Pool Starting Address

= || [ =
~|| =

¥ IP Pool Ending Address

» Authentication Protocol PAP CHAP ¥ MS-CHAP ¥ MS-CHAP v2
» MPPE Encryption + Enable | 40 bits v
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\ PPTP Server Configuration Window

Item Value setting Description
PPTP Server Unchecked by default  Check the Enable box to enable PPTP server role of the gateway.
1. A Must fill setting . . . .
. Select the interface on which PPTP tunnel is to be established. It can be the
Interface 2. All WANSs is selected . .
available WAN interfaces.
by default
1. A Must fill setting Specify the PPTP server Virtual IP address. The virtual IP address will serve as
Server Virtual IP 2. Default is the virtual DHCP server for the PPTP clients. Clients will be assigned a virtual IP
192.168.0.1 address from it after the PPTP tunnel has been established.
. . . This is the PPTP server’s Virtual IP DHCP server. User can specify the first IP
IP Pool Starting 1. A Must fill setting . . . .
. address for the subnet from which the PPTP client’s IP address will be assigned.
Address 2. Default is 10
Value Range: 1 ~ 254.
. . . This is the PPTP server’s Virtual IP DHCP server. User can specify the last IP
IP Pool Ending 1. A Must fill setting . L, . .
Add . address for the subnet from which the PPTP client’s IP address will be assigned.
ress 2. Default is 17 . .
Value Range: >= Starting Address, and < (Starting Address + 8) or 254,
Authentication 1. A Must fill setting Select single or multiple Authentication Protocols for the PPTP server with
Protocol 2. Unchecked by which to authenticate PPTP clients. Available authentication protocols are PAP /
default CHAP / MS-CHAP / MS-CHAP v2.
. . Specify whether to support MPPE Protocol. Click the Enable box to enable
1. A Must fill setting . . .
. MPPE and from dropdown box to select 40 bits / 56 bits / 128 bits.
MPPE Encryption 2. Unchecked by o —
default Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
efau
CHAP options will not be available.
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.

= PPTP Server Status

Remote Virtual IP Remote Call ID Actions

User Name Remote IP

No connection from remaote

PPTP Server Status Window

Item Value setting Description
It displays the User Name, Remote IP, Remote Virtual IP, and Remote Call ID of
PPTP Server Status N/A the connected PPTP clients.

Click the Refresh button to renew the PPTP client information.

= User Account List [[TT] BE
1D User Name Password Enable Actions
User Name Password Account
| | [ | 1 Enable
[Save]

\ User Account List Window
Item Value setting Description
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This is the PPTP authentication user account entry. You can create and add
accounts for remote clients to establish PPTP VPN connection to the gateway
device.
Click Add button to add user account. Enter User name and password. Then
. Max.of 10 user
User Account List check the enable box to enable the user.
accounts )
Click Save button to save new user account.
The selected user account can permanently be deleted by clicking the Delete
button.

Value Range: 1 ~ 32 characters.

As a PPTP Client

When select Client in Client/Server, a series PPTP Client Configuration will appear.

% PPTP Client Configuration

Item Setting

» PPTP Client Enable

PPTP Client Configuration

Item Value setting Description

PPTP Client Unchecked by default ~ Check the Enable box to enable PPTP client role of the gateway.
Save N/A Click Save button to save the settings.

Undo N/A Click Undo button to cancel the settings.

Create/Edit PPTP Client

= PPTP Chient List & Status B0 5| I Delete || Refresh
ID Tunnel Name Interface Virtual IP IIRJ?%[IJZ;?NI Remote Subnet Status Enable Actions

When Add/Edit button is applied, a series PPTP Client Configuration will appear.
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» Tunnel Name

» Interface

» Remote IP/FQDN
» MTU

b User Name

b Pazsword

» Remote Subnet

» MPPE Encryption

+ LCP Echo Type

+ Tunnel

Item

b Authentication Protocol

¥ MAT before Tunneling

PPTP #1
WANT ¥

1500

PAF [ CHAP

Enable

Enable
Auto
Interval |30

Enable

Setting

MS-CHAFP [ MS-CHAP v2

seconds Max. Failure Time |& times

Tunnel Name

Interface

Remote IP/FQDN

MTU

User Name

Password

Remote Subnet

A Must fill setting

1. A Must fill setting

2. WANL1 is selected by
default

1. A Must fill setting.
2. Format can be a

ipv4 address or FQDN
1.A Must filled setting

2.The value is 1500 by
default
A Must fill setting

A Must fill setting

A Must fill setting

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 32 characters.

Define the selected interface to be the used for this PPTP tunnel
(WAN-1 is available only when WAN-1 interface is enabled)

The same applies to other WAN interfaces (e.g. WAN-2).

Enter the public IP address or the FQDN of the PPTP server.

Specify the MTU.
Value Range: 0 ~ 1500.

Enter the User Name for this PPTP tunnel to be authenticated when connect to
PPTP server.

Value Range: 1 ~ 32 characters.

Enter the Password for this PPTP tunnel to be authenticated when connect to
PPTP server.

Specify the remote subnet for this PPTP tunnel to reach PPTP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of PPTP VPN server. So, at PPTP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the PPTP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at PPTP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the PPTP client peer, all packets, including the
Internet accessing of PPTP Client peer, will go through the established PPTP VPN
tunnel. That means the remote PPTP VPN server controls the flow of any
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Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Tunnel
Save
Undo

1. A Must fill setting
2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

Auto is set by default

Unchecked by default
N/A
N/A

packets from the PPTP client peer. Certainly, those packets come through the
PPTP VPN tunnel.

Specify one ore multiple Authentication Protocol for this PPTP tunnel.
Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether PPTP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this PPTP tunnel.

Specify the LCP Echo Type for this PPTP tunnel. It can be Auto, User-defined, or
Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Check the Enable box to enable this PPTP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.5 GRE

Generic Routing Encapsulation (GRE) is a tunneling protocol developed by Cisco Systems that encapsulates a
wide variety of network layer protocols inside virtual point-to-point links over an Internet Protocol
internetwork.

Deploy a M2M gateway for remote site and establish a virtual private network with control center by using
GRE tunneling. So, all client hosts behind M2M gateway can make data communication with server hosts
behind control center gateway.

GRE Tunneling is similar to IPSec Tunneling, client requesting the tunnel establishment with the server. Both
the client and the server must have a Static IP or a FQDN. Any peer gateway can be worked as either a client
or a server, even using the same set of configuration rule.

GRE Tunnel Scenario

Network.B @ Remote Office To setup a GRE tunnel, each peer needs to
Application =1 setup its global IP as tunnel IP and fill in the
Server Database =] & other's global IP as remote IP.

N

s | 10.0.76.0/28 J P

‘;‘g:/ ¢ . [’ Im%
Sy .

Network-A @ HQ Data Center

Besides, each peer must further specify the
Remote Subnet item. It is for the Intranet of

Security M2M X
Gateway Gateway GRE server peer. So, at GRE client peer, the
“StaticIP” “Cratic IP” . . .. .
" Server i saticl? packets whose destination is in the dedicated
b 00762 0 T TTTT 17 arisamss subnet will be transferred via the GRE tunnel.

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 203.95.80.22
Remote IP: 118.18.81.33

Key: 1234

TTL: 255

Remote Subnet: 10.0.75.0/24
DMVPN Spoke: Disable
Tunnel: Enable

4 Create tunnel by Client,
Authentication by Server.

2 Any peer gateway can be
both Client & Server, and
must have Static IP or FQDN.

Client subnet can access
3 Serversubnetvia tunnel.

Internet packets go through
4 Tunnel if “Default Gateway”
option Is enabled.

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 118.18.81.33
Remote IP: 203.95.80.22

Key: 1234

TTL: 255

Remote Subnet: 10.0.76.0/24
DMVPN Spoke: Disable
Tunnel: Enable

Others will be transferred based on current
routing policy of the gateway at GRE client peer.
But, if you entered 0.0.0.0/0 in the Remote
Subnet field, it will be treated as a "Default
Gateway" setting for the GRE client peer, all
packets, including the Internet accessing of GRE
client peer, will go through the established GRE

tunnel. That means the remote GRE server peer controls the flow of any packets from the GRE client peer.
Certainly, those packets come through the GRE tunnel.

If the GRE server supports DMVPN Hub function, like Cisco router as the VPN concentrator, the GRE client can
active the DMVPN spoke function here since it is implemented by GRE over IPSec tunneling.
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GRE Setting

Go to Security > VPN > GRE tab.

The GRE setting allows user to create and configure GRE tunnels.

Enable GRE
® Configuration ’ b4
ltem Setting
» GRE Tunnel ) Enable
» Max. Concurrent GRE 32
Tunnels
\ Enable GRE Window \
\ Item Value setting Description \
GRE Tunnel Unchecked by default  Click the Enable box to enable GRE function.
Max. Concurrent Depends on Product The specified value will limit the maximum number of simultaneous GRE tunnel
GRE Tunnels specification. connection. The default value can be different for the purchased model.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Create/Edit GRE tunnel

# GRE Tunnel List .. --

ID| Tunnel Name Interface Tunnel IP Remote IP MTU Key TTL Remote Subnet Enable Actions

When Add/Edit button is applied, a GRE Rule Configuration screen will appear.
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Item Setting
¥ Tunnel Name |GF!E #1 |
¥ Interface WANT »
» Tunnel IP IP: | | MASK: | -- select one - v | (Option

¥ Remote IP

» MTU

[ |

r Key

| (Optional)

» TTL

[ |

¥ Remote Subnet

¥ Tunnel

|
[ ] Enable

GRE Rule Configuration Window

Item Value setting

Tunnel Name A Must fill setting

Description
Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 9 characters.

1. A Must fill setting

Select the interface on which GRE tunnel is to be established. It can be the

Interface 2. WAN 1 is selected . .
available WAN and LAN interfaces.
by default
Tunnel IP An Optional setting Enter the Tunnel IP address and corresponding subnet mask.
. . Enter the Remote IP address of remote GRE tunnel gateway. Normally this is the
Remote IP A Must fill setting

public IP address of the remote GRE gateway.

1. A Must filled setting
MTU 2. Auto (value zero or
blank) is set by default

MTU refers to Maximum Transmission Unit. It specifies the largest packet size
permitted for Internet transmission.

When set to Auto (value ‘0’ or blank), the router selects the best MTU for best
Internet connection performance.
Value Range: 0 ~ 1500.

Key An Optional setting

Enter the Key for the GRE connection.
Value Range: 0 ~ 9999999999.

1. A Must fill setting
2.1to 255 range

TTL

Specify TTL hop-count value for this GRE tunnel.
Value Range: 1 ~ 255.

Remote Subnet A Must fill setting

Specify the remote subnet for this GRE tunnel.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of GRE server peer. So, at GRE client peer, the packets
whose destination is in the dedicated subnet will be transferred via the GRE
tunnel. Others will be transferred based on current routing policy of the security
gateway at GRE client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the GRE client peer, all packets, including the
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Internet accessing of GRE client peer, will go through the established GRE
tunnel. That means the remote GRE server peer controls the flow of any packets
from the GRE client peer. Certainly, those packets come through the GRE

tunnel.
Tunnel Unchecked by default ~ Check Enable box to enable this GRE tunnel.
Save N/A Click Save button to save the settings.
Undo N/A Click X button to cancel the settings and back to last page.
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5.2 Firewall

Internet
SeSSIONS | e e e e o
M2M-loT <J¥—— Allow/ Specific destination port TCP/UDP
Gateway =,.|"" Deny Specific Destination IP Address
Packet Filter
(( )) 1 Allow/ Specific key word of URL
P e . .
1 Deny Specific Domain Name
URL Blocking

__________________________
——— Allow / Deny Specific MAC Address

Application Filter
TSI TTT T IIo oSS m-——————- Applicati
T=3=,! Block Lotsof TCP/UDP/ICMP e
| attack packets
1PS Local

Access & Control

The firewall functions include Packet Filter, URL Blocking, Content Filter, MAC Control, Application Filter, IPS
and some firewall options. The supported function can be different for the purchased gateway.

5.2.1 Packet Filter

Item Setting
¥ Packet Filters ¥ Enahle
» Black List # White List Deny those match the following rules. »
» Log Alert Log Alert
= | Add || Delete |
Rule From To Destination = Source Source Destination Time .
D' Name |Interface Interface  >ourcelP IP mac | Protocol Tpon Port  Schedule ENaPle Actions

"Packet Filter" function can let you define some filtering rules for incoming and outgoing packets. So the
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gateway can control what packets are allowed or blocked to pass through it. A packet filter rule should
indicate from and to which interface the packet enters and leaves the gateway, the source and destination IP
addresses, and destination service port type and port number. In addition, the time schedule to which the rule

will be active.

Packet Filter with White List Scenario

Denied to pass for non-http packets.
{packets not dest. to TCP port 80 / 443)

X._ — _/f_lc:ess “ftp://ftp.abc.com/pub/”

B f

\
Allowed to Pass *~._ %
User Group 192.168.123.2007250

(packets with TCP Por-t.s'ﬂ'f%}-.-__
Access “http://www.abc.com/”

Rule Name : Allow HTTP_HTTPS | Destination IP : Any

From Interface : Any Destination Port :

To Interface : Any HTTP (TCP:80) for Rule-1,

Source IP: 192.168.123.200 ~ HTTPs (TCP:443) for Rule-2
192.168.123.250 Protocol : TCP

Black List / White List: Allow those
match the following rules

Packet Filter Setting

As shown in the diagram, specify "Packet Filter Rule
List" as white list (Allow those match the following
rules) and define the rules. Rule-1 is to allow HTTP
packets to pass, and Rule-2 is to allow HTTPS packets
to pass.

Under such configuration, the gateway will allow only
HTTP and HTTPS packets, issued from the IP range
192.168.123.200 to 250, which are targeted to TCP
port 80 or 443 to pass the WAN interface.

Go to Security > Firewall > Packet Filter Tab.

The packet filter setting allows user to create and customize packet filter policies to allow or reject specific
inbound/outbound packets through the router based on their office setting.

Enable Packet Filter

Item

» Packet Filters Enahle

» Black List / White List

b I_Dg Alert LDg Alert

The box is unchecked by
default

Packet Filter

Black List /

White List Deny those match the

Setting

Deny those match the following rules. v

Check the Enable box to activate Packet Filter function

When Deny those match the following rules is selected, as the name suggest,
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following rules is set by packets specified in the rules will be blocked —black listed. In contrast, with
default Allow those match the following rules, you can specifically white list the
packets to pass and the rest will be blocked.

The box is unchecked by

Log Alert Check the Enable box to activate Event Log.
default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Create/Edit Packet Filter Rules

The gateway allows you to customize your packet filtering rules. It supports up to a maximum of 20 filter rule
sets.

= Packet Filter List Rl [FEECH

Source IP

Destination Source |Destination

IP

Protocol Enable Actions

Schedule

When Add button is applied, Packet Filter Rule Configuration screen will appear.

#1 Packet Filter Rule Configuration

Item Setting
¥ Rule MName |RU|€1 |
» From Interface Any ¥
» Tolnterface Any T
» Source IP | Any ¥ |
» Destination 1P | Any ¥ |
» Saource MAC | Ay v |
» Protocal Any(0) v
» Source Part User-defined Service v || . |
» Destination Port User-defined Senvice v | | - |
» Time Schedule (0) Atwiays v
» Rule [ ] Enahle
Packet Filter Rule Configuration
Item Name Value setting Description
1. String format can be . .
Enter a packet filter rule name. Enter a name that is easy for you to remember.
Rule Name any text
. . Value Range: 1 ~ 30 characters.
2. A Must filled setting
From Interface 1. A Must filled setting Define the selected interface to be the packet-entering interface of the router.
2. By default Any is If the packets to be filtered are coming from LAN to WAN then select LAN for
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To Interface

Source IP

Destination IP

Source MAC

Protocol

selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any(0) is
selected

this field. Or VLAN-1 to WAN then select VLAN-1 for this field. Other examples
are VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets coming into the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

Define the selected interface to be the packet-leaving interface of the router. If
the packets to be filtered are entering from LAN to WAN then select WAN for
this field. Or VLAN-1 to WAN then select WAN for this field. Other examples are
VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets leaving the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

This field is to specify the Source IP address.

Select Any to filter packets coming from any IP addresses.

Select Specific IP Address to filter packets coming from an IP address.

Select IP Range to filter packets coming from a specified range of IP address.
Select IP Address-based Group to filter packets coming from a pre-defined
group. Note: group must be pre-defined before this option become available.
Refer to Object Definition > Grouping > Host grouping. You may also access to
create a group by the Add Rule shortcut button.

This field is to specify the Destination IP address.

Select Any to filter packets that are entering to any IP addresses.

Select Specific IP Address to filter packets entering to an IP address entered in
this field.

Select IP Range to filter packets entering to a specified range of IP address
entered in this field.

Select IP Address-based Group to filter packets entering to a pre-defined group
selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button. Setting done through
the Add Rule button will also appear in the Host grouping setting screen.

This field is to specify the Source MAC address.

Select Any to filter packets coming from any MAC addresses.

Select Specific MAC Address to filter packets coming from a MAC address.
Select MAC Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button.

For Protocol, select Any to filter any protocol packets

Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.

Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.

Value Range: 1 ~ 65535 for Source Port, Destination Port.
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For Protocol, select ICMPv4 to filter ICMPv4 packets
For Protocol, select TCP to filter TCP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select UDP to filter UDP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select GRE to filter GRE packets
For Protocol, select ESP to filter ESP packets
For Protocol, select SCTP to filter SCTP packets
For Protocol, select User-defined to filter packets with specified port number.
Then enter a pot number in Protocol Number box.
Apply Time Schedule to this rule, otherwise leave it as Always.

Time Schedule A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to
Object Definition > Scheduling > Configuration tab.

The box is unchecked by

Rule Click Enable box to activate this rule then save the settings.
default.

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Back N/A When the Back button is clicked the screen will return to the Packet Filter
Configuration page.
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5.2.2 URL Blocking (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.3 MAC Control

Item

» WA Control ¥ Enahle

» Black List/ White List

» Log Alert Enable

» Known MAC from LAN PC List v || Copyto
Add Delete

1D Rule Name MAC Address

Setting

Deny MAC Address Below. »

Time Schedule Rule Enable Actions

"MAC Control" function allows you to assign the accessibility to the gateway for different users based on
device’s MAC address. When the administrator wants to reject the traffics from some client hosts with specific
MAC addresses, he can use the "MAC Control” function to reject with the black list configuration.

MAC Control with Black List Scenario

MACAddress : “20:6A:6A:6A:6A:6B”
Denied to access Internet.

WAN
\ Gateway
ol

MAC Address : “00:50:18:99:99:011
Allowed to access Internet, I

j=2udayi3

Staff

Rule Name : Deny_JP
MAC Address : 20:6A:6A:6A:6A:6B

Black List / White List:
Deny MAC Address Below.

20:6A:6A:6A:6A:6B

00:50:18:99:99:01

As shown in the diagram, enable the MAC control
function and specify the "MAC Control Rule List" is
a black list, and configure one MAC control rule for
the gateway to deny the connection request from
the "JP NB" with its own MAC address
20:6A:6A:6A:6A:6B.

System will block the connecting from the "JP NB"
to the gateway but allow others.
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MAC Control Setting

Go to Security > Firewall > MAC Control Tab.

The MAC control setting allows user to create and customize MAC address policies to allow or reject packets
with specific source MAC address.

Enable MAC Control

® Configuration ' ®

Item Setting
» MAC Control [} Enahle
» Black List / White List | Deny MAC Address Below. v
¥ Log Alert Enable
¥ Known MAC from LAN PC List \ZI

Configuration Window

Item Value setting Description

The box is unchecked by

MAC Control default Check the Enable box to activate the MAC filter function

When Deny MAC Address Below is selected, as the name suggest, packets
Black List / Deny MAC Address Below  specified in the rules will be blocked —black listed. In contrast, with Allow MAC
White List is set by default Address Below, you can specifically white list the packets to pass and the rest

will be blocked.

The box is unchecked by

Log Alert default Check the Enable box to activate to activate Event Log.
efau
Known MAC N/A Select a MAC Address from LAN Client List. Click the Copy to to copy the
from LAN PC List selected MAC Address to the filter rule.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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Create/Edit MAC Control Rules

The gateway supports up to a maximum of 20 filter rule sets. Ensure that the MAC Control is enabled before
we can create control rules.

= MAC Control Rule List " "

MAC Address

Rule Name Time Schedule Rule Enable Actions

When Add button is applied, Filter Rule Configuration screen will appear.

% MAC Control Rule Configuration ®

Rule Name MAC Address (Use : to Compose) Time Schedule | Enable

Rule1 | || || [(0)Aways v | | [

MAC Control Rule Configuration
Item Value setting Description

1. String format can be any

Rule Name text Enter a MAC Control rule name. Enter a name that is easy for you to remember.
2. A Must fill setting

MAC Address 1. MAC Address string

(Use: to Format Specify the Source MAC Address to filter rule.

Compose) 2. A Must fill setting

Apply Time Schedule to this rule; otherwise leave it as (0) Always.
Time Schedule A Must fill setting If the dropdown list is empty, ensure Time Schedule is pre-configured. Refer to
Object Definition > Scheduling > Configuration tab

The box is unchecked by

Enable default Click Enable box to activate this rule, and then save the settings.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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5.2.4 Content Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.5 Application Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.6 IPS

[tem
v IPS Enable
» Log Alert Enable

[tem
» 5YN Flood Defense Enable (300
» UDP Flood Defense Enable (300
» ICMF Flood Defense Enable |300

Enable [200

Port Scan Defense

Setting

Setting
Packets/zecond (10~10000)
Packets/second (10~10000)
Packets/second (10~10000)

Fackets/second (10-~10000)

To provide application servers in the Internet, administrator may need to open specific ports for the services.
However, there are some risks to always open service ports in the Internet. In order to avoid such attack risks,

it is important to enable IPS functions.

Intrusion Prevention System (IPS) is network security appliances that monitor network and/or system
activities for malicious activity. The main functions of IPS are to identify malicious activity, log information
about this activity, attempt to block/stop it and report it. You can enable the IPS function and check the listed
intrusion activities when needed. You can also enable the log alerting so that system will record Intrusion

events when corresponding intrusions are detected.

IPS Scenario

Block lots of TCP attack packets to
Remote administration port: 8080 X Gateway
Global IP: 118.18.81.200

Local IP:192.168.1.253

Attackers Block lots of TCP attack packets to

Mail Server :SMTP 25, POP3 110
[IPS]-[Configuration]

Block lots of TCP attack packets to
Web Server : HTTP 80, HTTPS 443

| IPS: Enable |
Intrusion Prevention \

SYN Flood Defense Mail Server (port: 25,110)
Port Scan Detection Local IP: 192.168.1.2
Block IP Spoof

Block TCP Flag Scan

Wed Server (port: 80, 443)
Local IP: 192,168.1.3

As shown in the diagram, the gateway serves
as an E-mail server, Web Server and also
provides TCP port 8080 for remote
administration. So, remote users or unknown
users can request those services from Internet.
With IPS enabled, the gateway can detect
incoming attack packets, including the TCP
ports (25, 80, 110, 443 and 8080) with services.
It will block the attack packets and let the
normal access to pass through the gateway
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IPS Setting

Go to Security > Firewall > IPS Tab.

The Intrusion Prevention System (IPS) setting allows user to customize intrusion prevention rules to prevent
malicious packets.

Enable IPS Firewall

= Configuration . ®
ltem Setting

v IPS [] Enable

» Log Alert Enable

Configuration Window

Item Value setting Description

The box is unchecked b
IPS 4 Check the Enable box to activate IPS function
default
The box is unchecked b
Log Alert default Y Check the Enable box to activate to activate Event Log.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Setup Intrusion Prevention Rules

The router allows you to select intrusion prevention rules you may want to enable. Ensure that the IPS is
enabled before we can enable the defense function.
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& Intrusion Prevention

ac

ltem Setting
» SYN Flood Defense Enable Packets/second (10~10000)
» UDP Flood Defense Enable Packets/second (10~10000)
» ICMP Flood Defense Enable Packets/second (10~10000)
» Port Scan Defense Enable Packets/second (10~10000)
» Block Land Attack Enable
» Block Ping of Death Enable
» Block IP Spoof Enable
» Block TCP Flag Scan Enable
» Block Smurf Enable
b Block Traceroute Enable
¢ Block Fraggle Attack Enable
» ARP Spoofing Defense Enable Packets/second (10~10000)

Setup Intrusion Prevention Rules

Item Name Value setting Description
SYN Flood Click Enable box to activate this intrusion prevention rule and
Defense 1. A Must filled setting enter the traffic threshold in this field.
UDP Flood 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defense 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
ICMP Flood 4. The value range can be from 10 to Click Enable box to activate this intrusion prevention rule and
Defense 10000. enter the traffic threshold in this field.
Value Range: 10 ~ 10000.

1. A Must filled setting
Port Scan 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defection 3. Traffic threshold is set to 200 by default enter the traffic threshold in this field.

4. The value range can be from 10 to Value Range: 10 ~ 10000.

10000.
Block Land
Attack
Block Ping of
Death
Block IP Spoof
Block TCP Flag . . . . . .
Scan The box is unchecked by default. Click Enable box to activate this intrusion prevention rule.
Block Smurf
Block
Traceroute
Block Fraggle
Attack
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1. A Must filled setting

ARP Spoofing 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defence 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
4. The value range can be from 10 to Value Range: 10 ~ 10000.
10000.
Save NA Click Save to save the settings
Undo NA Click Undo to cancel the settings
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5.2.7 Options

= Firewall Options . x
ltem Setting

» Stealth Mode [] Enable

» SPI [] Enable

» Discard Ping from WAN [J Enable

# Remote Administrator Host Definition - 0 x

Service
ID | Interface Protocol IP Subnet Mask Enable | Action
Port

1 | AllWAN HTTP Any IP MIA 80 Edit

2 | AlIWAN HTTPS Any IP NIA 443
3 | AllWAN HTTP Any IP N/A 80 Edit

4 | AllWAN HTTP Any IP A 80 Edit

5 | AllWAN HTTP Any IP MN/A 80 Edit

There are some additional useful firewall options in this page.

“Stealth Mode” lets gateway not to respond to port scans from the WAN so that makes it less susceptible to
discovery and attacks on the Internet. “SPI1” enables gateway to record the packet information like IP address,
port address, ACK, SEQ number and so on while they pass through the gateway, and the gateway checks every
incoming packet to detect if this packet is valid.

“Discard Ping from WAN” makes any host on the WAN side can't ping this gateway. And finally, “Remote
Administrator Hosts” enables you to perform administration task from a remote host. If this feature is enabled,
only specified IP address(es) can perform remote administration.

174



4G WAN Extender

Enable SPI Scenario

Dst IP and Port Network-A
118.18.81.200: 1999 Dst IP and Port

SrcIPand Port 203.95.80.22 : 80
200.10.10.10 :80 SrcIPand Port Gateway

118.18.81.200: 1999
____________ Global IP: 118.18.81.200

_________ e = -
/ -x‘ -~
Internet
> \
DstIP and Port
118.18.81.200:1999

SrcIP and Port
203.95.80.22: 80

Unknown User
With Portscan Utility
Global IP: 200.10.10.10

Cloud Server
Global IP: 203.95.80.22

As shown in the diagram, Gateway has the I[P
address of 118.18.81.200 for WAN interface and
192.168.1.253 for LAN interface. It serves as a NAT
gateway. Users in Network-A initiate to access
cloud server through the gateway. Sometimes,
unknown users will simulate the packets but use
different source IP to masquerade. With the SPI
feature been enabled at the gateway, it will block
such packets from unknown users.

Discard Ping from WAN & Remote Administrator Hosts Scenario

Use “Ping tool” to detect if Global IP is existed,
- The gateway doesn’t reply such requests.

4-‘.‘.
-

Unknown User -

=~ Global IP: 118.18.81.200

-~

i \Lol:al IP: 192.168.1.253

. TR
§ 8B

Remote Admin. Remote Admin. can access Gateway GUI
via Browser “Http.// 118.18.81.200:8080"

Gateway

“Discard Ping from WAN” makes any host on the
WAN side can't ping this gateway reply any ICMP
packets. Enable the Discard Ping from WAN function
to prevent security leak when local users surf the
internet.

Remote administrator knows the gateway’s global IP,
and he can access the Gateway GUI via TCP port
8080.
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Firewall Options Setting

Go to Security > Firewall > Options Tab.

The firewall options setting allows network administrator to modify the behavior of the firewall and to enable
Remote Router Access Control.

Enable Firewall Options

= Firewall Options . x
[tem Setting

» Stealth Mode [CJ Enable

» SPI Enable

» Discard Ping from WAN [J Enable

Firewall Options
Item Value setting Description

The box i hecked b

Stealth Mode g ? (I)tx Is unchecked by Check the Enable box to activate the Stealth Mode function
efau

The box is checked b
SPI € boxis checked by Check the Enable box to activate the SPI function

default
Discard Ping The box is unchecked by ) ) . .
from WAN default Check the Enable box to activate the Discard Ping from WAN function

Define Remote Administrator Host

The router allows network administrator to manage router remotely. The network administrator can assign
specific IP address and service port to allow accessing the router.
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# Remote Administrator Host Definition

Service
ID | Interface Protocol IP Subnet Mask Enable | Action
Port
1 All WAN HTTP Any IP MNi& a0 [v] Edit
2 | AllWAN HTTPS Any IP MNi& 443 [v] Edit
3 | AllWAN HTTP Any IP NIA 80 O
4 | All WAN HTTP Any IP MN/& a0 ] Edit
5 | All'WAN HTTP Any IP MNi& a0 ] Edit

Remote Administrator Host Definition

Item Value setting Description

Protocol HTTP is set by default Select HTTP or HTTPS method for router access.

This field is to specify the remote host to assign access right for remote access.
Select Any IP to allow any remote hosts

IP A Must filled setting Select Specific IP to allow the remote host coming from a specific subnet. An IP
address entered in this field and a selected Subnet Mask to compose the
subnet.

1. 80 for HTTP by default o . . .
This field is to specify a Service Port to HTTP or HTTPS connection.

Service Port 2. 443 for HTTPS by
Value Range: 1 ~ 65535.

default

Enabling the The box is unchecked b
& X1 y Click Enable box to activate this rule.

rule default.
Save N/A Click Enable box to activate this rule then save the settings.
Undo N/A Click Undo to cancel the settings
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Chapter 6 Administration
6.1 Configure & Manage

M2M-loT ] k

Gateway

/1

Manage via Internet

N —! .., TRO69

Management
Server / Tools

amit Proprietary Standard

—{ & SNMP;

\ 4

Access & Control

Jomiap [e3o] ul 3Feue |y

|
|
|
|
Management | S
e Server [ Tools i @'
v

Local Access & Control

Configure & Manage refers to enterprise-wide administration of distributed systems including (and commonly
in practice) computer systems. Centralized management has a time and effort trade-off that is related to the
size of the company, the expertise of the IT staff, and the amount of technology being used. This device
supports many system management protocols, such as Command Script, TR-069, SNMP, and Telnet with CLI.
You can setup those configurations in the "Configure & Manage" section.
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6.1.1 Command Script

Command script configuration is the application that allows administrator to setup the pre-defined
configuration in plain text style and apply configuration on startup.

Go to Administration > Command Script > Configuration Tab.

Enable Command Script Configuration

Item Setting
» Command Script Enable
» Backup Script Via Web UI
» Upload Script Via Web UI
» Script Name
» Version
¥ Description

e

» Update time 2019-04-08T18:05:31

The box is unchecked by

Command Script
default

Check the Enable box to activate the Command Script function.

. Click the Via Web Ul or Via Storage button to backup the existed command
Backup Script N/A

script in a .txt file. You can specify the script file name in Script Name below.
. Click the Via Web Ul or Via Storage button to Upload the existed command
Upload Script N/A
script from a specified .txt file.

Specify a script file name for script backup, or display the selected upload script
1.An Optional setting

Script Name O file name.

2.Any valid file name
Value Range: 0 ~ 32 characters.

Version 1.An Optional setting Specify the version number for the applied Command script.

2.Any string Value Range: 0 ~ 32 characters.
L. 1.An Optional setting _— . .

Description ) Enter a short description for the applied Command script.
2.Any string

Update time N/A It records the upload time for last commad script upload.
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Edit/Backup Plain Text Command Script

* Command Script Editor

0765280

You can edit the plain text configuration settings in the configuration screen as above.

Plain Text Configuration
Item Value setting Description

Clean NA Clean text area. (You should click Save button to further clean the configuration
already saved in the system.)

Backup NA Backup and download configuration.

Save NA Save configuration

The supported plain text configuration items are shown in the following list. For the settings that can be
executed with standard Linux commands, you can put them in a script file, and apply to the system configure
with STARTUP command. For those configurations without corresponding Linux command set to configure,
you can configure them with proprietary command set.

Configuration Content

Key Value setting Description

OPENVPN_ENABLED 1:enable Enable or disable OpenVPN Client function.
0 : disable

OPENVPN_DESCRIPTION A Must filled Specify the tunnel name for the OpenVPN Client connection.
Setting

OPENVPN_PROTO udp Define the Protocol for the OpenVPN Client.
tcp e Select TCP or TCP /UDP

->The OpenVPN will use TCP protocol, and Port will be set as 443
automatically.

e Select UDP

->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.

OPENVPN_PORT A Must filled Specify the Port for the OpenVPN Client to use.
Setting
OPENVPN_REMOTE_IPADDR IP or FQDN Specify the Remote IP/FQDN of the peer OpenVPN Server for this

OpenVPN Client tunnel.
Fill in the IP address or FQDN.
OPENVPN_PING_INTVL seconds Specify the time interval for OpenVPN keep-alive checking.
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OPENVPN_PING_TOUT
OPENVPN_COMP
OPENVPN_AUTH

OPENVPN_CA_CERT
OPENVPN_LOCAL_CERT
OPENVPN_LOCAL_KEY
OPENVPN_EXTRA_OPTS
IP_ADDR1

IP_NETM1
PPP_MONITORING

PPP_PING
PPP_PING_IPADDR

PPP_PING_INTVL

STARTUP

seconds
Adaptive
Static Key/TLS

A Must filled
Setting

A Must filled
Setting

A Must filled
Setting
Options

Ip

Net mask

1: enable

0 : disable

0 : DNS Query
1:ICMP Query

IP
seconds

Script file

Specify the timeout value for OpenVPN Client keep-alive checking.
Specify the LZO Compression algorithm for OpenVPN client.

Specify the authorization mode for the OpenVPN tunnel.

e TLS

->The OpenVPN will use TLS authorization mode, and the following
items CA Cert., Client Cert. and Client Key need to specify as well.
Specify the Trusted CA certificate for the OpenVPN client. It will go
through Base64 Conversion.

Specify the local certificate for OpenVPN client. It will go through
Base64 Conversion.

Specify the local key for the OpenVPN client. It will go through Base64
Conversion.

Specify the extra options setting for the OpenVPN client.

Ethernet LAN IP

Ethernet LAN MASK

When the Network Monitoring feature is enabled, the router will use
DNS Query or ICMP to periodically check Internet connection —
connected or disconnected.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in PPP_PING_IPADDR.
With ICMP Query, the system will check connection by sending ICMP
request packets to the destination specified in PPP_PING_IPADDR.
Specify an IP address as the target for sending DNS query/ICMP
request.

Specify the time interval for between two DNS Query or ICMP
checking packets.

For the configurations that can be configured with standard Linux
commands, you can put them in a script file, and apply the script file
with STARTUP command.

For example,

STARTUP=#!/bin/sh

STARTUP=echo “startup done” > /tmp/demo

Plain Text System Configuration with Telnet

In addition to the web-style plain text configuration as mentioned above, the gateway system also allow the
configuration via Telnet CLI. Administrator can use the proprietary telnet command “txtConfig” and related
action items to perform the plain system configuration.

The command format is: txtConfig (action) [option]

clone Output file

Duplicate the configuration content from database and stored as a
configuration file.

(ex: txtConfig clone /tmp/config)

The contents in the configuration file are the same as the plain text commands
mentioned above. This action is exactly the same as performing the “Backup”
plain text configuration.
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commit

enable

disable
run_immediately

run_immediately

a existing file
NA
NA
NA

a existing file

Commit the configuration content to database.

(ex: txtConfig commit /tmp/config)

Enable plain text system config.

(ex: txtConfig enable)

Disable plain text system config.

(ex: txtConfig disable)

Apply the configuration content that has been committed in database.
(ex: txtConfig run_immediately)

Assign a configuration file to apply.

(ex: txtConfig run_immediately /tmp/config)
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6.1.2 TR-069

TR-069 (Technical Report 069) is a Broadband Forum technical specification entitled CPE WAN Management
Protocol (CWMP). It defines an application layer protocol for remote management of end-user devices, like this
gateway device. As a bidirectional SOAP/HTTP-based protocol, it provides the communication between
customer-premises equipment (CPE) and Auto Configuration Servers (ACS). The Security Gateway is such CPE.

TR-069 is a customized feature for ISP. It is not recommend that you change the configuration for this. If you
have any problem in using this feature for device management, please contact with your ISP or the ACS
provider for help. At the right upper corner of TR-069 Setting screen, one “[Help]” command let you see the
same message about that.

Scenario - Managing deployed gateways through an ACS Server

Gatewayn
Gateway 2
/ ’
S
L Gateway 1
-\% \‘_ e ———— v
Global IP:
ACS 118.18.81.33
Server

Scenario Application Timing

When the enterprise data center wants to use an ACS server to manage remote gateways
geographically distributed elsewhere in the world, the gateways in all branch offices must have an
embedded TR-069 agent to communicate with the ACS server. So that the ACS server can configure,
FW upgrade and monitor these gateways and their corresponding Intranets.

Scenario Description

The ACS server can configure, upgrade with latest FW and monitor these gateways.
Remote gateways inquire the ACS server for jobs to do in each time period.

The ACS server can ask the gateways to execute some urgent jobs.

Parameter Setup Example
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Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "TR-069" enabling.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path [TR-069]-[Configuration]
TR-069 m Enable

ACS URL http://qa.acslite.com/cpe.php
ACS User Name ACSUserName

ACS Password ACSPassword
ConnectionRequest Port 8099

ConnectionRequest User Name ConnReqUserName
ConnectionRequest Password ConnReqPassword

Inform m Enable Interval 900

Scenario Operation Procedure

In above diagram, the ACS server can manage multiple gateways in the Internet. The "Gateway 1" is
one of them and has 118.18.81.33 IP address for its WAN-1 interface.

When all remote gateways have booted up, they will try to connect to the ACS server.

Once the connections are established successfully, the ACS server can configure, upgrade with latest
FW and monitor these gateways.

Remote gateways inquire the ACS server for jobs to do in each time period.

If the ACS server needs some urgent jobs to be done by the gateways, it will issue the "Connection
Request" command to those gateways. And those gateways make immediate connections in response
to the ACS server’s immediate connection request for executing the urgent jobs.
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TR-069 Setting

Go to Administration > Configure & Manage > TR-069 tab.

In "TR-069" page, there is only one configuration window for TR-069 function. In the window, you must
specify the related information for your security gateway to connect to the ACS. Drive the function to work by
specifying the URL of the ACS server, the account information to login the ACS server, the service port and the
account information for connection requesting from the ACS server, and the time interval for job inquiry.
Except the inquiry time, there are no activities between the ACS server and the gateways until the next inquiry
cycle. But if the ACS server has new jobs that are expected to do by the gateways urgently, it will ask these
gateways by using connection request related information for immediate connection for inquiring jobs and
executing.

Enable TR-069

= Configuration . %
Item Setting

» TR-059 Enable

¥ Interface

» Data model | ACS Cloud Data Model |

» ACS URL |

P ACS UserName | |

b ACS Password | |

b Connection Request Port 8099

¥ Connection Request UserName | |

¥ Connection Request Password | |

v Inform 4| Enable Interval

o default

Select from Certificate List

Certificate:

b Certification Setup

Item Value setting Description

The box is unchecked by . .
TR-069 default Check the Enable box to activate TR-069 function.
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Interface

Data Model

ACS URL
ACS Username
ACS Password

ConnectionRequest
Port

ConnectionRequest
UserName

ConnectionRequest
Password

Inform

Certification Setup

Save
Undo

WAN-1 is selected by
default.

ACS Cloud Data Model
is selected by default.

A Must filled setting
A Must filled setting
A Must filled setting

1. A Must filled setting.

2. By default 8099 is set.

A Must filled setting

A Must filled setting

1. The box is checked by

default.
2. The Interval value is
300 by default.

The default box is
selected by default

N/A
N/A

When you finish set basic network WAN-1 ~ WAN-n, you can choose WAN-1 ~
WAN-n

When you finish set Security > VPN > IPSec/OpenVPN/PPTP/L2TP/GRE, you
can choose IPSec/OpenVPN/PPTP/L2TP/GRE tunnel, the interface just like
“IPSec #1”

Select the TR-069 dat model for the remote management.

Standard : the ACS Server is a standard one, which is fully comply with TR-
069.

ACS Cloud Data Model : Select this data model if you intend to use Cloud ACS
Server to managing the deployed gateways.

You can ask ACS manager provide ACS URL and manually set

You can ask ACS manager provide ACS username and manually set

You can ask ACS manager provide ACS password and manually set

You can ask ACS manager provide ACS ConnectionRequest Port and manually
set

Value Range: 0 ~ 65535.

You can ask ACS manager provide ACS ConnectionRequest Username and
manually set

You can ask ACS manager provide ACS ConnectionRequest Password and
manually set

When the Enable box is checked, the gateway (CPE) will periodicly send
inform message to ACS Server according to the Interval setting.
Value Range: 0 ~ 86400 for Inform Interval.

You can leave it as default or select an expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Click Save to save the settings.

Click Undo to cancel the modifications.

When you finish set ACS URL ACS Username ACS Password, your gateway (CPE, Client Premium Equipment)
can send inform to ACS Server.
When you finish set ConnectionRequest Port ConnectionRequest Username ConnectionRequest Password,
ACS Server can ask the gateway (CPE) to send inform to ACS Server.

Enable STUN Server
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= STUN Settings n %

Item Setting
¥ STUN + Enable
b Server Address | |
¥ Server Port {1~65535)
b Keep Alive Period D {0~B65535)second(s)

STUN Settings Configuration

Item ‘ Value setting Description

The box is checked by

STUN Check the Enable box to activate STUN function.
default

1. String format: any

Server Address IPva address Specify the IP address for the expected STUN Server.

2. Itis an optional item.

. . Specify the port number for the expected STUN Server.
1. An optional setting

2.3478 is set by default

Server Port
Value Range: 1 ~ 65535.
Specify the keep alive time period for the connection with STUN Server.

1. An optional setting

Keep Alive Period )
2.0 is set by default
Value Range: 0 ~ 65535.
Save N/A Click Save to save the settings.
Undo N/A Click Undo to cancel the modifications.
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6.1.3 SNMP

In brief, SNMP, the Simple Network Management Protocol, is a protocol designed to give a user the capability
to remotely manage a computer network by polling and setting terminal values and monitoring network
events.

In typical SNMP uses, one or more administrative computers, called managers, have the task of monitoring or
managing a group of hosts or devices on a computer network. Each managed system executes, at all times, a
software component called an agent which reports information via SNMP to the manager.

SNMP agents expose management data on the managed systems as variables. The protocol also permits active
management tasks, such as modifying and applying a new configuration through remote modification of these
variables. The variables accessible via SNMP are organized in hierarchies. These hierarchies, and other
metadata (such as type and description of the variable), are described by Management Information Bases
(MIBs).

The device supports several public MIBs and one private MIB for the SNMP agent. The supported MIBs are as
follow: MIB-II (RFC 1213, Include IPv6), IF-MIB, IP-MIB, TCP-MIB, UDP-MIB, SMIvl and SMIv2,
SNMPvV2-TM and SNMPv2-MIB, and AMIB (a Proprietary MIB)

SNMP Management Scenario

&3

Remote NMS
118.18.81.22

&3

Remote NMS
118.18.81.11

Gatewayn

Gateway 2

Gateway 1l

LAN IP:10.0.75.2
et: 10.0.75.0/24

o

10.0.75.100

Intranet

Scenario Application Timing

There are two application scenarios of SNMP Network Management Systems (NMS). Local NMS is in
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the Intranet and manage all devices that support SNMP protocol in the Intranet. Another one is the
Remote NMS to manage some devices whose WAN interfaces are connected together by using a
switch or a router with UDP forwarding. If you want to manage some devices and they all have
supported SNMP protocol, use either one application scenario, especially the management of devices
in the Intranet. In managing devices in the Internet, the TR-069 is the better solution. Please refer to
last sub-section.

Scenario Description

The NMS server can monitor and configure the managed devices by using SNMP protocol, and those
devices are located at where UDP packets can reach from NMS.

The managed devices report urgent trap events to the NMS servers.
Use SNMPv3 version of protocol can protected the transmitting of SNMP commands and responses.
The remote NMS with privilege IP address can manage the devices, but other remote NMS can't.

Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "SNMP" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[SNMP]-[Configuration]

SNMP Enable

m LAN m WAN

Supported Versions

mvl mv2c mv3

Get / Set Community

ReadCommunity / WriteCommunity

Trap Event Receiver 1 118.18.81.11

WAN Access IP Address 118.18.81.11

Configuration Path [SNMP]-[User Privacy Definition]

ID 1 2 3

User Name UserNamel UserName2 UserName3
Password Password1 Password2 Disable
Authentication MD5 SHA-1 Disable
Encryption DES Disable Disable
Privacy Mode authPriv authNoPriv noAuthNoPriv
Privacy Key 12345678 Disable Disable
Authority Read/Write Read Read
Enable m Enable m Enable m Enable

Scenario Operation Procedure

In above diagram, the NMS server can manage multiple devices in the Intranet or a UDP-reachable
network. The "Gateway 1" is one of the managed devices, and it has the IP address of 10.0.75.2 for
LAN interface and 118.18.81.33 for WAN-1 interface. It serves as a NAT router.
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At first stage, the NMS manager prepares related information for all managed devices and records
them in the NMS system. Then NMS system gets the status of all managed devices by using SNMP get
commands.

When the manager wants to configure the managed devices, the NMS system allows him to do that by
using SNMP set commands. The "UserNamel" account is used if the manager uses SNMPv3 protocol
for configuring the "Gateway 1". Only the "UserNamel" account can let the "Gateway 1" accept the
configuration from the NMS since the authority of the account is "Read/Write".

Once a managed device has an urgent event to send, the device will issue a trap to the Trap Event
Receivers. The NMS itself could be one among them.

If you want to secure the transmitted SNMP commands and responses between the NMS and the
managed devices, use SNMPv3 version of protocol.

The remote NMS without privilege IP address can't manage the "Gateway 1", since "Gateway 1" allows
only the NMS with privilege IP address can manage it via its WAN interface.
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SNMP Setting

Go to Administration > Configure & Manage > SNMP tab.

The SNMP allows user to configure SNMP relevant setting which includes interface, version, access control
and trap receiver.

Enable SNMP
= Configuration . %
ltem Setting

¥ SNMP Enable [ LAN [ WAN

» WAN Interface All' WANs v

» Supported Versions ¥ viw v2e D v3

» SNMP Port
'IP Range v
| | - | | [ Enable
| | - | | [ Enable

¥ Limited Remote Access P | | ) | |  Enable
| | - | | ] Enable
| | - | | [] Enable

SNMP

Item Value setting Descri

Select the interface for the SNMP and enable SNMP functions.
When Check the LAN box, it will activate SNMP functions and you can access
SNMP Enable SNMP from LAN side;

1.The boxes are

unchecked by default
4 When Check the WAN box, it will activate SNMP functions and you can access

SNMP from WAN side.
1.A Must filled setting ~ Specify the WAN interface that a remote SNMP host can access to the device.

WAN Interface 2. ALL WANSs is By default, All WANS is selected, and there is no limitation for the WAN
selected by default inferface.

Select the version for the SNMP
When Check the v1 box.
1.A Must filled setting It means you can access SNMP by version 1.
Supported Versions  2.The boxes are When Check the v2c box.
unchecked by default It means you can access SNMP by version 2c.
When Check the v3 box.
It means you can access SNMP by version 3.
SNMP Port 1. String format: any Specify the SNMP Port.
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Limited Remote
Aceess IP

Save
Undo

port number

2. The default SNMP
portis 161.

3. A Must filled setting

1. String format: any
IPv4 address

2. It is an optional
item.

N/A
N/A

Create/Edit Multiple Community

You can fill in any port number. But you must ensure the port number is not to
be used.
Value Range: 1 ~ 65535.

Specify the Remote Access IP for WAN and check the box to enable it as well.
Select Specific IP Address, and fill in a certain IP address. It means only this IP
address can access SNMP from LAN/WAN side.

Select IP Range, and fill in a range of IP addresses. It means the IP address
within specified range can access SNMP from LAN/WAN side.

If you left it as blank, it means any IP address can access SNMP from WAN side.
Click Save to save the settings
Click Undo to cancel the settings

The SNMP allows you to custom your access control for version 1 and version 2 user. The router supports up to
a maximum of 10 community sets.

Add Delete

Community

Enable Actions

When Add button is applied, Multiple Community Rule Configuration screen will appear.

» Community

» Enable

Community

Enable

Save

Undo

Setting

Read Only -

#| Enable

1. Read Only is
selected by default

2. A Must filled setting
3. String format: any
text

1.The box is checked
by default

N/A

N/A

Specify this version 1 or version v2c user’s community that will be allowed Read
Only (GET and GETNEXT) or Read-Write (GET, GETNEXT and SET) access
respectively.

The maximum length of the community is 32.

Click Enable to enable this version 1 or version v2c user.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Click the Undo button to cancel the settings.
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Back N/A Click the Back button to return to last page.

Create/Edit User Privacy

The SNMP allows you to custom your access control for version 3 user. The router supports up to a maximum
of 128 User Privacy sets.

= User Privacy List [[oeh

Password | Authentication | Encryption

OID Filter
Prefix

Privacy
Key

Authority Enable | Actions

When Add button is applied, User Privacy Rule Configuration screen will appear.

® User Privacy Rule Configuration

ltem Setting

¥ User Mame

v Password

v Authentication Mone v

» Encryption Mone v

¥ Privacy Mode noAuthMNoPriv v

¥ Privacy Key

» Authority Read v

=

» OID Filter Prefix

Y
m
=
=
o
o

¥ Enable 4

User Privacy Rule Configuration
Item Value setting Description

User Name 1. A Must filled setting  Specify the User Name for this version 3 user.
2. String format: any Value Range: 1 ~ 32 characters.
text
Password 1. String format: any When your Privacy Mode is authNoPriv or authPriv, you must specify the
text Password for this version 3 user.
Value Range: 8 ~ 64 characters.
Authentication 1. None is selected by ~ When your Privacy Mode is authNoPriv or authPriv, you must specify the
default Authentication types for this version 3 user.
Selected the authentication types MD5/ SHA-1 to use.
Encryption 1. None is selected by =~ When your Privacy Mode is authPriv, you must specify the Encryption
default protocols for this version 3 user.
Selected the encryption protocols DES / AES to use.
Privacy Mode 1. noAuthNoPriv is Specify the Privacy Mode for this version 3 user.
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selected by default

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

Privacy Key 1. String format: any When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64
text characters) for this version 3 user.
Authority 1. Read is selected by Specify this version 3 user’s Authority that will be allowed Read Only (GET and

OID Filter Prefix

default

1. The default value is
1

2. A Must filled setting
3. String format: any

GETNEXT) or Read-Write (GET, GETNEXT and SET) access respectively.
The OID Filter Prefix restricts access for this version 3 user to the sub-tree
rooted at the given OID.

Value Range: 1 ~2080768.

legal OID
Enable 1.The box is checked Click Enable to enable this version 3 user.
by default
Save N/A Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Undo N/A Click the Undo button to cancel the settings
Back N/A Click the X button to return the last page.

Create/Edit Trap Event Receiver

The SNMP allows you to custom your trap event receiver. The router supports up to a maximum of 4 Trap
Event Receiver sets.

- Add Delete
ID Seer\.rer Sg‘l;«r?r U‘?erjsh;‘ci Cew;nn:';iw hl.l-lasrﬁ; Password Pﬂ;g? Authentication | Encryption F‘r&n;cy Enable Actions

When Add button is applied, Trap Event Receiver Rule Configuration screen will appear. The default SNMP
Version is v1. The configuration screen will provide the version 1 must filled items.
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= Trap Event Receiver Rule Configuration

ltem Setting
b Server IP | | (IP Address/FQDMN)
¥ Server Port 1162
¥ SNMP Version A
¥ Community Name | |
» Enable Enable

When you selected v2c, the configuration screen is exactly the same as that of v1, except the version.

When you selected v3, the configuration screen will provide more setting items for the version 3 Trap.

# Trap Event Receiver Rule Configuration

ltem Setting
» Server [P | | (IP Address/FQDN)
¥ Server Port 162
» SNMP Version v3 v

¥ Community Name

b User Name

¥ Password

¥ Privacy Mode

' noAuthNoPriv v |

r Authentication

Mone -

¥ Encryption

¥ Privacy Key

r Enable

Enable

Item Value setting

Trap Event Receiver Rule Configuration

Description

1. A Must filled setting
2. String format: any
IPv4 address or FQDN

Server IP

Specify the trap Server IP or FQDN.
The DUT will send trap to the server IP/FQDN.

1. String format: any
port number

2. The default SNMP
trap portis 162

3. A Must filled setting

Server Port

Specify the trap Server Port.

You can fill in any port number. But you must ensure the port number is not to
be used.

Value Range: 1 ~ 65535.

1. vl is selected by
default

SNMP Version

Select the version for the trap
Selected the v1.
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Community Name

User Name

Password

Privacy Mode

Authentication

Encryption

Privacy Key

Enable

Save

Undo
Back

1. Avl and v2c Must
filled setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. noAuthNoPriv is
selected by default

1. Av3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. String format: any
text

1.The box is checked
by default

N/A

N/A
N/A

Specify SNMP MIB-2 System

The configuration screen will provide the version 1 must filled items.
Selected the v2c.

The configuration screen will provide the version 2c must filled items.
Selected the v3.

The configuration screen will provide the version 3 must filled items.

Specify the Community Name for this version 1 or version v2c trap.
Value Range: 1 ~ 32 characters.

Specify the User Name for this version 3 trap.
Value Range: 1 ~ 32 characters.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Password for this version 3 trap.
Value Range: 8 ~ 64 characters.

Specify the Privacy Mode for this version 3 trap.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Authentication types for this version 3 trap.
Selected the authentication types MD5/ SHA-1 to use.

When your Privacy Mode is authPriv, you must specify the Encryption
protocols for this version 3 trap.
Selected the encryption protocols DES / AES to use.

When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64
characters) for this version 3 trap.

Click Enable to enable this trap receiver.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Click the Undo button to cancel the settings.

Click the X button to return to last page.
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If required, you can also specify the required onformation the the MIB-2 System.

« SNMP MIB-2 System a %

Item Setting

b sysContact | |

» sysLocation | |

SNMP MIB-2 System Configuration

Item Value setting Description

sysContact 1. An Optional filled Specify the contact information forMIB-2 system.
setting Value Range: 0 ~ 64 characters.
2. String format: any
text

sysLocation 1. An Optional filled Specify the location information forMIB-2 system.
setting Value Range: 0 ~ 64 characters.
2. String format: any
text

Edit SNMP Options

If you use some particular private MIB, you must fill the enterprise name, number and OID.

= Options a *®
Item Setting
r Enterprise Name Default
¥ Enterprise Number |1 2823 |
» Enterprise OID 136141 |'12823.4.4.9 |
\ Options \
\ Item Value setting Description \
1. The default value is
Default ) . . .
. . . Specify the Enterprise Name for the particular private MIB.
Enterprise Name 2. A Must filled setting

. Value Range: 1 ~ 10 characters, and only string with A~Z, a~z, 0~9, '/, “_".
3. String format: any

text

The default value is

12823
Enterprise Number (Default Enterprise Specify the Enterprise Number for the particular private MIB.
Number) Value Range: 1 ~2080768.

2. A Must filled setting
3. String format: any
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Enterprise OID

Save

Undo

number

1. The default value is
1.3.6.1.4.1.12823.4.4.9
(Default Enterprise OID)
2. A Must filled setting
3. String format: any
legal OID

N/A

N/A

Specify the Enterprise OID for the particular private MIB.

The range of the each OID number is 1-2080768.

The maximum length of the enterprise OID is 31.

The seventh number must be identical with the enterprise number.

Click the Save button to save the configuration and apply your changes to
SNMP functions.
Click the Undo button to cancel the settings.

198



4G WAN Extender

6.1.4 Telnet & SSH

A command-line interface (CLI), also known as command-line user interface, and console user interface are
means of interacting with a computer program where the user (or client) issues commands to the program in
the form of successive lines of text (command lines). The interface is usually implemented with a command
line shell, which is a program that accepts commands as text input and converts commands to appropriate
operating system functions. Programs with command-line interfaces are generally easier to automate via
scripting. The device supports both Telnet and SSH (Secure Shell) CLI with default service port 23 and 22,
respectively.

Telnet & SSH Scenario

Network-A

Gateway

&‘T“*"ss;e'ﬁcn*“"-o— .

Remote Admin
140.116.82.98

Global IP: 118.18.81.33
Local IP: 10.0.75.2

Subnet: 10.0.75.0/24

i

I
CLiviaTelnet |
i
i
I

Local Admin
10.0.75.100

Scenario Application Timing

When the administrator of the gateway wants to manage it from remote site in the Intranet or Internet,
he may use "Telnet with CLI" function to do that by using "Telnet" or "SSH" utility.

Scenario Description

The Local Admin or the Remote Admin can manage the Gateway by using "Telnet" or "SSH" utility with
privileged user name and password.

The data packets between the Local Admin and the Gateway or between the Remote Admin and the
Gateway can be plain texts or encrypted texts. Suggest they are plain texts in the Intranet for Local
Admin to use "Telnet" utility, and encrypted texts in the Internet for Remote Admin to use "SSH" utility.
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Parameter Setup Example

Following table lists the parameter configuration as an example for the Gateway in above diagram with
"Telnet with CLI" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the table.

Configuration Path [Telnet & SSH]-[Configuration]

Telnet

LAN: m Enable WAN: O Enable
Service Port: 23

SSH

LAN: m Enable \WAN: m Enable
Service Port: 22

Scenario Operation Procedure

In above diagram, "Local Admin" or "Remote Admin" can manage the "Gateway" in the Intranet or
Internet. The "Gateway" is the gateway of Network-A, and the subnet of its Intranet is 10.0.75.0/24. It
has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface. It serves as a

NAT gateway.

The "Local Admin" in the Intranet uses "Telnet" utility with privileged account to login the Gateway.
Or the "Remote Admin" in the Internet uses "SSH" utility with privileged account to login the Gateway.

The administrator of the gateway can control the device as like he is in front of the gateway.

200




4G WAN Extender

Telnet & SSH Setting

Go to Administration > Configure & Manage > Telnet & SSH tab.

The Telnet & SSH setting allows administrator to access this device through the traditional Telnet or SSH
Telnet program. Before you can telnet (login) to the device, please configure the related settings and
password with care. The password management part allows you to set root password for logging telnet and
SSH.

Item Setting
LAM [« Enable
WAN (] Enable | WAN-1 « WARN-4 )
r Telnet | - |
Service Port |23 |
LAM ¢ Enable
WAN [] Enable { WAN-1 ¥ WAN-4 )

F S5H |

"]

Service Port |22 |

Configuration

\ Item Value setting Description \
Telnet 1. The LAN Enable box is Check the Enable box to activate the Telnet function for connecting from LAN or WAN
checked by default. interfaces.
2. By default Service You can set which number of Service Port you want to provide for the corresponding
Port is 23. Service.
Value Range: 1 ~65535.
SSH 3. The LAN Enable box is Check the Enable box to activate the SSH Telnet function for connecting from LAN or
checked by default. WAN interfaces.
4. By default Service You can set which number of Service Port you want to provide for the corresponding
Port is 22. service.
Value Range: 1 ~65535.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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- seeEEED  BC

Item Setting

Old Password : | |

¥ root New Password : | |

Mew Password Confirmation : |

Configuration

Item Value setting Description
root 1. String: any text but no Type old password and specify new password to change root password.
blank character Note_1: You are highly recommended to change the default telnet password with
2. The default password yours before the device is deployed.
for telnet is Note_2: If you have trouble for the default password for previous FW version, please
. , check the corresponding User Manual to get the correct one.
wirelessm2m’.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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6.2 System Operation

System Operation allows the network administrator to manage system, settings such as web-based utility
access password change, system information, system time, system log, firmware/configuration backup &
restore, and reset & reboot.

6.2.1 Password & MMI

Go to Administration > System Operation > Password & MMI tab.

Setup Host Name

Host Name screen allows network administrator to setup / change the host name of the gateway. Click the
Modify button and provide the new username setting.

= Host Name ° ®x

ltem Setting

» Host Name |:|

\ Username Configuration
\ Item Value setting Description

Host Name 1. An Optional setting Enter the host name of the gateway

2. Itis blanked by default )
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change UserName

Username screen allows network administrator to change the web-based MMI login account to access
gateway. Click the Modify button and provide the new username setting.

= Usemame ° ®

ltem Setting
¢+ Username admin | Modify
» New Username I:l
» Password I:I
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\ Username Configuration

Item Value setting Description

1. The default Username
Username for web-based MMl is Display the current MM login account (Username).

‘admin’.
New Username String: any text Enter new Username to replace the current setting.

. Enter current password to verify if you have the permission to change the
Password String: any text .
username setting.

Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change Password

Change password screen allows network administrator to change the web-based MMI login password to
access gateway.

= Password x

ltem Setting

» Old Password l:l

» New Password I:I
+ New Password Confirmation I:l

Password Configuration

Item Value setting Description

1. String: any text

Old Password fzc;::v::fe:::‘::p“:s“snvlv;rd Enter the current password to enable you unlock to change password.
‘admin’.

New Password String: any text Enter new password

New Password . . )

Confirmation String: any text Enter new password again to confirm

Save N/A Click Save button to save the settings

Undo N/A Click Undo button to cancel the settings

Change MMI Setting for Accessing

This is the gateway’s web-based MMI access which allows administrator to access the gateway for
management. The gateway’s web-based MMI will automatically logout when the idle time has elapsed. The
setting allows administrator to enable automatic logout and set the logout idle time. When the login timeout
is disabled, the system won’t logout the administrator automatically.
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Item

* Login

* Login Timeout

¥ GUI Access Protocol

¥ HTTPs Certificate Setup

¥ HTTP Compression

» HTTP Binding

¥ System Boot Mode

Login

Login Timeout

GUI Access Protocol

HTTPs Certificate
Setup

HTTP Compression

HTTP Binding

System Boot Mode

Setting

Password-Guessing Attack & MAX: (3 (times)
# Enable 300 (seconds)
http/https *
s default

Select from Certificate List
Certificate: | TrustedCertD v | Key: | TrustedKey0 v
¥ gzip deflate

DHCP 1

MNormal Mode

3 times is set by default

The Enable box is
checked, and 300 is set
by default.

http/https is selected by
default.

The default box is
selected by default

The box is unchecked by
default.

1. An Optional setting
2. DHCP-1 is checked by
default

Normal Mode is selected
by default.

Enter the login trial counting value.

Value Range: 3 ~ 10.

If someone tried to login the web GUI with incorrect password for more
than the counting value, an warning message “Already reaching maximum
Password-Guessing times, please wait a few seconds!” will be displayed
and ignore the following login trials.

Check the Enable box to activate the auto logout function, and specify the
maximum idle time as well.

Value Range: 30 ~ 65535.

Select the protocol that will be used for GUI access. It can be http/https,
http only, or https only.

If the https Access Protocol is selected, the HTTPs Certificate Setup option
will be available for further configuration.

You can leave it as default or select a expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Check the box (gzip, or deflate) if any comprerssion method is preferred.

Select the DHCP Server to bind with http access.
Select the system boot mode that will be adopted to boot up the device.

Normal Mode: It takes longer boot up time, with complete firmware image
check during the device booting.
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Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings
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6.2.2 System Information

System Information screen gives network administrator a quick look up on the device information for the
purchades gateway.

Go to Administration > System Operation > System Information tab.

= System Information ° ®

ltem Setting

» Model Name VHGETBAM_OTOO1

¢ Device Serial Number

» Kernel Version 26.36

» FW Version 0000Y90.J31_e32 BETA_04021700
b System Time Thu, 18 Apr 2019 16:18:16 +0800

¢+ Device Up-Time 15day 22hr 30min 35sec

‘ System Information

Item Value Setting Description

Model Name N/A It displays the model name of this product.

Device Serial . . .

Number N/A It displays the serial number of this product.

Kernel Version N/A It displays the Linux kernel version of the product

FW Version N/A It displays the firmware version of the product

Memory Usage N/A It displays the percentage of device memory utilization.

System Time N/A It displays the current system time that you browsed this web page.
Device Up-Time N/A It displays the statistics for the device up-time since last boot up.
Refresh N/A Click the Refresh button to update the system Information immediately.
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6.2.3 System Time

The gateway provides manually setup and auto-synchronized approaches for the administrator to setup the
system time for the gateway. The time supported synchronization methods can be Time Server, Manual, PC,
Cellular Module, or GPS Signal. Select the method first, and then configure rest settings.

Instead of manually configuring the system time for the gateway, there are two simple and quick solutions for
you to set the correct time information and set it as the system time for the gateway.

The first one is “Sync with Timer Server”. Based on your selection of time zone and time server in above time
information configuration window, system will communicate with time server by NTP Protocol to get system
date and time after you click on the Synchronize immediately button.

The second one is “Sync with my PC”. Select the method and the system will synchronize its date and time to
the time of the administration PC.

Go to Administration > System Operation > System Time tab.

Synchronize with Time Server

Item Setting
» Synchronization method Time Server v
» Time Zone (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London ¥
¥ Auto-synchronization Time Server.

Available Time Servers (RFC-863): | Auto v

» Daylight Saving Time Enable
» NTP Service Enable
» Synchronize immediately Active

1. A Must-filled item.
2. Time Server is Select the Time Server as the synchronization method for the system time.
selected by default.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

Synchronization
method

Auto 1. A Must-filled item. Enter the IP or FQDN for the NTP time server you expected, or leave it as auto
synchronization 2. Auto is selected by mode so that the available server will be used for time synchronization one by
default. one.
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Daylight Saving
Time

NTP Service

Synchronize
immediately

Save
Refresh

1. It is an optional item.
2. Un-checked by default

1. Itis an optional item.
2. Un-checked by default
N/A

N/A
N/A

Check the Enable button to activate the daylight saving function.

When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.

Check the Enable button to activate the NTP Service function.

When you enabled this function, the gateway can provide NTP server service for
its local connected devices.

Click the Active button to synchronize the system time with specified time
server immediately.

Click the Save button to save the settings.

Click the Refresh button to update the system time immediately.

Note: Remember to select a correct time zone for the device, otherwise, you will just get the UTC
(Coordinated Universal Time) time, not the local time for the device.

Synchronize with Manually Setting

ltem

¥ Synchronization method

¥ Time Zone

¥ Daylight Saving Time

¥ Set Date & Time Manually

¥ NTP Service

Synchronization
method

Time Zone
Daylight Saving
Time

Set Date & Time
Manually

NTP Service

Manual

Setting

v

(GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, Londan

Enable

2019 -
16
Enable:

1. A Must-filled item.
2. Time Server is
selected by default.

1. A Must-filled item.
2. GMT+00 :00 is
selected by default.

1. Itis an optional item.
2. Un-checked by default

1. It is an optional item.

1. Itis an optional item.
2. Un-checked by default

April v
24~

18 v | (Year/Month/Day)

27 v | (Hour:Minute:Second)

Select the Manual as the synchronization method for the system time. It means
administrator has to set the Date & Time manually.

Select a time zone where this device locates.

Check the Enable button to activate the daylight saving function.
When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.
Manually set the date (Year/Month/Day) and time (Hour:Minute:Second) as the
system time.
Check the Enable button to activate the NTP Service function.
When you enabled this function, the gateway can provide NTP server service for
its local connected devices.
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‘ Save N/A Click the Save button to save the settings.

Synchronize with PC

= System Time Configuration ° "
ltem Setting

b Synchronization method |PC v

» NTP Service (] Enable

» Synchronize immediately

System Time Information

Item Value Setting Description

1. A Must-filled item.
2. Time Server is
selected by default.

Synchronization
method

Select PC as the synchronization method for the system time to let system
synchronize its date and time to the time of the administration PC.

. . . Check the Enable button to activate the NTP Service function.
1. It is an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with Cellular Time Service

= System Time Configuration ° x
Item Setting

» Synchronization method | Cellular Module v |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v |

» NTP Service (] Enable

» Synchronize immediately Active

System Time Information

Item Value Setting Description

Select Cellular Module as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the connected
mobile ISP.

1. A Must-filled item.
2. Time Server is
selected by default.

Synchronization
method

Note: this option is only available for the product with Cellular WAN interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
. 1. It is an optional item. i X . .
NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with GPS Time Service

= System Time Configuration ° x
Item Setting

* Synchronization method ' GPS Signal |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v |

» NTP Service (] Enable

» Synchronize immediately Active

\ System Time Information

Item Value Setting Description

Select GPS Signal as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the GNSS
service.

1. A Must-filled item.
2. Time Server is
selected by default.

Synchronization
method

Note: this option is only available for the product with GNSS interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
1. It is an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default . .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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6.2.4 System Log

System Log screen contains various event log tools facilitating network administrator to perform local event
logging and remote reporting.

Go to Administration > System Operation > System Log tab.

S e | Emeion |

Item Setting

» Web Log Type Category System Attacks Drop Login message [J) Debug
() Enable

Server: Add Object

» Email Alert E-mail Addresses:

Subject: | |

Log type Category: [[) System [ Attacks [ ) Drop [ ) Login message [ Debug

[) Enable Server: Add Object

Log type Category: [[) System [ Attacks [ ) Drop [ ) Login message [ Debug
Enable

Select Device: [ |nternal »

Log file name: |SySIOg |
Split file: (1) Enable Size: 200 [KB ¥

» Log to St
0970 Storage Interval: (] Enable [1440 | (1~ 10080 Minutes)

Max Records: [3000 | (5~10000)

» Syslogd

Download log file | clear logs ‘

Log type Category: System Attacks Drop Login message Debug

View & Email Log History

View button is provided for network administrator to view log history on the gateway. Email Now button
enables administrator to send instant Email for analysis.

View & Email Log History

\ Item Value setting Description \
View button N/A Click the View button to view Log History in Web Log List Window.
Email Now . . . . -
button N/A Click the Email Now button to send Log History via Email instantly.
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T e [ [ [ o oo | o I

Time Log
Apr106:01:36 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1 06:08:31 dnsmasg-dhcp[6016]: Ignoring domain amit.com tw for DHCP host name NB-msnb
Apr106:15:30 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:22:06 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:28:42 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:35:42 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:42:20 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb

Web Log List Window

Item Value Setting Description
Time column N/A It displays event time stamps
‘ Log column N/A It displays Log messages ‘

Web Log List Button Description

Item Value setting Description

Previous N/A Click the Previous button to move to the previous page.

Next N/A Click the Next button to move to the next page.

First N/A Click the First button to jump to the first page.

Last N/A Click the Last button to jump to the last page.

Download N/A Click the Download button to download log to your PC in tar file format.
Clear N/A Click the Clear button to clear all log.

Back N/A Click the Back button to return to the previous page.

Web Log Type Category

Web Log Type Category screen allows network administrator to select the type of events to log and be
displayed in the Web Log List Window as described in the previous section. Click on the View button to view
Log History in the Web Log List window.

» Web Log Type Category System Attacks Drop Login message [] Debug

Web Log Type Category Setting Window

Item Value Setting Description

System Checked by default Check to log system events and to display in the Web Log List window.
Attacks Checked by default Check to log attack events and to display in the Web Log List window.

Drop Checked by default Check to log packet drop events and to display in the Web Log List window.
Login message Checked by default Check to log system login events and to display in the Web Log List window.
Debug Un-checked by default Check to log debug events and to display in the Web Log List window.
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Email Alert

Email Alert screen allows network administrator to select the type of event to log and be sent to the destined

Email account.

¥ Email Alert

Enable

Server

E-mail address

Subject

Log type category

Enable
Server: | — Option — v || Add Object

E-mail Addresses:

Subject

Log type Category: System Attacks Drop Login message Debug

Check Enable box to enable sending event log messages to destined Email
Un-checked by default . . .
account defined in the E-mail Addresses blank space.
Select one email server from the Server dropdown box to send Email. If none
has been available, click the Add Object button to create an outgoing Email
N/A server.

You may also add an outgoing Email server from Object Definition > External

Server > External Server tab.

. . Enter the recipient’s Email address. Separate Email addresses with comma *; or
String : email format

semicolon “;’
Enter the Email address in the format of ‘myemail@domain.com’
String : any text Enter an Email subject that is easy for you to identify on the Email client.

Select the type of events to log and be sent to the designated Email account.

Default unchecked . .
Available events are System, Attacks, Drop, Login message, and Debug.
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Syslogd

Syslogd screen allows network administrator to select the type of event to log and be sent to the designated

Syslog server.
[} Enable Server: Add Object

Log type Category: [[] System [) Attacks [ Drop [) Login message [ Debug

» Syslogd

\ Item Value Setting Description \
Enable Un-checked by default Check Enable box to activate the Syslogd function, and send event logs to a syslog server
Select one syslog server from the Server dropdown box to sent event log to.
Server N/A If none has been available, click the Add Object butfcon to c_re_a'_ce a system log server.
You may also add an system log server from the Object Definition > External Server >
External Server tab.
Log type Select the type of event to log and be sent to the destined syslog server. Available
Un-checked by default .
category events are System, Attacks, Drop, Login message, and Debug.
Log to Storage

Log to Storage screen allows network administrator to select the type of events to log and be stored at an
internal or an external storage.

| Enable

Select Device: [|nternal »

Log fils name: |syslog |

Split file: (] Enable Size: 200 | KB |
» Log to St
°glo Slorage Interval: (] Enable [1440 | (1~ 10080 Minutes)
Max Records: |3{}DO | {5~10000)

| Download log file | clear logs |
Log type Category: [# System [# Attacks # Drop # Login message [ Debug

Log to Storage Setting Window

Enable Un-checked by default Check to enable sending log to storage.

Internal is selected by

Select Device Select internal or external storage.

default
Log file name Un-checked by default Enter log file name to save logs in designated storage.
Split file Enable Un-checked by default Check enable box to split file whenever log file reaching the specified limit.
el e Enter the file size limit for each split log file.
Split file Size 200 KB is set by default Pt

Value Range: 10 ~ 1000.
Interval Enable Un-checked by default Check enable box to enable the log interval setting.
Enter the log interval setting.
Value Range: 1 ~ 10080 Minute.
Enter the maximum number of records to be stored in the log storage.
Value Range: 5 ~ 10000.
Log type category  Un-checked by default Check which type of logs to send: System, Attacks, Drop, Login message, Debug

Log Interval 1440 is set by default

Max Records 3000 is set by default
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Log to Storage Button Description

\ Item Value setting Description \
Download log N/A Click the Download log file button to download log files to a log.tar file.
file
Clear Logs N/A Click the Clear logs button to delete the log files from the storage.
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6.2.5 Backup & Restore

In the Backup & Restore window, you can upgrade the device firmware when new firmware is available and
also backup / restore the device configuration.

In addition to the factory default settings, you can also customize a special configuration setting as a
customized default value. With this customized default value, you can reset the device to the expected default

setting if needed.

Go to Administration > System Operation > Backup & Restore tab.

ltem Setting
» FW Upgrade Via Web Ul v | | FW Upgrade
» Backup Configuration Settings Download ¥ | | Via Web UI
¥ Auto Restore Configuration Enable | Save Conf. | Clean Conf. | Conf. Info.
» Self-defined Logo Download ¥ || Via Web Ul || Reset
» Self-defined CSS Edit
Download v || Via Web Ul || Reset

Via Web Ul is selected by

FW Upgrade
Pe default
B
ack‘up . Download is selected by
Configuration
Settings default

The Enable box is
unchecked by default

Auto Restore
Configuration

If new firmware is available, click the FW Upgrade button to upgrade the device
firmware via Web UI, or Via Storage.

After clicking on the “FW Upgrade” command button, you need to specify the
file name of new firmware by using “Browse” button, and then click “Upgrade”
button to start the FW upgrading process on this device. If you want to upgrade
a firmware which is from GPL policy, please check “Accept unofficial firmware”
You can backup or restore the device configuration settings by clicking the Via
Web Ul button.

Download: for backup the device configuration to a config.bin file.

Upload: for restore a designated configuration file to the device.

Via Web Ul: to retrieve the configuration file via Web GUI.

Chick the Enable button to activate the customized default setting function.
Once the function is activated, you can save the expected setting as a
customized default setting by clicking the Save Conf. button, or clicking the
Clean Conf. button to erase the stored customized configuration.
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6.2.6 Reboot & Reset

For some special reason or situation, you may need to reboot the gateway or reset the device configuration to
its default value. In addition to perform these operations through the Power ON/OFF, or pressing the reset
button on the device panel, you can do it through the web GUI too.

Go to Administration > System Operation > Reboot & Reset tab.

In the Reboot & Reset window, you can reboot this device by clicking the “Reboot” button, and reset this
device to default settings by clicking the “Reset” button.

Item
» Reboot

» Reset to Default

Reboot

Reset to Default

Setting
Now r | | Reboot

Reset

Chick the Reboot button to reboot the gateway immediately or on a pre-defined
time schedule.

Now is selected by Now: Reboot immediately

default Time Schedule: Select a pre-defined auto-reboot time schedule rule to reboot
the auto device on a designated tim. To define a time schedule rule, go to
Object Definition > Scheduling > Configuration tab.

N/A Click the Reset button to reset the device configuration to its default value.
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6.3 FTP (not supported)

Not supported feature for the purchased product, leave it as blank.
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6.4 Dia

gnostic

This gateway supports simple network diagnosis tools for the administrator to troubleshoot and find the root
cause of the abnormal behavior or traffics passing through the gateway. There can be a Packet Analyzer to
help record the packets for a designated interface or specific source/destination host, and another Ping and
Tracert tools for testing the network connectivity issues.

6.4.1 Diagnostic Tools

The Diagnostic Tools provide some frequently used network connectivity diagnostic tools (approaches) for the
network administrator to check the device connectivity.

Go to Administration > Diagnostic > Diagnostic Tools tab.

¥ Ping Test

b Tracert Test

k Wake on LAM

Ping Test

Tracert Test

Wake on LAN

Save

Item

Host IP
Default

Host IP

Optional Setting

Optional setting

Optional setting

N/A

Setting

Outer Interface: [ A tg v | LAN Source:

Interface: |Auto ¥ | |UDP Tracert

Wake up

This allows you to specify an IP / FQDN, the Outer interface (auto, WAN, LAN,
or VLAN), and LAN source (default, LAN, or VLAN) as well, so system will try
to ping the specified device to test whether it is alive after clicking on the
Ping button. A test result window will appear beneath it.

Trace route (tracert) command is a network diagnostic tool for displaying the
route (path) and measuring transit delays of packets across an IP network.
Trace route proceeds until all (three) sent packets are lost for more than
twice, then the connection is lost and the route cannot be evaluated.

First, you need to specify an IP / FQDN, the test interface (LAN, WAN, or
Auto) and the protocol (UDP or ICMP), and by default, it is UDP.

Then, system will try to trace the specified host to test whether it is alive
after clicking on Tracert button. A test result window will appear beneath it.
Wake on LAN (WOL) is an Ethernet networking standard that allows a
computer to be turned on or awakened by a network message. You can
specify the MAC address of the computer, in your LAN network, to be
remotely turned on by clicking on the Wake up command button.

Click the Save button to save the configuration.
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Chapter 7 Service

7.1 Cellular Toolkit

Data Usage Monitoring i
1. Statisticsof data usage thru 3G/LTE i
2. SIMswitchor drop if reach quota limit |

[®) SMS [Short Message Service)

‘g 1. Compose SMSmessage ongateway
Cél.llul.ar 2. Receive SMSmessage from remote
Tower

Mobile Network ((( ) SIM PIN Management

i
i 1. SIMcardPIN lock or PIN unlock
Operator cellular i 2. PIN code change or PUK unlock 8
\ Tower . AMIT M2M
{(‘g : Mobile Network Scan i Cellular Gateway
¢ i 1. Actively mobile networksearch 1
Cellular i 2. Manuallyselect mobile network |
Tower \ ]

! USSD Communication

i 1. Instant communicationwith MNO

i — ;

] 2. Subscriber inguiry or setting change

SS|

inserted to device before you continue settings in this section.

f @ e 1| m SMS SIMPIN  USSD  Network Scan

= 3GIAG Data Usage Profile List IRl IS
@ omctomomon | —
| D SIM info Carrier Name | Cycle Period Start Date

'@ Field Communication |

() secumty ]
'e Administration |

(@) service |

- SMS & Event

Besides cellular data connection, you may
also like to monitor data usage of cellular
WAN, sending text message through SMS,
changing PIN code of SIM card,
communicating with carrier/ISP by USSD
command, or doing a cellular network scan
for diagnostic purpose.

In Cellular Toolkit section, it includes several
useful features that are related to cellular
configuration or application. You can
configure settings of Data Usage, SMS, SIM
PIN, USSD, and Network Scan here. Please
note at least a valid SIM card is required to be

Connection
Data Limitation Enable Action
Restrict
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7.1.1 Data Usage

Most of data plan for cellular connection is with a limited amount of data usage. If data usage has been over
limited quota, either you will get much lower data throughput that may affect your daily operation, or you will
get a ‘bill shock’ in the next month because carrier/ISP charges a lot for the over-quota data usage.

With help from Data Usage feature, device will monitor cellular data usage continuously and take actions. If
data usage reaches limited quota, device can be set to drop the cellular data connection right away. Otherwise,
if secondary SIM card is inserted, device will switch to secondary SIM and establish another cellular data

connection with secondary SIM automatically.

If Data Usage feature is enabled, all history of cellular data usage can be viewed at Status > Statistics &

Reports > Cellular Usage tab.

J Add || Delete
D SIM info Carrier Name | Cycle Period Start Date
1 | 3GHGSIMA ISP A 1 Monthly Mon Apr 01 2019

3G/4G Data Usage
SIMA
ISP A Bill start: every20® ((9))
Zﬂgﬁ U Datalimit: 1Gh |
'-‘-:a..
é\ % SIMB Gateway
ISPB
SIM A Settings

-Cycle Period: monthly
-Start Date: 2017 [ Feb [ 20
-Diata Limitation: 1Gb
-Connection Restrict: Enable

00:00:00 GMT+0300

Connection
Data Limitation Enable Action
Restrict
1GB Edit Select

Data Usage feature enabling gateway device to
continuously monitor cellular data usage and take
actions. In the diagram, quota limit of SIM A is 1Gb
per month and bill start date is 20" of every month.
The device is smart to start a new calculation of
data usage on every 20" of month. Enable
Connection Restrict will force gateway device to
drop cellular connection of SIM A when data usage
reaches quota limit (1Gb in this case). If SIM
failover feature is configured in Internet Setup,
then gateway will switch to SIM B and establish a
new cellular data connection automatically.
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Data Usage Setting

Go to Service > Cellular Toolkit > Data Usage tab.

Before finished settings for Data Usage, you need to know bill start date, bill period, and quota limit of data
usage according to your data plan. You can ask this information from your carrier or ISP.

Create / Edit 3G/4G Data Usage Profile

= 3GI4G Data Usage Profile List [[R¢] =

Connection

5IM info Carrier Name | Cycle Period Start Date Data Limitation Enable Action

Restrict

When Add button is applied, 3G/4G Data Usage Profile Configuration screen will appear. You can create up to
four data usage profiles, one profile for each SIM card used in the Gateway.

# 3G/4AG Data Usage Profile Configuration

ltem Setting

» SIM Select 13G/4G v | [SIMA ¥ |

b Carrier Name | |

» Cycle Period Days v/ | |

» Start Date 12019 v | /| April IERERE2
» Data Limitation | | (KB v

» Connection Restrict (] Enable

» Enable [« Enable

 3G/4G Data Usage Profile Configuration |

3G/4G Data Usage Profile Configuration

\ Item Setting
SIM Select

Value setting
3G/4G-1 and SIM A by
default.

Description

Choose a cellular interface (3G/4G-1 or 3G/4G-2), and a SIM card bound to the
selected cellular interface to configure its data usage profile.

Note: 3G/4G-2 is only available for for the product with dual cellular module.

Carrier Name

It is an optional item.

Fill in the Carrier Name for the selected SIM card for identification.

Cycle Period

Days by default

The first box has three types for cycle period. They are Days, Weekly and Monthly.
Days: For per Days cycle periods, you have to further specify the number of days in
the second box.

Value Range: 1 ~ 90 days.

Weekly, Monthly: The cycle period is one week or one month.

Start Date

N/A

Specify the date to start measure network traffic.
Please don’t select the day before now, otherwise, the traffic statistics will be
incorrect.

Data Limitation

N/A

Specify the allowable data limitation for the defined cycle period.

Connection

Un-Checked by default.

Check the Enable box to activate the connection restriction function.
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Restrict During the specified cycle period, if the actual data usage exceeds the allowable data
limitation, the cellular connection will be forced to disconnect.
Enable Un-Checked by default. Check the Enable box to activate the data usage profile.
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7.1.2 SMS

Short Message Service (SMS) is a text messaging service, which is used to be widely-used on mobile phones. It
uses standardized communications protocols to allow mobile phones or cellular devices to exchange short text
messages in an instant and convenient way.

SMS Setting

Go to Service > Cellular Toolkit > SMS tab

With this gateway device, you can send SMS text messages or browse received SMS messages as you usually
do on a cellular phone.

Setup SMS Configuration

¥ Physical Interface

r SMS

¥ SMS Storage
b SMS Space

Physical
Interface

SMS

SIM Status

SMS Storage

SMS Space

Save

SMS Setup Managing Events Setup Notifying Events Setup

Item Setting
3GH4G1r
Enable SIM Status: SIM_A
SIM Card Only
Enable & Keep Available Space (1-10)

The box is 3G/4G-1 by
default

The box is checked by
default

N/A

The box is SIM Card Only
by default

The box is unchecked by
default

N/A

Choose a cellular interface (3G/4G-1 or 3G/4G-2) for the following SMS function
configuration.

Note: 3G/4G-2 is only available for for the product with dual cellular module.
This is the SMS switch. If the box checked that the SMS function enable, if the
box unchecked that the SMS function disable.

Depend on currently SIM status. The possible value will be SIM_A or SIM_B.

This is the SMS storage location. Currently the option only SIM Card Only.

Check the Enable box and specify a number (1-10) for message count to reserve
some available storage space and prevent it from run out of storage.

The oldest message(s) will be deleted when the SMS storage is going to full.
Click the Save button to save the settings
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SMS Summary

Show Unread SMS, Received SMS, Sent SMS, Remaining SMS, and edit SMS context to send, read SMS from
SIM card.

SR\ sMS il SMS Inbox | SMS Sent Folder ’ %
Item Setting

+ Unread SMS 0

» Received SMS 10

» Sent SMS 0

* Remaining SMS 0

\ SMS Summary

Item Value setting Description

If SIM card insert to router first time, unread SMS value is zero. When received the
new SMS but didn’t read, this value plus one.

This value record the existing SMS numbers from SIM card, When received the new
SMS, this value plus one.

This value record the number of out going SMS, When sent one SMS, this value
plus one.

Unread SMS N/A

Received SMS  N/A

Sent SMS N/A

. . This value is SMS capacity minus received SMS, When received the new SMS, this
Remaining SMS  N/A ]
value minus one.

Click New SMS button, a New SMS screen appears. User can set the SMS setting

New SMS N/A
from this screen. Refer to New SMS in the next page.
Click SMS Inbox button, a SMS Inbox List screen appears. User can read or delete
SMS Inbox N/A SMS, reply SMS or forward SMS from this screen. Refer to SMS Inbox List in the
next page.
Refresh N/A Click the Refresh button to update the SMS summary immediately.
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New SMS
You can set the SMS setting from this screen.

« New sms [EET] a %

b Item Setting

{Use "+ for International Format and ;' to Compose Multiple Receivers)

+ Receivers

b Text Message

Length of Current Input: 0

» Result

New SMS

\ Item Value setting Description

Write the receivers to send SMS. User need to add the semicolon and compose

Receivers N/A
multiple receivers that can group send SMS.

Write the SMS context to send SMS. The router supports up to a maximum of
1023 character for SMS context length.

Send N/A Click the Send button, above text message will be sent as a SMS.

If SMS has been sent successfully, it will show Send OK, otherwise Send Failed

Text Message N/A

Result N/A

will be displayed.

SMS Inbox List
You can read or delete SMS, reply SMS or forward SMS from this screen.

From Phone

Timestamp SMS Text Preview Actions

SMS Inbox List

\ Item Value setting Description
ID N/A The number of SMS.
From Phone N/A Sender List (Phone Number) for the received SMS
Number / ender List (Phone Number) for the receive
Timestamp N/A What time the SMS is received
SMS Text N/A Preview the SM lick the Detail b d i
Preview / review the SMS text. Click the Detail button to read a certain message.
Action The box is unchecked by Click the Detail button to read the SMS detail; Click the Reply / Forward button
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default to reply/forward SMS.
Besides, you can check the box(es), and then click the Delete button to delete
the checked SMS(s).

Refresh N/A Refresh the SMS Inbox List.
Delete N/A Delete the SMS for all checked box from Action.
Close N/A Close the Detail SMS Message screen.

SMS Sent Folder

You can read or delete SMS from this screen.

Y oeiete ] iose [ Preveus [0 - [ x|

SMS Text Preview

Receivers Timestamp Actions

SMS Sent Folder

Item Value setting Description

ID N/A The number of SMS.

Receivers N/A Receiver list for the sent SMS.

Timestamp N/A What time the SMS is sent

SMS Text . . . .

Preview N/A Preview the SMS text. Click the Detail button to read a certain message.

. Click the Detail button to read the SMS detail
The box is unchecked by

Action Besides, you can check the box(es), and then click the Delete button to delete
default
the checked record(s).
Refresh N/A Refresh the SMS Sent Folder.
Delete N/A Delete the SMS for all checked box from Action.
Close N/A Close the Detail SMS Message screen.
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7.1.3 SIM PIN

With most cases in the world, users need to insert a SIM card (a.k.a. UICC) into end devices to get on cellular
network for voice service or data surfing. The SIM card is usually released by mobile operators or service
providers. Each SIM card has a unique number (so-called ICCID) for network owners or service providers to
identify each subscriber. As SIM card plays an important role between service providers and subscribers, some
security mechanisms are required on SIM card to prevent any unauthorized access.

Enabling a PIN code in SIM card is an easy and effective way of protecting cellular devices from unauthorized
access. This gateway device allows you to activate and manage PIN code on a SIM card through its web GUI.

Activate PIN code on SIM Card

This gateway device allows you to activate PIN code on SIM card. This
example shows how to activate PIN code on SIM-A for 3G/4G-1 with
default PIN code “0000”.

with PIN Code ‘0000 Gateway

SIM A Settings
-SIM Lock: Enable

-PIN Code: 0000

Change PIN code on SIM Card

This gateway device allows you to change PIN code on SIM card.
Following the example above, you need to type original PIN code
“0000”, and then type new PIN code with ‘1234’ if you like to set new
PIN code as ‘1234’. To confirm the new PIN code you type is what you
want, you need to type new PIN code ‘1234’ in Verified New PIN Code
again.

‘\“-‘T.‘\

with PIN Code ‘0000 Gateway

Change PIN Code Settings
-Current PIN Code: 0000
-New PIN Code: 1234
Verified New PIN Code: 1234

Unlock SIM card by PUK Code

If you entered incorrect PIN code at configuration page for 3G/4G-1

~ (G
. WAN over three times, and then it will cause SIM card to be locked by
ag 0O PUK code. Then you have to call service number to get a PUK code to
MNO SIMA locked - unlock SIM card. In the diagram, the PUK code is “12345678” and new
by PUK code Gateway .
12345678’ PIN code is “5678".

PUK Unlock Settings
-PUK Code: 12345678

-New PIN Code: 5678
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SIM PIN Setting

Go to Service > Cellular Toolkit > SIM PIN Tab

With the SIM PIN Function window, it allows you to enable or disable SIM lock (which means protected by PIN
code), or change PIN code. You can also see the information of remaining times of failure trials as we
mentioned earlier. If you run out of these failure trials, you need to get a PUK code to unlock SIM card.

Select a SIM Card

¥ Physical Interface

» SIM Status

» SIM Selection

Physical
Interface

SIM Status

SIM Selection

ltem

Setting

3G/MA4G-1

SIM-A Ready

SIM-A ¥ || Switch

The box is 3G/4G-1 by
default

N/A

N/A

Choose a cellular interface (3G/4G-1 or 3G/4G-2) to change the SIM PIN setting
for the selected SIM Card.

Note: 3G/4G-2 is only available for for the product with dual cellular module.
Indication for the selected SIM card and the SIM card status.

The status could be Ready, Not Insert, or SIM PIN.

Ready -- SIM card is inserted and ready to use. It can be a SIM card without PIN
protection or that SIM card is already unlocked by correct PIN code.

Not Insert -- No SIM card is inserted in that SIM slot.

SIM PIN -- SIM card is protected by PIN code, and it’s not unlocked by a correct
PIN code yet. That SIM card is still at locked status.

Select the SIM card for further SIM PIN configuration.

Press the Switch button, then the Gateway will switch SIM card to another one.
After that, you can configure the SIM card.
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Enable / Change PIN Code

Enable or Disable PIN code (password) function, and even change PIN code function.

Cave hanae J Code

Item Setting
PIN Lock Enable PIN Code: (4~8 digits)
Remaining times NIA
SIM lock Depend on SIM card Click the Enable button to activate the SIM lock function.

For the first time you want to enable the SIM lock function, you have to
fill in the PIN code as well, and then click Save button to apply the setting.

Remaining times Depend on SIM card Represent the remaining trial times for the SIM PIN unlocking.
Save N/A Click the Save button to apply the setting.
Change PIN Code N/A Click the Change PIN code button to change the PIN code (password).

If the SIM Lock function is not enabled, the Change PIN code button is
disabled. In the case, if you still want to change the PIN code, you have to
enable the SIM Lock function first, fill in the PIN code, and then click the Save
button to enable. After that, You can click the Change PIN code button to
change the PIN code.

When Change PIN Code button is clicked, the following screen will appear.

ftem Setting

Current PIN Code {48 digits)

Mew PIM Code i4-~8 digits)

Vertified Mew PIN Code {4~8 digits)

Apply | Cancel

Current PIN A Must filled setting Fill in the current (old) PIN code of the SIM card.
Code
New PIN Code A Must filled setting Fill in the new PIN Code you want to change.
Verified New A Must filled setting Confirm the new PIN Code again.
PIN Code
Apply N/A Click the Apply button to change the PIN code with specified new PIN code.
Cancel N/A Click the Cancel button to cancel the changes and keep current PIN code.

Note: If you changed the PIN code for a certain SIM card, you must also change the corresponding PIN code
specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with SIM Card page.
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Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.

Unlock with a PUK Code
The PUK Function window is only available for configuration if that SIM card is locked by PUK code. It means
that SIM card is locked and needs additional PUK code to unlock. Usually it happens after too many trials of
incorrect PIN code, and the remaining times in SIM Function table turns to 0. In this situation, you need to
contact your service provider and request a PUK code for your SIM card, and try to unlock the locked SIM card
with the provided PUK code. After unlocking a SIM card by PUK code successfully, the SIM lock function will be
activated automatically.

(%]
]

» PUK status

» Remaining times
» PUK Code

» New PIN Code

PUK status

Remaining times

PUK Code
New PIN Code

Save

PUK unlock.

N/A

PUK Unlock
/ PUK Lock

Depend on SIM card

A Must filled setting
A Must filled setting

N/A

Setting

(8 digits)

(4~8 digits)

Indication for the PUK status.

The status could be PUK Lock or PUK Unlock. As mentioned earlier, the SIM card
will be locked by PUK code after too many trials of failure PIN code. In this case,
the PUK Status will turns to PUK Lock. In a normal situation, it will display PUK
Unlock.

Represent the remaining trial times for the PUK unlocking.

Note : DO NOT make the remaining times down to zero, it will damage the SIM
card FOREVER ! Call for your ISP’s help to get a correct PUK and unlock the SIM if
you don’t have the PUK code.

Fill in the PUK code (8 digits) that can unlock the SIM card in PUK unlock status.
Fill in the New PIN Code (4~8 digits) for the SIM card.

You have to determine your new PIN code to replace the old, forgotten one.
Keep the PIN code (password) in mind with care.

Click the Save button to apply the setting.

Note: If you changed the PUK code and PIN code for a certain SIM card, you must also change the
corresponding PIN code specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with
SIM Card page. Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.
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7.1.4 USSD

Unstructured Supplementary Service Data (USSD) is a protocol used by GSM cellular telephones to
communicate with the service provider's computers. USSD can be used for WAP browsing, prepaid callback
service, mobile-money services, location-based content services, menu-based information services, and as
part of configuring the phone on the network.

An USSD message is up to 182 alphanumeric characters in length. Unlike Short Message Service (SMS)
messages, USSD messages create a real-time connection during an USSD session. The connection remains
open, allowing a two-way exchange of a sequence of data. This makes USSD more responsive than services
that use SMS.

* Configuration ' »®

ltem Setting

» Physical Interface 3GMAG-1 v | SIM Status: SIM_A

USSD Command

N senc | i [ Gancel |

Profile Name Comments Actions

Item Setting

b USSD Profile

» USSD Command |

toe n% roami Mce.’,"

USSD Scenario
Gateway USSD allows you to have an instant bi-directional
e 9@ communication with carrier/ISP. In the diagram, the USSD
* e ¥ Cemmorms 0 command *135# is referred to data roaming services.
Seng a USSTTCOGE +135#

After sending that USSD command to carrier, you can get

> a response at window USSD Response. Please note the
@ The USShsery lie: i . . .
S i gyl S USSD command varies for different carriers/ISP.
USSD Server
& Service Provider
Lecal Administrator

10.0,75.100
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USSD Setting

Go to Service > Cellular Toolkit > USSD tab.

In "USSD" page, there are four windows for the USSD function. The "Configuration" window can let you specify
which 3G/4G module (physical interface) is used for the USSD function, and system will show which SIM card in
the module is the current used one. The second window is the "USSD Profile List" and it shows all your defined
USSD profiles that store pre-commands for activating an USSD session. An "Add" button in the window can let
you add one new USSD profile and define the command for the profile in the third window, the "USSD Profile
Configuration". When you want to start the activation of an USSD connection session to the USSD server,
select the USSD profile or type in the correct pre-command, and then click on the "Send" button for the
session. The responses from the USSD server will be displayed beneath the "USSD Command" line. When
commands typed in the "USSD Command" field are sent, received responses will be displayed in the "USSD
Response" blank space. User can communicate with the USSD server by sending USSD commands and getting
USSD responses via the gateway.

USSD Configuration

Item Setting

» Physical Interface 3GMAG-1 SIM Status: SIM_A

Choose a cellular interface (3G/4G-1 or 3G/4G-2) to configure the USSD setting
for the connected cellular service (identified with SIM_A or SIM_B).

Note: 3G/4G-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).

The box is 3G/4G-1 by

Physical Interface
default.

Create / Edit USSD Profile

The cellular gateway allows you to custom your USSD profile. It supports up to a maximum of 35 USSD profiles.
Add Delete

D Profile Name USSD Command Comments Actions

When Add button is applied, USSD Profile Configuration screen will appear.
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SN LT send || Clear || Cancel |

Item Setting

» USSD Command |

USSD Profile Configuration

Item Value setting Description

Profile Name N/A Enter a name for the USSD profile.

Enter the USSD command defined for the profile.

Normally, it is a command string composed with numeric keypad “0~9”, “*”,

USSD Command N/A
and “#”. The USSD commands are highly related to the cellular service, please

check with your service provider for the details.
Comments N/A Enter a brief comment for the profile.

Send USSD Request

When send the USSD command, the USSD Response screen will appear.
When click the Clear button, the USSD Response will disappear.

= ussorensen BT [0 020

Item Setting

» USSD Command | |

\ USSD Request

Item Value setting Description
USSD Profile N/A Select a USSD profile name from the dropdown list.
USSD Command  N/A The USSD Command string of the selected profile will be shown here.
Click the Send button to send the USSD command, and the USSD Response
USSD Response N/A screen will appear. You will see the response message of the corresponding
service, receive the service SMS.

236



4G WAN Extender

7.1.5 Network Scan

"Network Scan" function can let administrator specify the device how to connect to the mobile system for
data communication in each 3G/4G interface. For example, administrator can specify which generation of
mobile system is used for connection, 2G, 3G or LTE. Moreover, he can define their connection sequence for
the gateway device to connect to the mobile system automatically. Administrator also can scan the mobile
systems in the air manually, select the target operator system and apply it. The manual scanning approach is
used for problem diagnosis.

Network Scan Setting

Go to Service > Cellular Toolkit > Network Scan tab.

In "Network Scan" page, there are two windows for the Network Scan function. The "Configuration" window
can let you select which 3G/4G module (physical interface) is used to perform Network Scan, and system will
show the current used SIM card in the module. You can configure each 3G/4G WAN interface by executing the
network scanning one after another. You can also specify the connection sequence of the targeted generation
of mobile system, 2G/3G/LTE.

Network Scan Configuration

Item Setting
» Physical Interface IGMAG-1 v | SIM Status: SIM_A
» Network Type LTE Only v
¥ Scan Approach Auto d
Physical The box is 3G/4G-1 by Choose a cellular interface (3G/4G-1 or 3G/4G-2) for the network scan function.
Interface default Note: 3G/4G-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).

Specify the network type for the network scan function.

. It can be Auto, 2G Only, 2G prefer, 3G Only, 3G prefer, or LTE Only.
Auto is selected by

Network Type default. When Auto is selected, the network will be register automatically;
If the prefer option is selected, network will be register for your option first;
If the only option is selected, network will be register for your option only.
When Auto selected, cellular module register automatically.

Scan Approach Auto is selected by If the Manually option is selected, a Network Provider List screen appears.

default. Press Scan button to scan for the nearest base stations. Select (check the box)

the preferred base stations then click Apply button to apply settings.

Save N/A Click Save to save the settings
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The second window is the "Network Provider List" window and it appears when the Manually Scan Approach
is selected in the Configuration window. By clicking on the "Scan" button and wait for 1 to 3 minutes, the found
mobile operator system will be displayed for you to choose. Click again on the "Apply" button to drive system
to connect to that mobile operator system for the dedicated 3G/4G interface.

* Network Provider List g 200

Provider Name

Mobile System Network Status Action
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7.2 SMS & Event

SMS & Event handling is the application that allows administrator to setup the pre-defined events, handlers, or
response behavior with individual profiles. With properly configuring the event handling function,
administrator can easily and remotely obtain the status and information via the purchased gateway.

The supported events are categorized into two groups: the managing events and notifying events.

The managing events are the events that are used to manage the gateway or change the setting / status of the
specific functionality of the gateway. On receiving the managing event, the gateway will take action to change
the functionality, and collect the required status for administration simultaneously.

The notifying events are the events that some related objects have been triggered and take corresponding
actions on the occurrence of the events. It could be an event for alerting the administrator something
happened with SMS message, Email, and SNMP Trap, etc...

For ease of configuration, administrator can create and edit the common pre-defined managing / notifying
event profiles for taking instant reaction on a certain event or managing the devices for some advanced useful
purposes. For example, sending/receiving remote managing SMS for the gateway’s routine maintaining, and so
on. All of such management and notification function can be realized effectively via the Event Handling feature.

The following is the summary lists for the provided profiles, and events:

® Profiles (Rules):
e SMS Configuration and Accounts
e Email Accounts
* Remote Host profiles
® Managing Events:
* Trigger Type: SMS, SNMP Trap
e Actions: Get the Network Status; or Configure the LAN/VLAN behavior, WIFI behavior, NAT
behavior, Firewall behavior, VPN behavior, System Management, Administration, and Remote
Host.
® Notifying Events:
e Trigger Type: Connection Change (WAN, LAN & VLAN, WiFi, DDNS), Administration, Data Usage.
e Actions: Notify the administrator with SMS, Syslog, SNMP Trap or Email Alert; Sending collected
information to Remote Host.

To use the event handling function, First of all, you have to enable the event management setting and
configure the event details with the provided profile settings. You can create or edit pre-defined profiles for
individual managing / notifying events. The profile settings are separated into several items; they are the SMS
Account Definition, Email Service Definition, and Remote Host Configuration. Then, you have to configure each
managing / notifying event with identifying the event’s trigger condition, and the corresponding actions
(reaction for the event) for the event. For each event, more than one action can be activated simultaneously.
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7.2.1 Configuration

Go to Service > SMS & Event > Configuration Tab.

Event handling is the service that allows administrator to setup the pre-defined events, handlers, or response
behavior with individual profiles.

Enable Event Management

*| Configuration ' ®

Item Setting

» Event Management (] Enable

Configuration

Item Value setting Description

Event The box is unchecked by Check the Enable box to activate the Event Management function.
Management default
Enable SMS Management

To use the SMS management function, you have to configure some important settings first.

= SMS Configuration u ®

Item Settin
|> £}

» Message Prefix [) Enable | ‘

» Physical Interface 3G/M4G-1 v | SIM Status: SIM_A

¥ Delete Managed SMS after [ Enable
Processing

SMS Configuration

Item Value setting Description
Message Prefix The box is unchecked Click the Enable box to enable the SMS prefix for validating the received SMS.
by default Once the function is enabled, you have to enter the prefix behind the checkbox.
The received managing events SMS must have the designated prefix as an initial
identifier, then corresponding handlers will become effective for further

processing.
Physical Interface The box is 3G/4G-1 by Choose a cellular interface (3G/4G-1 or 3G/4G-2) to configure the SMS
default. management setting.
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Note: 3G/4G-2 is only available for for the product with dual cellular module.

SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).
Delete Managed The box is unchecked Check the Enable box to delete the received managing event SMS after it has
SMS after by default been processed.

Processing

Create / Edit SMS Account

Setup the SMS Account for managing the gateway through the SMS. It supports up to a maximum of 5
accounts.

SRCTTY R Add [l Delete |

Phone Number

Send confirmed
SMS

Phone Description Application Enable Actions

You can click the Add / Edit button to configure the SMS account.

& SMS Account Configuration o

Item Setting

» Phone Number | Specific Number v | | ‘

¥ Phone Description ‘ ‘

» Application ) Event Trigger [J Notify Handle

» Send confirmed SMS () Enable

» Enable Enable

Save
SMS Account Configuration
\ Item \ Value setting Description
Phone 1. Mobile phone number Select the Phone number policy from the drop list, and specify a mobile phone
Number format number as the SMS account identifier if required.
2. A Must filled setting It can be Specific Number, or Allow Any. If Specific Number is selected, you

have to specify the phone number as the SMS account identifier.
Value Range: -1 ~ 32 digits.

Phone 1. Any text Specify a brief description for the SMS account.

Description 2. An Optional setting

Application A Must filled setting Specify the application type. It could be Event Trigger, Notify Handle, or both.
If the Phone Number policy is Allow Any, the Noftify Handle will be unavailable.

Send 1. An Optional setting Click Enable box to active the SMS response function.

confirmed 2. The box is unchecked by The gateway will send a confirmed message back to the sender whenever it

SMS default. received a SMS managing event. The confirmed message is similar to following

format: “Device received a SMS with command xxxxx.”
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Enable The box is unchecked by Click Enable box to activate this account.
default.
Save NA Click the Save button to save the configuration.

Create / Edit Email Service Account

Setup the Email Service Account for event notification. It supports up to a maximum of 5 accounts.

Enable

Email Server Email Addresses Actions

You can click the Add / Edit button to configure the Email account.

%1 Email Service Configuration ®

Item Setting

» Email Addresses | ‘

» Enable Enable

Email Service Configuration

Item Value setting Description
Email Server --- Option --- Select an Email Server profile from External Server setting for the email account
setting.
Email 1. Internet E-mail address Specify the Destination Email Addresses.
Addresses format
2. A Must filled setting
Enable The box is unchecked by Click Enable box to activate this account.
default.
Save NA Click the Save button to save the configuration
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Create / Edit Remote Host Profile

Setup the Remote Host Profile. It supports up to a maximum of 10 profiles.

Protocol
Type

ID | Host Name Host IP Prefix Message Suffix Message Enable Actions

You can click the Add / Edit button to configure the profile.

* Remote Host Configuration x

Item Setting

» Host Name

» Host IP

¥ Protocol Type

¥ Prefix Message

¥ Suffix Message

» Port Number |:|
|
|
o

» Enable
Save
Remote Host Configuration
\ Item ‘ Value setting \ Description
Host Name 1. String format Specify the Remote Host profile name.
2. A Must filled setting Value Range: -1 ~ 64 characters.
Host IP 1. A Must filled setting Specify the IP address for the Remote Host. IPv4 Format.
2.IP Address format.
Protocol Type 1. A Must filled setting Specify the protocol to access the Remote Host. It could be TCP or UDP.
2. TCP is selected by default
Port Number 1. A Must filled setting Specify the Port number for accessing the Remote Host.
Value Range: 1 ~ 65535.
Prefix 1. String format Specify the Prefix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting remote host, if required.
Value Range: -1 ~ 64 characters.
Suffix 1. String format Specify the Suffix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting ~ remote host, if required.
Value Range: -1 ~ 64 characters.
Enable The box is unchecked by Click Enable box to activate this profile setting.
default.
Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous
setting.

243



4G WAN Extender

7.2.2 Managing Events

Managing Events allow administrator to define the relationship (rule) among event trigger, handlers and
response.

Go to Service > SMS & Event > Managing Events Tab.

Enable Managing Events

* Configuration n ®

Item Setting

» Managing Events () Enable

Configuration

\ Item \ Value setting Description
Managing The box is unchecked by Check the Enable box to activate the Managing Events function.
Events default

Create / Edit Managing Event Rules

Setup the Managing Event rules. It supports up to a maximum of 128 rules.

= Managing Event List m ..

Event Name

Actions

Trigger Type Description

When Add or Edit button is applied, the Managing Event Configuration screen will appear.
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Item

» Event Name

» Event

v Trigger Type
v Interval

» Description

¥ Action

» Managing Event

Event

Trigger Type

Interval

Description
Action

Setting

None A

MNone ¥

Mone v

Period v

0 (0~86400 seconds)

Metwork Status
LANEVLAN
MAT

Firewal

VPN

GRE

System Manage
Administration
Femote Host

+ Enable

None by default

Period is selected by default

0 is set by default

String format : any text.
All box is unchecked by
default.

Save

Specify the Event type (SMS, or SNMP Trap) and an event identifier / profile. Up
to 3 event conditions can be specified for defining an event, and the event will
be triggered when all the conditions hold simutaneously (AND relation).

The supported Event types could be:

SMS: Select SMS and fill the message in the textbox to as the trigger condition
for the event;

SNMP: Select SNMP Trap and fill the message in the textbox to specify SNMP
Trap Event;

Note: The available Event Type could be different for the purchased product.
Specify the type of event trigger, either Period or Once.

Period: Select Period and specify a time interval, the event will be repeatedly
triggered on every time interval when the specified event condition holds.
Once: Select Once and the event will be just triggered just one time when the
specified event condition holds.

Specify the repeatedly event trigger time interval.

Value Range: 0 ~86400 seconds.

Enter a brief description for the Managing Event.

Specify Network Status, or at least one rest action to take when the expected
event is triggered.

Network Status: Select Network Status Checkbox to get the network status as
the action for the event;

LAN&VLAN: Select LAN&VLAN Checkbox and the interested sub-items (Port link
On/0ff), the gateway will change the settings as the action for the event;

NAT: Select NAT Checkbox and the interested sub-items (Virtual Server Rule
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On/Off, DMZ On/Off), the gateway will change the settings as the action for the
event;

Firewall: Select Firewall Checkbox and the interested sub-items (Remote
Administrator Host ID On/Off), the gateway will change the settings as the
action for the event;

VPN: Select VPN Checkbox and the interested sub-items (IPSec Tunnel ON/Off,
PPTP Client On/Off, L2TP Client On/Off, OpenVPN Client On/Off), the gateway
will change the settings as the action for the event;

GRE: Select GRE Checkbox and the interested sub-items (GRE Tunnel On/Off),
the gateway will change the settings as the action for the event;

System Manage: Select System Manage Checkbox and the interested sub-items
(WAN SSH Service On/Off, TR-069 On/Off), the gateway will change the settings
as the action for the event;

Administration: Select Administration Checkbox and the interested sub-items
(Backup Config, Restore Config, Reboot, Save Current Setting as Default), the
gateway will change the settings as the action for the event;

Remote Host: Select Remote Host checkbox and a Remote Host profile you
defined as the action for the event;

Note: The available Event Type could be different for the purchased product.

Managing The box is unchecked by Click Enable box to activate this Managing Event setting.

Event default.

Save NA Click the Save button to save the configuration

Undo NA Click the Undo button to restore what you just configured back to the previous
setting.
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7.2.3 Notifying Events

Go to Service > SMS & Event > Notifying Events Tab.

Notifying Events Setting allows administrator to define the relationship (rule) between event trigger and
handlers.

Enable Notifying Events

#* Configuration n ®

Item Setting

» Notifying Events Enable

Configuration

Item Value setting V Description
Notifying Events The box is unchecked by Check the Enable box to activate the Notifying Events function.
default

Create / Edit Notifying Event Rules

Setup your Notifying Event rules. It supports up to a maximum of 128 rules.
= Nosying Event it

Trigger Type | Description

Schedule

Item Setting
» Event | |
MName
'None v |
» Event ' None v |
| None v |
ype
»interval | |0 | (0~86400 seconds)
¥ Description |
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SMS
) Syslog
» Action SNMP Trap (Only Support vi and v2c)
Email Alert
Remote Host
Sc':rerc??le (0) Always ¥
» Notifying 7 Enable

Events

Event None by default Specify the Event type and corresponding event configuration. Up to 3 event
conditions can be specified for defining an event, and the event will be
triggered when all the conditions hold simutaneously (AND relation).
The supported Event Type could be:
Power Change: Select Power Change and a trigger condition to specify the
event on a certain power source.
WAN: Select WAN and a trigger condition to specify a certain WAN Event;
LAN&VLAN: Select LAN&VLAN and a trigger condition to specify a certain
LAN&VLAN Event;
DDNS: Select DDNS and a trigger condition to specify a certain DDNS Event;
Administration: Select Administration and a trigger condition to specify a
certain Administration Event;
Data Usage: Select Data Usage, the SIM Card (Cellular Service) and a trigger
condition to specify a certain Data Usage Event;
Note: The available Event Type could be different for the purchased product.

Description String format : any text. Enter a brief description for the Notifying Event.

Action All box is unchecked by Specify at least one action to take when the expected event is triggered.

default. SMS: Select SMS, and the gateway will send out a SMS to all the defined SMS

accounts as the action for the event;
Syslog: Select Syslog and select/unselect the Enable Checkbox to as the action
for the event;
SNMP Trap: Select SNMP Trap, and the gateway will send out SNMP Trap to
the defined SNMP Event Receivers as the action for the event;
Email Alert: Select Email Alert, and the gateway will send out an Email to the
defined Email accounts as the action for the event;
Remote Host: Select Remote Host checkbox and a Remote Host profile you
defined as the action for the event;
Note: The available Event Type could be different for the purchased product.

Time Schedule (0) Always is selected by Select a time scheduling rule for the Notifying Event.

default

Notifying The box is unchecked by Click Enable box to activate this Notifying Event setting.

Events default.

Save NA Click the Save button to save the configuration

Undo NA Click the Undo button to restore what you just configured back to the previous

setting.
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7.3 Location Tracking

Location tracking applications are usually referred to applications that take benefits from Global Navigation
Satellite System (GNSS). GNSS is the infrastructure that allows devices to determine its position, velocity, and
time by processing satellites signals from outer space. GNSS includes varieties of satellite systems and
Satellite-Based Augmentation Systems (SBAS). SBAS is usually used for improving positioning accuracy. The
tables below show 4 major GNSS system in the world, and SBAS system in different areas.

Major GNSS System in the world

GPS USA

GLONASS Russia

Galileo European Union
BeiDou (COMPASS) China

Satellite-Based Augmentation System (SBAS)

EGNOS Europe

WAAS North America
GAGAN India

MSAS Japan

Position applications are widely-used by varieties of industrial applications, including Location-Based Services
(LBS), Automatic Vehicle Location (AVL), Fleet Management, or assets tracking. However, in most case, GNSS is
a one-way communication. That means GNSS-compatible device can only locate its location by receiving GNSS
signal, but it can’t forward its location data to any other identity through GNSS system. According to this
limitation by GNSS system, devices usually need to equip other technology to transmit their location data to
back-end server for track or further analysis. Furthermore, as the position applications are more applied on
moving objects, a kind of wireless technology would be more suitable to be adopted to transmit location data.
Nowadays, thanks to popularity and wide coverage of cellular technology (GSM, 3G, 4G/LTE), transmitting
location data to remote center in real time is no longer a hurdle. In addition, the data format of location data
is NMEA 0183 compatible, so the back-end server will be easy to interpret the collected location data.

Hereunder are the main features of GNSS function in cellulargateway, if optional GNSS function is supported.
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« Retrieve GNSS data from satellites and send to remote operation center periodically or save in local
storage.

+ Global positioning with multiple GNSS systems, including GPS, and optional for GLONASS, Galileo, or
BeiDou.

« Mandatory for varieties of LBS (Location-Based Service) applications, such as advertisement, emergent
call.

« Easy integration with AVL (Automatic Vehicle Location) applications, for managing fleet of service
vehicles.

« Other value-added applications, such as asset tracking, electronic toll collection, intelligent transport
system.

7.3.1 GNSS

With GNSS configuration page, you can configure those functions that are mentioned above. Please note the
available GNSS features on different models may be different. Please check product datasheet for details.

The configuration steps include following items.

« Activate GNSS feature in gateway and finish settings of cellular WAN.

« Support NMEA 0183 (compatible to 3.0) protocol, and allow customized prefix and suffix.

« Configurable GPS data logging on local microSD card storage for route record tracking.

+ Indicate remote host, time interval, TCP/UDP, and type of GPS data that would be sent.

® GPS Message Type

This item shows all supported types of NMEA 0183 data format. NMEA 0183 data format was defined and
maintained by National Marine Electronics Association (NMEA). Select one or more types that you want to use
for transmitting GPS data. In most case, this configuration depends on which data format that your central
server can recognize. Only select the type you need, otherwise it will consume unnecessary network
bandwidth. The table below shows more information for different types of NMEA 0183 message.

GGA Fix Information SGPGGA,123519,4807.038,N,01131.000,E,1,08,0.9,545.4,M,46.9,M,,*47
GLL Lat/Lon Data SGPGLL,4916.45,N,12311.12,W,225444,A,*1D
GSA Overall Satellite Data SGPGSA,A,3,04,05,,09,12,,,24,,,,,2.5,1.3,2.1*39
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GSV Detailed Satellite Data = $GPGSV,2,1,08,01,40,083,46,02,17,308,41,12,07,344,39,14,22,228,45*75

RMC Recommended SGPRMC,123519,A,4807.038,N,01131.000,E,022.4,084.4,230394,003.1, W*6A
Minimum Data

VTG Vector Track and SGPVTG,054.7,T,034.4,M,005.5,N,010.2,K*48
Speed Over the
Ground

Please note this option is hardware dependent. The available options of GPS message type show on this page
is according to product specification. You may not see all options if your product doesn’t support all of them.
® SBAS

SBAS is Satellite-Based Augmentation Systems that is used to improve accuracy of location data. There are
several SBAS systems for different areas in the world.

EGNOS Europe

WAAS North America
GAGAN India

MSAS Japan

Please note this option is hardware dependent. You may not see this option if your product doesn’t support it.

® Assisted GPS

Assisted GPS (as known as A-GPS) is used for speeding up location fix, especially when satellite signal is weak.
If activating this option, gateway will download almanac data from A-GPS server through IP network instead of
from satellite. You can also choose different valid period of almanac data. The shorter almanac data will get
higher accuracy. However, the almanac data with shorter valid period needs to be updated more frequently. It
will consume more network bandwidth. Please note this option is hardware dependent. You may not see this
option if your product doesn’t support it.

® Data to Storage

Besides transmitting location data to remote server, you can also store location data into internal storage (e.g.
microSD card) or external storage (e.g. USB drive) if any. Regarding to data format, either can be NMEA 0183
raw data format or save it as GPX file format. The location data will be saved to a new file if the original file
size is bigger than the pre-defined file size. The “Download log file” button allows you to browse all saved log
files and download to your personal devices.
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»  Scenario of location tracking for fleet management

A fleet owner would like to see the locations of his trucks in real time. He also likes to know where his trucks
have been passed through with time information. In his operation office, there is a server (IP: 100.100.100.1)
which can interpret NMEA RMC data format and shows truck’s location and track on map. This server is
listening on TCP port 888 to receive NMEA RMC packet from trucks. IMEI number will be added before NMEA
RMC data for identification of each truck. Hereunder is the configuration on each truck.

Basic Settings:

GNSS Enable
GNSS Type GPS
GPS Message Types RMC
SBAS Enable
Assisted GPS Enable, 1
Data to Storage Disable

Settings for Remote Host:

Host Name Truck-1

Host IP 100.100.100.1
Protocol Type TCP

Port Number 888

Interval(s) 15

Prefix Message 123456789012345
Suffix Message [blank]

Enable Checkbox [Checked]
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GNSS Setting

Go to Service>Location Tracking> GNSS Tab.

The GNSS allows user to set the configuration of GNSS, log NMEA data to storage, and send data to remote
host.Ensure GNSS is enabled and saved

Setup GNSS Configuration

Item
» GNSS
» GNSS Type
F GNSS Message Types
b Assisted GPS

¥ Data to Storage

GNSS Enable

GNSS Type

GNSS Message Types

SBAS

Assisted GPS

¥ Enable
GPS v
¢ RMC
¥ Enable
Enable
Interval: |5

Data format

Data file name:

Split file:

¥ || Download log file

The box is unchecked
by default

GPS is selected by
default

These box is
unchecked by default.

The box is unchecked
by default

The box is checked by
default

Select Device

Enable Size: (200

Setting

Internal v

(=)

Delete log file

Check Enable box to activate GNSS functions.

Select a GNSS Type (GNSS System) that you want to use.

Please note this option is hardware dependent. The available options of GNSS
type show on this page is according to product specification. You may not see
all of these four options if your product doesn’t support all of them.

Select one or more GNSS Message Types that you want to use for transmitting
or recording GPS data.

There are many sentences in the NMEA standard for selecting, GGA, GLL, GSA,
GSV, RMC and VTG. ALL Other includes DTM, GNS, GRS, GST, ZDA, and GBS
sentences.

Only select the type you need, otherwise it will consume unnecessary network
bandwidth.

Note: The supported message type is hardware dependent.

Check Enable box to activate satellite-based augmentation system (SBAS).
Note: Some devices do not support this function.

Check Enable box to activate Assisted GPS (A-GPS).

Select the duration for downloading the Differential Almanac Corrections data
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from A-GPS server through IP network.
Note: Some devices may not support this function.
Data to Storage The box is unchecked (] Enable (The box is unchecked by default)
by default Check Enable box to activate data to storage function.

® Select Device (A Must filled setting)
Select Internal or External device to store log data.

(] Interval (A Must filled setting)
Specify the time interval between two continuous data log. By default, 5
second is set.
Value Range:5 ~ 60 seconds.

) Data Format(A Must filled setting)
Select data format (RAW, or GPX) to store.

(] Data file name(A Must filled setting)
Define file name to store.

[ ] Split Enable
Check Enable box to activate file splitting function.

® Split Size& Unit
Define file size and unit for log file. By default, 200 KB is defined.
Value Range:>= 10KB (Minimum file size is 10 KB).

(] Download log file
Select a log file and Click Download log file to download through Web
GUI. If the log format which is specified to download is GPX, we will
convert standard GPX format for used.

Save NA Click the Save button to save the configuration

Create / Edit Remote Host

The Remote Host allows you to customize your rules for sending NMEA data to specific IP address and Port.
The router supports up to a maximum of 10 rule sets.

Add || Delete
ID | Host Name Host IP Protocol Port Interval(s) Ag‘c#gss Prefix Suffix Enable Actions
Type Number Message Message Message

When Add button is applied, Remote Host Configuration screen will appear.
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* Remote Host Configuration

Item

Setting

r Host Name

¥ HostIP

» Protocol Type

¥ Port Mumber

¥ Interval(s)

r MAC Address Message

r Prefix Message

v Suffie Message

r Enable

\ Remote Host Configuration

alue setting Descr n

Host Name String format: any text  Enter the host name for the designated remote host.
Value Range:-1 ~ 64 characters.
Host IP A Must filled setting Specify the IP Addressof remote host. It will be use as destination IP for sending

NMEA packets.

Protocol Type

TCP is selected by
default

Specify the Protocol (TCP or UDP) to use for sending NMEA packets.

Port Number

A Must filled setting

Specify a Port Number as destination port for sending NMEA packets.
Value Range:1 ~ 65535.

Interval(s) A Must filled setting Specify the time interval (seconds) between two NMEA packets.

Value Range:1 ~255 seconds.
MAC Address The box is unchecked Check Enable box to send the device MAC address with the NMEA packets, and
Message by default then your backend server can recognize this GPS data is sent from this device.

Prefix Message

String format: any text

Specify optional prefix string with specific information if your backend server
can recognize.

For example, you can input the IMEI code of this device here, and then your
backend server can recognize this GPS data is sent from this device. You can
also leave this field blank.

Suffix Message String format: any text  Specify optional suffix string with specific information if your backend server
can recognize.
Enable The box is unchecked Check Enable box to activate this remote host rule.
by default
Save NA Click the Save button to save the configuration
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Chapter 8 Status

8.1 Dashboard

Device Up-Time: 3day Ohr 22min 32sec

CPU: § 8%
Memory: s

Connection Sessions:

| Basic Network ' -
[- ] ]

@ Object Definition | Current
I I Device| Type | Uplead Traffic D':.‘;nf:_?ém Uplg:g ?.?;fﬁ i Download

Traffic

|® Field Communication | sth? | Sthemst| 190 (MB) 31 (MB) 3(KB) 2 (KB)

= sth21 | Cthemst| 24 (MB) 49 (KB) 18 (Bytes) 0 (Bytes)
| E) Security ! . | |

eth2.2 Elhernet. 147 (MB) 273 (MB) 3 (KB) 2 (KB}

Ie | b0 |Ethemet| 19 (M) 0 8) 0 (Bytee) 0 (Bytes) 10:04:40  10:04:50 10:05:00 100510 10:05:20 10:05:30

8.1.1 Device Dashboard

The Device Dashboard window shows the current status in graph or tables for quickly understanding the
operation status for the gateway. They are the System Information, System Information History, and Network
Interface Status. The display will be refreshed once per second.

From the menu on the left, select Status > Dashboard > Device Dashboard tab.

System Information Status
The System Information screen shows the device Up-time and the resource utilization for the CPU, Memory,
and Connection Sessions.

% System Information - | %

Device Up-Time: 3day 1hr 21min 48sec

CPU: § 10%
Memory: s 599%
Connection Sessions: 0%
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System Information History
The System Information History screen shows the statistic graphs for the CPU and memory.

-] o B, Sec v
o X 250 MB
o Memory
Ik 225 MB
- CPU 1
; CPU2 200 MB
80% B CPU3 e
c 2
70% o sl
& MBH- -
60%
_ 125 MB
50%
40% 18
30% e 75 MB
20% | : i 50 MB
10% D D _ 25 MB
0% L= a1 0 MB
SO B O I DR L B R ) 11:0520 11:05:30 11:05:40 11:0550 11:06:00 11:06:10

Network Interface Status

The Network Interface Status screen shows the statistic information for each network interface of the
gateway. The statistic information includes the Interface Type, Upload Traffic, Download Traffic, and Current
Upload / Download Traffic.

- - »

Current Current
. Upload | Download
Device| Type Traffic Traffic Uplead | Download

Traffic Traffic
eth2 |Ethernet| 211 (MB) | 321 (MB) 3 (KB) 3 (KB)

eth21 Ethernet| 24 (MB) | 71(KB) | 64 (Bytes) O (Bytes)
eth22  Ethernet 168 (MB) | 283 (MB) 3 (KB) 3 (KB)

bri0 | Ethemet| 19(MB) = 31(MB) | 42 (Bytes) | O (Bytes)

a0 | WIRSS 1mB) | 1MB) | D(Byles) 0 (Bytes)

rain | VSRS 21MB) | 42(MB) | 0(Bytes) | 0(Bytes)

rat | W/SESS| g(Bytes) | 0(Bytes) | O(Bytes) O (Bytes)

Wireless 362

rai1 LAN | (Bytes) 4 (KB) 0 (Bytes) | O (Bytes)

tun0 | Ethemet| O (Bytes) | 0 (Bytes) | 0(Byles) 0 (Bytes)
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8.2 Basic Network

8.2.1 WAN & Uplink Status

Go to Status > Basic Network > WAN & Uplink tab.

The WAN & Uplink Status window shows the current status for different network type, including network
configuration, connecting information, modem status and traffic statistics. The display will be refreshed on
every five seconds.

WAN interface IPv4 Network Status

WAN interface IPv4 Network Status screen shows status information for IPv4 network.

ID | Interface | WAN Type | Network Type IP Addr. Subnet Mask Gateway DNS MAC Address | Conn. Status | Action
WAN-1| 3G/4G 3G/4G NAT 10.59.152.73 | 255255255252 10.59.152.74 o891 N/A Comnected || Egit
' - - T [ A 166.95.192.1 ) 0 day 0:26:35

ID N/A It displays corresponding WAN interface WAN IDs.
Interface N/A It displays the type of WAN physical interface.
Depending on the model purchased, it can be Ethernet, 3G/4G, etc...
It displays the method which public IP address is obtained from your ISP.
WAN Type N/A Depending on the model purchased, it can be Static IP, Dynamic IP, PPPoE,
PPTP, L2TP, 3G/4G.

It displays the network type for the WAN interface(s).

Network Type N/A Depending on the model purchased, it can be NAT, Routing, Bridge, or IP Pass-
through.

IP Addr. N/A It dlspla\./s the public IP adfiress obta?med from yc.)ur ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.

Subnet Mask N/A It displays the Subnet Mask for public IP address obtained from your ISP for
Internet connection. Default value is 0.0.0.0 if left unconfigured.
It displ IP i | |

Gateway N/A t displays the Gateway IP address obtained from your ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.

DNS N/A It displays the IP address of DNS server obtained from your ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.

MAC Address N/A It displays the MAC Ai‘ddre.ss for your ISP to allow you for Internet access. Note:
Not all ISP may require this field.

Conn. Status N/A It displays the connection status of the device to your ISP.
Status are Connected or disconnected.

Action N/A This area provides functional buttons.
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Renew button allows user to force the device to request an IP address from
the DHCP server. Note: Renew button is available when DHCP WAN Type is
used and WAN connection is disconnected.

Release button allows user to force the device to clear its IP address setting to
disconnect from DHCP server. Note: Release button is available when DHCP
WAN Type is used and WAN connection is connected.

Connect button allows user to manually connect the device to the Internet.
Note: Connect button is available when Connection Control in WAN Type
setting is set to Connect Manually (Refer to Edit button in Basic Network >
WAN & Uplink > Internet Setup) and WAN connection status is disconnected.

Disconnect button allows user to manually disconnect the device from the
Internet. Note: Connect button is available when Connection Control in WAN
Type setting is set to Connect Manually (Refer to Edit button in Basic Network
> WAN & Uplink > Internet Setup) and WAN connection status is connected.

LAN Interface Network Status

LAN Interface Network Status screen shows IPv4 and IPv6 information of LAN network.

IPv4 Address IPv4 Subnet Mask MAC Address Action

192.168.123.254 255.255.255.0 00:50:18:00:0F:FE Edit IPv4

[=}]

It displays the current IPv4 IP Address of the gateway

IPv4 Address N/A . il
This is also the IP Address user use to access Router’s Web-based Utility.
IPv4 Subnet Mask N/A It displays the current mask of the subnet.
MAC Address N/A It displays the LAN MAC Address of the gateway
This area provides functional buttons.
Action N/A Edit IPv4 Button when press, web-based utility will take you to the Ethernet

LAN configuration page. (Basic Network > LAN & VLAN > Ethernet LAN tab).
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3G/4G Modem Status

3G/4G Modem Status List screen shows status information for 3G/4G WAN network(s).
= 3G/4G Modem Status List ’ X

Interface Card Information Link Status Signal Strength Network Name Action

3GMAG ZMB620 Connected 70% (-69dBm) Chunghwa Telecom (LTE)

3G/4G Modem Status List

‘ Item Value setting Description

It displays the type of WAN physical interface.

Physical . . o

Interface N/A Note: Some device model may support two 3G/4G modules. Their physical interface
name will be 3G/4G-1 and 3G/4G-2.

Card .

Information N/A It displays the vendor’s 3G/4G modem model name.

Link Status N/A It displays the 3G/4G connection status. The status can be Connecting, Connected,

Disconnecting, and Disconnected.

Signal . . .
Strength N/A It displays the 3G/4G wireless signal level.
Network . . .
N N/A It displays the name of the service network carrier.

ame
Refresh N/A Click the Refresh button to renew the information.

This area provides functional buttons.

Action N/A Detail Button when press, windows of detail information will appear. They are the

Modem Information, SIM Status, and Service Information. Refer to next page for

more.

When the Detail button is pressed, 3G/4G modem information windows such as Modem Information, SIM
Status, Service Information, Signal Strength / Quality, and Error Message will appear.

Interface Traffic Statistics

Interface Traffic Statistics screen displays the Interface’s total transmitted packets.
# Interface Traffic Statistics

D Interface Received Packets(Mb) Transmitted Packets(Mb) Action

WWAN-
R 21713 167.09 | |

Interface Traffic Statistics

Item Value setting Description
ID N/A It displays corresponding WAN interface WAN IDs.

It displays the type of WAN physical interface.

Interface N/A . .
Depending on the model purchased, it can be Ethernet, 3G/4G, etc...
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Received Packets It displays the downstream packets (Mb). It is reset when the device is
N/A
(Mb) rebooted.
Transmitted Packets . . L
(Mb) N/A It displays the upstream packets (Mb). It is reset when the device is rebooted.
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8.2.2 LAN & VLAN Status

Go to Status > Basic Network > LAN & VLAN tab.

Client List

The Client List shows you the LAN Interface, IP address, Host Name, MAC Address, and Remaining Lease Time
of each device that is connected to this gateway.

_

LAN Interface

IP Address

Host Name MAC Address

Remaining Lease Time

Ethemet

Dynamic / 192.165.66.100

amit26613572 00-13-3B-0E-5B-1D

00:15:00

LAN Client List
Item

Value setting

: Description

Time

LAN Interface N/A Client record of LAN Interface. String Format.
1P Address N/A Client record of IP Address Type and the IP Address. Type is String Format and
the IP Address is IPv4 Format.
Host Name N/A Client record of Host Name. String Format.
MAC Address N/A Client record of MAC Address. MAC Address Format.
Remaining Lease . - . .
N/A Client record of Remaining Lease Time. Time Format.
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8.2.3 WiFi Status (not supported)

Not supported feature for the purchased product, leave it as blank.
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8.2.4 DDNS Status

Go to Status > Basic Network > DDNS tab.

The DDNS Status window shows the current DDNS service in use, the last update status, and the last update
time to the DDNS service server.

DDNS Status

Host Name Provider Effective IP Last Update Status Last Update Time

DDNS Status

Item Value Setting Description

Host Name N/A It displays the name you entered to identify DDNS service provider

Provider N/A It displays the DDNS server of DDNS service provider

Effective IP N/A It displays the public IP address of the device updated to the DDNS server

Last Update It displays whether the last update of the device public IP address to the DDNS
N/A . .

Status server has been successful (Ok) or failed (Fail).

Last Update Time  N/A It displays time stamp of the last update of public IP address to the DDNS server.

Refresh N/A The refresh button allows user to force the display to refresh information.
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8.3 Security

| @. Status Firewall

+ Dashboard
*'Basic Network =) IPSec Tunnel Status  [Ree0:
._Em Local Subnets Remote IP/FQDN Remote Subnets Conn. Time

Firewall

* Administration Remote IP/FQDN Virtual IP/Mac Conn. Time
+ Statistics & Reporis

| Basic Network

| @ Object Definition ” Master_client WAN 1 m2mclusterde / 172.17.0.190 00:00:00:44 Connected

= OpenVPN Client Status SR IEEEN

OpenVPN Client Name Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status

|® Field Communication »

Remote IP Remote Virtual IP Remote Call ID Conn. Time

' Security
l Administration

tats

L2TP Client Name | Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time

8.3.1 VPN Status

Go to Status > Security > VPN tab.

The VPN Status widow shows the overall VPN tunnel status. The display will be refreshed on every five
seconds.

IPSec Tunnel Status

IPSec Tunnel Status windows show the configuration for establishing IPSec VPN connection and current
connection status.

« IPSec Tunnel Status = 3

Remote IP/FQDN

IPSec Tunnel Status

Tunnel Name Tunnel Scenario Local Subnets Remote Subnets Conn. Time

Item Value setting Description

Tunnel Name N/A It displays the tunnel name you have entered to identify.
Tunnel Scenario N/A It displays the Tunnel Scenario specified.

Local Subnets N/A It displays the Local Subnets specified.
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Remote IP/FQDN N/A It displays the Remote IP/FQDN specified.
Remote Subnets N/A It displays the Remote Subnets specified.
Conn. Time N/A It displays the connection time for the IPSec tunnel.

It displays the Status of the VPN connection. The status displays are
Connected, Disconnected, Wait for traffic, and Connecting.

Click on Edit Button to change IPSec setting, web-based utility will take you
to the IPSec configuration page. (Security > VPN > IPSec tab)

Status N/A

Edit Button N/A

OpenVPN Server Status

According to OpenVPN configuration, the OpenVPN Server/Client Status shows the status and statistics for
the OpenVPN connection from the server side or client side.

% OpenVPN Server Sutus..

User Name Remote IP/FQDN Virtual IP/Mac Conn. Time

OpenVPN Server Status

Item Value setting Description

User Name N/A It displays the Client name you have entered for identification.

Remote N/A It displays the public IP address (the WAN IP address) of the connected

IP/FQDN OpenVPN Client

Virtual IP/MAC N/A It displays the virtual IP/MAC address assigned to the connected OpenVPN
client.

Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.

Status N/A It displays the connection status of the corresponding OpenVPN tunnel.
The status can be Connected, or Disconnected.

OpenVPN Client Status

= OpenVPN Client Status[[R LI

OpenVPN Client Name

Conn. Status

Virtual IP Conn. Time

Remote Subnet

Interface Remote IP/FQDN

OpenVPN Client Status
Item Value setting Description

OpenVPN Client N/A It displays the Client name you have entered for identification.

Name

Interface N/A It displays the WAN interface specified for the OpenVPN client connection.
Remote N/A It displays the peer OpenVPN Server’s Public IP address (the WAN IP address) or
IP/FQDN FQDN.

Remote Subnet N/A It displays the Remote Subnet specified.

TUN/TAP N/A It displays the TUN/TAP Read Bytes of OpenVPN Client.

Read(bytes)

TUN/TAP N/A It displays the TUN/TAP Write Bytes of OpenVPN Client.

Write(bytes)

TCP/UDP N/A It displays the TCP/UDP Read Bytes of OpenVPN Client.

Read(bytes)

266



4G WAN Extender

TCP/UDP N/A It displays the TCP/UDP Write Bytes of OpenVPN Client.

Write(bytes) Connection

Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.
Conn. Status N/A It displays the connection status of the corresponding OpenVPN tunnel.

The status can be Connected, or Disconnected.
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L2TP Server/Client Status

LT2TP Server/Client Status shows the configuration for establishing LT2TP tunnel and current connection
status.

Remote Call ID Conn. Time

Remote IP Remote Virtual IP

L2TP Server Status
Item Value setting Description
User Name N/A It displays the login name of the user used for the connection.
Remote IP N/A It displays the public IP address (the WAN IP address) of the connected L2TP
client.
Remote Virtual IP N/A It displays the IP address assigned to the connected L2TP client.
Remote Call ID N/A It displays the L2TP client Call ID.
Conn. Time N/A It displays the connection time for the L2TP tunnel.
It displays the Status of each of the L2TP client connection. The status
Status N/A
displays Connected, Disconnect, Connecting
Edit N/A Click on Edit Button to change L2TP server setting, web-based utility will

take you to the L2TP server page. (Security > VPN > L2TP tab)

= L2TP Client Status "

Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time Status

L2TP Client Name

L2TP Client Status

Item Value setting Description

Client Name N/A It displays Name for the L2TP Client specified.

Interface N/A It displays the WAN |nte'rface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.

Virtual IP N/A It displays the IP address assigned by Virtual IP server of L2TP server.

Remote IP/FQDN N/A It displays the L2TP Server’s Public IP address (the WAN IP address) or
FQDN.

Default It displays the specified IP address of the gateway device used to connect to

etau the internet to connect to the L2TP server —the default gateway. Or other

Gateway/Remote N/A o ) )

Subnet specified subnet if the default gateway is not used to connect to the L2TP
server —the remote subnet.

Conn. Time N/A It displays the connection time for the L2TP tunnel.

Status N/A It displays the Status of the VPN connection. The status displays Connected,
Disconnect, and Connecting.

Edit N/A Click on Edit Button to change L2TP client setting, web-based utility will take

you to the L2TP client page. (Security > VPN > L2TP tab)
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PPTP Server/Client Status

« PPTP Server Status =i

Remote Call ID

Remote Virtual IP

User Name Remote IP

PPTP Server Status

Item Value setting Description

User Name N/A It displays the login name of the user used for the connection.

Remote IP N/A It displays the public IP address (the WAN IP address) of the connected PPTP
client.

Remote Virtual IP N/A It displays the IP address assigned to the connected PPTP client.

Remote Call ID N/A It displays the PPTP client Call ID.

Conn. Time N/A It displays the connection time for the PPTP tunnel.
It displays the Status of each of the PPTP client connection. The status

Status N/A . . .
displays Connected, Disconnect, and Connecting.

Edit Button N/A Click on Edit Button to change PPTP servser setting, web-based utility will
take you to the PPTP server page. (Security > VPN > PPTP tab)

« PPTP Client Status = 3

ID| PPTP Client Name | Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time | Status

PPTP Client Status

Item Value setting Description

Client Name N/A It displays Name for the PPTP Client specified.

Interface N/A It displays the WAN interface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.

Virtual IP N/A It displays the IP address assigned by Virtual IP server of PPTP server.

Remote IP/FQDN N/A It displays the PPTP Server’s Public IP address (the WAN IP address) or
FQDN.
It displays the specified IP address of the gateway device used to connect to

Default Gateway / N/A the internet to connect to the PPTP server —the default gateway. Or other

Remote Subnet specified subnet if the default gateway is not used to connect to the PPTP
server —the remote subnet.

Conn. Time N/A It displays the connection time for the PPTP tunnel.

Status N/A It.dlsplays the Status of the VPN connection. The status displays Connected,
Disconnect, and Connecting.

Edit Button N/A Click on Edit Button to change PPTP cllen.t setting, web-based utility will
take you to the PPTP server page. (Security > VPN > PPTP tab)
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8.3.2 Firewall Status

Go to Status > Security > Firewall Status Tab.
The Firewall Status provides user a quick view of the firewall status and current firewall settings. It also keeps

the log history of the dropped packets by the firewall rule policies, and includes the administrator remote
login settings specified in the Firewall Options. The display will be refreshed on every five seconds.

By clicking the icon [+], the status table will be expanded to display log history. Clicking the Edit button the
screen will be switched to the configuration page.

Packet Filter Status

Activated Filter Rule Detected Contents

\ Packet Filter Status

Item Value setting Description
Activated Filter o .
Rule N/A This is the Packet Filter Rule name.

This is the logged packet information, including the source IP, destination IP,

Detected protocol, and destination port —the TCP or UDP.
Contents N/A String format:
Source IP to Destination IP : Destination Protocol (TCP or UDP)
IP N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"

"Day" "Hours":"Minutes":"Seconds")
Note: Ensure Packet Filter Log Alert is enabled.
Refer to Security > Firewall > Packet Filter tab. Check Log Alert and save the setting.

URL Blocking Status

Activated Blocking Rule Blocked URL

URL Blocking Status

Item Value setting Description

Activated o .

Blocking Rule N/A This is the URL Blocking Rule name.
Blocked URL N/A This is the logged packet information.

IP N/A The Source IP (IPv4) of the logged packet.
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The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure URL Blocking Log Alert is enabled.

Refer to Security > Firewall > URL Blocking tab. Check Log Alert and save the setting.

Time N/A

Web Content Filter Status

%1 Web Content Filters

Detected Contents

Activated Filter Rule

Web Content Filter Status

Item Value setting Description

Activated Filter .

Rule N/A Logged packet of the rule name. String format.

Detected q ket of the fi | ine f

Contents N/A Logged packet of the filter rule. String format.

IP N/A Logged packet of the Source IP. IPv4 format.

Time N/A Logged pacl.<et of the Date Time. Date time format ("Month" "Day
"Hours":"Minutes":"Seconds")

Note: Ensure Web Content Filter Log Alert is enabled.

Refer to Security > Firewall > Web Content Filter tab. Check Log Alert and save the setting.

MAC Control Status

Activated Control Rule Blocked MAC Addresses

MAC Control Status

Item Value setting Description
Activated o
N/A This is the MAC Control Rule name.
Control Rule
Blocked MAC -
Addresses N/A This is the MAC address of the logged packet.
IP N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure MAC Control Log Alert is enabled.
Refer to Security > Firewall > MAC Control tab. Check Log Alert and save the setting.
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Application Filters Status

Filtered Application Category Filtered Application Name

Application Filters Status

Item Value setting Description

Filtered Application o .

Category N/A The name of the Application Category being blocked.

Filtered Application o .

Name N/A The name of the Application being blocked.

IP N/A The Source IP (IPv4) of the logged packet.

Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure Application Filter Log Alert is enabled.
Refer to Security > Firewall > Application Filter tab. Check Log Alert and save the setting.

IPS Status

Detected Intrusion

IPS Firewall Status

Item Value setting Description

Detected his is the intrusi f the packets being blocked
Intrusion N/A This is the intrusion type of the packets being blocked.
IP N/A The Source IP (IPv4) of the logged packet.

Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month" "Day

"Hours":"Minutes":"Seconds")
Note: Ensure IPS Log Alert is enabled.
Refer to Security > Firewall > IPS tab. Check Log Alert and save the setting.
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Firewall Options Status

= Options | Edit |

Stealth Mode SPI Discard Ping from WAN Remote Administrator Management

Disable Disable Disable IP: 192.1658.121.24, User Name: admin, Time: Apr 1 11:14:54

Firewall Options Status

Item Value setting Description
Enable or Disable setting status of Stealth Mode on Firewall Options.
String Format: Disable or Enable

Stealth Mode N/A

Enable or Disable setting status of SPI on Firewall Options.

String Format : Disable or Enable

Enable or Disable setting status of Discard Ping from WAN on Firewall
N/A Options.

SPI N/A

Discard Ping from

WAN

String Format: Disable or Enable

Enable or Disable setting status of Remote Administrator.

If Remote Administrator is enabled, it shows the currently logged in
Remote administrator’s source IP address and login user name and the login time.
Administrator N/A Format:
Management IP : "Source IP", User Name: "Login User Name", Time: "Date time"

Example:

IP: 192.168.127.39, User Name: admin, Time: Mar 3 01:34:13
Note: Ensure Firewall Options Log Alert is enabled.
Refer to Security > Firewall > Options tab. Check Log Alert and save the setting.
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8.4 Administration

8.4.1 Configure & Manage Status

Go to Status > Administration > Configure & Manage tab.

The Configure & Manage Status window shows the status for managing remote network devices. The type of
management available in your device is depended on the device model purchased. The commonly used ones
are the SNMP, TR-069, and UPnP. The display will be refreshed on every five seconds.

SNMP Linking Status

SNMP Link Status screen shows the status of current active SNMP connections.
« SNMP Linking Status

Auth. Mode SNMP Version

IP Address

User Name Community Privacy Mode

SNMP Link Status
Item Value setting Description

It displays the user name for authentication. This is only available for SNMP
User Name N/A .
version 3.
IP Address N/A It displays the IP address of SNMP manager.
It displays the port number used to maintain connection with the SNMP
Port N/A
manager.
Community N/A It displays the community for SNMP version 1 or version 2c only.
Auth. Mode N/A It displays the authentication method for SNMP version 3 only.
Privacy Mode N/A It displays the privacy mode for version 3 only.
SNMP Version N/A It displays the SNMP Version employed.

SNMP Trap Information

SNMP Trap Information screen shows the status of current received SNMP traps.

# SNMP Trap Information

Trap Event

Trap Level

| SNMP Trap Informaton
Item Value setting Description
Trap Level N/A It displays the trap level.
Time N/A It displays the timestamp of trap event.
Trap Event N/A It displays the IP address of the trap sender and event type.
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TR-069 Status

TR-069 Status screen shows the current connection status with the TR-068 server.

« TR.069 Status ’ x

Link Status

Off

TR-069 Status

\ Item Value setting Description
It displays the current connection status with the TR-068 server. The connection
Link Status N/A status is either On when the device is connected with the TR-068 server or Off

when disconnected.
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8.4.2 Log Storage Status

Go to Status > Administration > Log Storage tab.

The Log Storage Status screen shows the status for selected device storage.

Log Storage Status

Log Storage Status screen shows the status of current the selected device storage. The status includes Device
Description, Usage, File System, Speed, and status.

Device Description File System
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8.4.3 GNSS Status

Go to Status > Administration > GNSS tab.

The GNSS Information screen shows the status for current GNSS positioning information for the gateway.

« GNSS Information . %

. No. of Satellites ID / . .
Condition Satellites  Signal Strength (dBm) Position (Lat, Long) Altitude (meters) | True Course Ground Speed (km/h)
Mot Fixed 0 , 0 0.00

The available GNSS information includes GNSS Condition, No. of Satellites, Satellites ID / Signal Strength,
Position (Lat., Long.), Altitude (meters), True Course, and the equivalent Ground Speed (km/h).
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8.5 Statistics & Report

8.5.1 Connection Session

Go to Status > Statistics & Reports > Connection Session tab.

Internet Surfing Statistic shows the connection tracks on this router.

Last || Export (xml) || Export (_.csv)

= Internet Surfing List (14 entries) W01

' Refresh
User Name Protocol Internal IP & Port MAC External IP & Port Duration Time
UDP 192.168.127.58:3847 §5.196.95.100:1194 2019/04/01 12:09~
UDP 192.168.127.55:44586 192.166.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:2899 192.166.123.10:53 20159/04/01 12:09~
UDP 192.168.127.58:1251 192.166.123.10:53 2015/04/01 12:09~
UDP 192.168.127.58:3145 192.166.123.10:53 2015/04/01 12:09~

Internet Surfing Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of track list.
Next N/A Click the Next button; you will see the next page of track list.

First N/A Click the First button; you will see the first page of track list.

Last N/A Click the Last button; you will see the last page of track list.

Export (.xml) N/A Click the Export (.xml) button to export the list to xml file.

Export (.csv) N/A Click the Export (.csv) button to export the list to csv file.

Refresh N/A Click the Refresh button to refresh the list.

278



4G WAN Extender
8.5.2 Network Traffic (not supported)

Not supported feature for the purchased product, leave it as blank.
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8.5.3 Login Statistics

Go to Status > Statistics & Reports > Login Statistics

Login Statistics shows the login information.

= Device Manager Login Stafistics [l 5 =1U011E3 i Export (xml) || Export (.csv)

User Name Protocol Type IP Address Info Duration Time
admin HTTP 192.168.123.190 Admin 2018/01/01 00:00~
admin HTTP 192.168.123.190 Admin 2018/01/01 00:02~
admin HTTF 192 168123190 Login Fail 2019/06/05 16:30~
admin HTTP 192.168.123.190 Admin 2019/06/05 16:30~

Device Manager Login Statistic :

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of login statistics.
Next N/A Click the Next button; you will see the next page of login statistics.

First N/A Click the First button; you will see the first page of login statistics.

Last N/A Click the Last button; you will see the last page of login statistics.

Export (.xml) N/A Click the Export (.xml) button to export the login statistics to xml file.
Export (.csv) N/A Click the Export (.csv) button to export the login statistics to csv file.
Refresh N/A Click the Refresh button to refresh the login statistics.
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8.5.4 Cellular Usage

Go to Status > Statistics & Reports > Cellular Usage tab.

Cellular Usage screen shows data usage statistics for the selected cellular interface. The cellular data usage
can be accumulated per hour or per day.

" Data Usage Records
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Appendix A GPL WRITTEN OFFER

This product incorporates open source software components covered by the terms of third party copyright notices
and license agreements contained below.

GPSBabel

Version 1.4.4

Copyright (C) 2002-2005 Robert Lipe<robertlipe@usa.net>
GPL License: https://www.gpsbabel.org/

Curl

Version 7.19.6

Copyright (c) 1996-2009, Daniel Stenberg, <daniel@haxx.se>.
MIT/X derivate License: https://curl.haxx.se/

OpenSSL

Version 1.0.2m

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
GPL License: https://www.openssl.org/

brctl - ethernet bridge administration

Stephen Hemminger <shemminger@osdl.org>

Lennert Buytenhek <buytenh@gnu.org>

version 1.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

tc - show / manipulate traffic control settings

Stephen Hemminger<shemminger@osdl.org>

Alexey Kuznetsov<kuznet@ms2.inr.ac.ru>

version iproute2-ss050330

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

dhcp-fwd — starts the DHCP forwarding agent

Enrico Scholz <enrico.scholz@informatik.tu-chemnitz.de>
version 0.7

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Iftp - Sophisticated file transfer program

Alexander V. Lukyanov <lav@yars.free.net>

version:4.5.x

Copyright (c) 1996-2014 by Alexander V. Lukyanov (lav@yars.free.net)

dnsmasq - A lightweight DHCP and caching DNS server.
Simon Kelley <simon@thekelleys.org.uk>

version:2.72

dnsmasq is Copyright (c) 2000-2014 Simon Kelley
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socat - Multipurpose relay
Version: 2.0.0-b8

GPLv2
http://www.dest-unreach.org/socat/

LibModbus

Version: 3.0.3

LGPL v2
http://libmodbus.org/news/

LibIEC60870

GPLv2

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

https://sourceforge.net/projects/mrts/

Openswan

Version: v2.6.38 GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

https://www.openswan.org/

Opennhrp

Version: v0.14.1

OpenNHRP is an NHRP implementation for Linux. It has most of the RFC2332
and Cisco 10S extensions.

Project homepage: http://sourceforge.net/projects/opennhrp

Git repository: git://opennhrp.git.sourceforge.net/gitroot/opennhrp
LICENSE

OpenNHRP is licensed under the MIT License. See MIT-LICENSE.txt for
additional details.

OpenNHRP embeds libev. libev is dual licensed with 2-clause BSD and
GPLv2+ licenses. See libev/LICENSE for additional details.

OpenNHRP links to c-ares. c-ares is licensed under the MIT License.
https://sourceforge.net/projects/opennhrp/

IPSec-tools

Version: v0.8

No GPL be written
http://ipsec-tools.sourceforge.net/

PPTP
Version: pptp-1.7.1
GNU GENERAL PUBLIC LICENSE Version 2, June 1991
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Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://pptpclient.sourceforge.net/

PPTPServ

Version: 1.3.4

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed. http://poptop.sourceforge.net/

L2TP

Version: 0.4

Copying All software included in this package is Copyright 2002 Roaring
Penguin Software Inc. You may distribute it under the terms of the

GNU General Public License (the "GPL"), Version 2, or (at your option)
any later version.

http://www.roaringpenguin.com/

L2TPServ

Version: v 1.3.1 GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://www.xelerance.com/software/x12tpd/

Mpstat: from sysstat, system performance tools for Linux
Version: 10.1.6
Copyright: (C) 1999-2013 by Sebastien Godard (sysstat <at> orange.fr)

SSHD: dropbear, a SSH2 server
Version: 0.53.1
Copyright: (c) 2002-2008 Matt Johnston

Libncurses: The ncurses (new curses) library is a free software emulation of curses in System V Release 4.0
(SVr4), and more.

\ersion: 5.9

Copyright: (c) 1998,2000,2004,2005,2006,2008,2011,2015 Free Software Foundation, Inc., 51 Franklin Street,
Boston, MA 02110-1301, USA

MiniUPnP: The miniUPNnP daemon is an UPnP IGD (internet gateway device) which provide NAT traversal
services to any UPnP enabled client on the network.

Version: 1.7

Copyright: (c) 2006-2011, Thomas BERNARD
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CoovaChilli is an open-source software access controller for captive portal (UAM) and 802.1X access
provisioning.

Version: 1.3.0

Copyright: (C) 2007-2012 David Bird (Coova Technologies) <support@coova.com>

Krb5: Kerberos is a network authentication protocol. It is designed to provide strong authentication for
client/server applications by using secret-key cryptography.

Version: 1.11.3

Copyright: (C) 1985-2013 by the Massachusetts Institute of Technology and its contributors

OpenLDAP: a suite of the Lightweight Directory Access Protocol (v3) servers, clients, utilities, and
development tools.

\ersion: 2.4

Copyright: 1998-2014 The OpenLDAP Foundation

Samba3311: the free SMB and CIFS client and server for UNIX and other operating systems
Version: 3.3.11
Copyright: (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

NTPClient: an NTP (RFC-1305, RFC-4330) client for unix-alike computers
Version: 2007_365
Copyright: 1997, 1999, 2000, 2003, 2006, 2007 Larry Doolittle

exFAT: FUSE-based exFAT implementation
Version: 0.9.8
Copyright: (C) 2010-2012 Andrew Nayenko

ONTFS_3G: The NTFS-3G driver is an open source, freely available read/write NTFS driver for Linux,
FreeBSD, Mac OS X, NetBSD, Solaris and Haiku.

Version: 2009.4.4

Copyright: (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA

mysql-5_1 72: a release of MySQL, a dual-license SQL database server
Version: 5.1.72

Copyright: (c) 2000, 2013, Oracle and/or its affiliates

FreeRadius: a high performance and highly configurable RADIUS server
Version: 2.1.12

Copyright: (C) 1999-2011 The FreeRADIUS server project and contributors

Linux IPv6 Router Advertisement Daemon — radvd

Version: V 1.15

Copyright (c) 1996,1997 by Lars Fenneberg<If@elemental.net>
BSD License: http://www.litech.org/radvd/

WIDE-DHCPV6
Dynamic Host Configuration Protocol for IPv6 (DHCPV6) clients, servers, and relay agents.
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Version: 20080615
Copyright (C) 1998-2004 WIDE Project.
BSD License: https://sourceforge.net/projects/wide-dhcpv6/

Python version 2.7.12

This Python distribution contains no GNU General Public Licensed
(GPLed) code so it may be used in proprietary projects just like prior
Python distributions. There are interfaces to some GNU code but these
are entirely optional

OpenPAM Radula

This software was developed for the FreeBSD Project by ThinkSec AS and
Network Associates Laboratories, the Security Research Division of

Network Associates, Inc. under DARPA/SPAWAR contract N66001-01-C-8035
("CBOSS"), as part of the DARPA CHATS research program.

ISC DHCP Version 4.3.5
Copyright (c) 2004-2016 by Internet Systems Consortium, Inc. ("ISC")
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